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INTRODUCTION 

Dear students to understand the audio recording and its editing first you need to have the basic 

know how of sound and listening. The following discussion will give you the brief idea about 

sound and its fundamentals. when we are discussing about the fundamentals we are basically 

explaining the basic qualities of sounds that how different sounds can be produced and it arrives 

in to the ears and how the sound waves travel in the form of periodic variations and their 

depiction in the form of graphical representation. 

When we make a recording, in effect we’re actually capturing and storing sound into a memory 

media so that an original event can be re-created at a later date. But to follow this regeneration of 

event we need to get help from the graphical wave forms and their characteristics will allow you 

to get help and distinguished between one another. The two basic fundamentals of a graphically 

presented wave form is its frequency and the amplitude. The content in this unit will explain you 

the basic range of human hearing in the form of frequency and various range to measure the 

amplitude of basic wave form cycle and its repetition within the positive and negative 

amplitudes. 

This unit will enable you to get a better idea of how the frequency range has a direct relationship 

over the period of time for determining the difference between low and high frequency ranges. 

The unit also explains you to get a better idea about the behavior of sound while striking at 

different surfaces and the relationship of mixing the wave form at different sound angles, the 

addition of sound at different phases and their results.  

After having clear background knowledge of a sinusoidal wave form and its characteristics this 

unit will lead you to more advance level or the actual form of sounds produced by different 

musical instruments along with their original sound frequencies. In addition to their even and 

odd multiples called the harmonics which enables you to have a better idea of differentiating 

between different musical instrumental voicing and the simple and complex waveform 

mechanism. The unit will also explain the characteristic variation in different musical levels. 

 After having a detailed discussion on sound and its characteristics the chapter will lead 

you to the next part that is hearing.  If we start with the idea that sound is actually a concept that 

describes the brain’s perception and interpretation of a physical auditory stimulus, the 

examination of sound can be explained by the characteristics of the ear and how the ear is 

stimulated by sound. 



By understanding the physical nature of sound and the basics of how the ears change a physical 

phenomenon into a sensory one, we can discover how to best convey this science into the 

subjective art forms of music, sound recording and production. 

 

 

OBJECTIVES: 

 

After studying this unit you will be able to: 

 

1. Know about the fundamental of sound 

2. Identify the characteristics of a sinusoidal waveform. 

3. You can differentiate between a simple and a complex waveform.  

4. Know about the musical waveform and its qualities 

5. Know about calibration of sound  

6. Basics of logarithm. 

7. Function of human ear as a transducer 

 

 

 

 

 

 

 

 

 

 



1 THE BASICS OF SOUND 

Sound is a vibration, or wave, that travels through matter (solid, liquid, or gas) and can be heard. 

It’s a vibration that propagates as a typically audible mechanical wave of pressure 

and displacement, through a medium such as air or water. In physiology and psychology, sound 

is the reception of such waves and their perception by the brain. 

All sounds are vibrations traveling through the air as sound waves. Sound waves are caused by 

the vibrations of objects and radiate outward from their source in all directions. A vibrating 

object compresses the surrounding air molecules (squeezing them closer together) and 

then rarefies them (pulling them farther apart). Although the fluctuations in air pressure travel 

outward from the object, the air molecules themselves stay in the same average position. As 

sound travels, it reflects off objects in its path, creating further disturbances in the surrounding 

air. When these changes in air pressure vibrate your eardrum, nerve signals are sent to your brain 

and are interpreted as sound. 

Sound arrives at the ear in the form of periodic variations in atmospheric pressure called sound-

pressure waves. This is the same atmospheric pressure that’s measured by the weather service 

with a barometer; however, the changes in pressure heard by the ear are too small in magnitude 

and fluctuate too rapidly to be observed on a barometer. An analogy of how sound waves travel 

in air can be demonstrated by bursting a balloon in a silent room. Before we stick it with a pin, 

the molecular motion of the room’s atmosphere is at a normal resting pressure. The pressure 

inside the balloon is much higher, though, and the molecules are compressed much more tightly 

together—like people packed into a crowded subway car (Figure 1.1a). When the balloon is 

popped… “POW!” (Figure 1.1b), the tightly compressed molecules under high pressure begin to 

exert an outward force on their neighbors in an effort to move toward areas of lower pressure. 

When the neighboring set of molecules has been com-pressed, they will continue to exert an 

outward force on the next set of lower-pressured neighbors (Figure 1.1c) in an ongoing outward 

motion that continues until the molecules have used up their energy in the form of heat. 

 

https://en.wikipedia.org/wiki/Vibration
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https://en.wikipedia.org/wiki/Particle_displacement
https://en.wikipedia.org/wiki/Transmission_medium
https://en.wikipedia.org/wiki/Air
https://en.wikipedia.org/wiki/Water
https://en.wikipedia.org/wiki/Physiology
https://en.wikipedia.org/wiki/Psychology
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Figure 1.1 Wave movement in air as it moves away from its point of origin.  

(a) An intact balloon contains pressurized air. (b) When the balloon is popped, the compressed 

molecules exert a force on outer neighbors in an effort to move to areas of lower pressure. (c) 

The outer neighbors then exert a force on the next set of molecules in an effort to move to areas 

of lower pressure … and the process continues. 

Likewise, as a vibrating mass (such as a guitar string, a person’s vocal chords or a loudspeaker) 

moves outward from its normal resting state, it squeezes air molecules into a compressed area, 

away from the sound source. This causes the area being acted on to have a greater than normal 

atmospheric pressure, a process called compression (Figure 1.2a). As the vibrating mass moves 

inward from its normal resting state, an area with a lower-than-normal atmospheric pressure will 

be created, in a process called rarefaction (Figure 1.2b). As the vibrating body cycles through its 

inward and outward motions, areas of higher and lower compression states are generated. These 

areas of high pressure will cause the wave to move outward from the sound source in the same 

way waves moved outward from the burst balloon. It’s interesting (and important) to note that 

the molecules themselves don’t move through air at the velocity of sound—only the sound wave 

itself moves through the atmosphere in the form of high-pressure compression waves that 

continue to push against areas of lower pressure (in an outward direction). This outward pressure 

motion is known as wave propagation. 

 

fig  a fig b 

Figure 1.2: Effects of a vibrating mass on air molecules and their propagation. 



(a) Compression—air molecules are forced together to form a compression wave (b) 

Rarefaction—as the vibrating mass moves inward, an area of lower atmospheric pressure is 

created. 

 

2 WAVEFORM CHARACTERISTICS 

A waveform is essentially the graphic representation of a sound-pressure level or voltage level as 

it moves through a medium over time. The simplest kind of sound wave is a sine wave. Pure sine 

waves rarely exist in the natural world, but they are a useful place to start because all other 

sounds can be broken down into combinations of sine waves. A sine wave clearly demonstrates 

the three fundamental characteristics of a sound wave: frequency, amplitude, and phase. 

 

 

In short, a waveform lets us see and explain the actual phenomenon of wave propagation in our 

physical environment and will generally have the following fundamental characteristics: 

 Amplitude 

 Frequency 

 Velocity 

 Wavelength 

 Phase 

 Harmonic content 

 Envelope. 

These characteristics allow one waveform to be distinguished from another. The most 

fundamental of these are amplitude and frequency (Figure 1.3). The following sections describe 

each of these characteristics. Although several math formulas have been included, it is by no 

means important that you memorize or worry about them. It’s far more important that you grasp 

the basic principles of acoustics rather than fret over the underlying math. 



 

          Figure 1.3: Amplitude and frequency ranges of human hearing. 

2.1 Amplitude 

Amplitude (or intensity) refers to the strength of a sound wave, which the human ear interprets as 

volume or loudness. People can detect a very wide range of volumes, from the sound of a pin 

dropping in a quiet room to a loud rock concert. Because the range of human hearing is so large, 

audio meters use a logarithmic scale (decibels) to make the units of measurement more 

manageable. 

 

         Figure 1.4: Graph of a sine wave showing the various ways to measure amplitude. 

The distance above or below the centerline of a waveform (such as a pure sine wave) represents 

the amplitude level of that signal. The greater the distance or displacement from that centerline, 

the more intense the pressure variation, electrical signal level, or physical displacement will be 

within a medium. Wave-form amplitudes can be measured in several ways (Figure 1.4). For 

example, the measurement of either the maximum positive or negative signal level of a wave is 

called its peak amplitude value (or peak value). The total measurement of the positive and 



negative peak signal levels is called the peak-to-peak value. The root-mean-square (rms) value 

was developed to determine a meaningful average level of a waveform over time (one that more 

closely approximates the level that’s perceived by our ears and gives a better real-world 

measurement of overall signal amplitudes). 

The rms value of a sine wave can be calculated by squaring the amplitudes at points along the 

waveform and then taking the mathematical average of the combined results. The math isn’t as 

important as the concept that the rms value of a perfect sine wave is equal to 0.707 times its 

instantaneous peak amplitude level. Because the square of a positive or negative value is always 

positive, the rms value will always be positive. The following simple equations show the 

relationship between a waveform’s peak and rms values: 

rms voltage = peak voltage ×0.707             peak voltage =rms voltage ×1.414 

2.2 FREQUENCY 

Frequency is the rate, or number of times per second, that a sound wave cycles from positive to 

negative to positive again. Frequency is measured in cycles per second, or hertz (Hz). Humans 

have a range of hearing from 20 Hz (low) to 20,000 Hz (high). Frequencies beyond this range 

exist, but they are inaudible to humans. 

The rate at which an acoustic generator, electrical signal or vibrating mass repeats within a cycle 

of positive and negative amplitude is known as the frequency of that signal. As the rate of 

repeated vibration increases within a given time period, the frequency (and thus the perceived 

pitch) will likewise increase … and vice versa. One completed excursion of a wave (which is 

plotted over the 360° axis of a circle) is known as a cycle (Figure 1.5). The number of cycles that 

occur within a second (frequency) is measured in hertz (Hz). The diagram in Figure 1.6 shows 

the value of a waveform as starting at zero (0°). At time  t= 0, this value increases to a positive 

maximum value and then decreases back through zero, where the process begins all over again in 

a repetitive fashion. A cycle can begin at any angular degree point on the waveform; however, to 

be complete, it must pass through a single 360° rotation and end at the same point as its starting 

value. For example, the waveform that starts at t= 0 and ends at t= 2 constitutes a cycle, as does 

the waveform that begins at t= 1 and ends at t= 3. 



 

Figure 1.5:  Cycle divided into the 360° of a circle. 

 

Figure 1.6: Graph of waveform amplitude over time. 

Frequency Spectrum of Sounds 

With the exception of pure sine waves, sounds are made up of many different frequency 

components vibrating at the same time. The particular characteristics of a sound are the result of 

the unique combination of frequencies it contains. 

Sounds contain energy in different frequency ranges, or bands. If a sound has a lot of low-

frequency energy, it has a lot of bass. The 250–4000 Hz frequency band, where humans hear 

best, is described as midrange. High-frequency energy beyond the midrange is called treble, and 

this adds crispness or brilliance to a sound. The graph below shows how the sounds of different 

musical instruments fall within particular frequency bands. 



 
Note: Different manufacturers and mixing engineers define the ranges of these frequency bands 

differently, so the numbers described above are approximate. 

 

The human voice produces sounds that are mostly in the 250–4000 Hz range, which likely 

explains why people’s ears are also the most sensitive to this range. If the dialogue in your movie 

is harder to hear when you add music and sound effects, try reducing the midrange frequencies 

of the non-dialogue tracks using an equalizer filter. Reducing the midrange creates a “sonic 

space” in which the dialogue can be heard more easily. 

Musical sounds typically have a regular frequency, which the human ear hears as the 

sound’s pitch. Pitch is expressed using musical notes, such as C, E flat, and F sharp. The pitch is 

usually only the lowest, strongest part of the sound wave, called the fundamental frequency. 

Every musical sound also has higher, softer parts called overtones or harmonics, which occur at 

regular multiples of the fundamental frequency. The human ear doesn’t hear the harmonics as 

distinct pitches, but rather as the tone color (also called the timbre) of the sound, which allows 

the ear to distinguish one instrument or voice from another, even when both are playing the same 

pitch. 



 
 

Musical sounds also typically have a volume envelope. Every note played on a musical 

instrument has a distinct curve of rising and falling volume over time. Sounds produced by some 

instruments, particularly drums and other percussion instruments, start at a high volume level but 

quickly decrease to a much lower level and die away to silence. Sounds produced by other 

instruments, for example, a violin or a trumpet, can be sustained at the same volume level and 

can be raised or lowered in volume while being sustained. This volume curve is called the 

sound’s envelope and acts like a signature to help the ear recognize what instrument is producing 

the sound. 

 
 

 

 



2.3 VELOCITY 

The velocity of an object is the rate of change of its position with respect to a frame of reference, 

and is a function of time. Velocity is equivalent to a specification of its speed and direction of 

motion (e.g. 60 km/h to the north). Velocity is an important concept in kinematics, the branch 

of classical mechanics that describes the motion of bodies. 

Velocity is a physical vector quantity; both magnitude and direction are needed to define it. 

The scalar absolute value(magnitude) of velocity is called "speed", being a coherent derived unit 

whose quantity is measured in the SI (metric) system as meters per second (m/s) or as the SI base 

unit of (m.s−1). For example, "5 meters per second" is a scalar (not a vector), whereas "5 meters 

per second east" is a vector. 

If there is a change in speed, direction, or both, then the object has a changing velocity and is 

said to be undergoing an acceleration. 

2.4 WAVE LENGTH 

The wavelength of a waveform (frequently represented by the Greek letter lambda, λ) is the 

physical distance in a medium between the beginning and the end of a cycle. The physical length 

of a wave can be calculated using: 

λ=Vf 

Where λ is the wavelength in the medium V is the velocity in the medium f is the frequency (in 

hertz). 

The time it takes to complete 1 cycle is called the period of the wave. To illustrate, a 30-

Hz sound wave completes 30 cycles each second or 1 cycle every 1/30th of a second. The period 

of the wave is expressed using the symbol T: 

T=1/F 

Where T is the number of seconds per cycle. 

Assuming that sound propagates at the rate of 1130ft/sec, all that’s needed is to divide 

this figure by the desired frequency. For example, the simple math for calculating the wavelength 

of a 30-Hz waveform would be 1130/30 = 37.6 feet long, whereas a waveform having a 

frequency of 300Hz would be 1130/300 =3.76 feet long (Figure 1.7). Likewise, a 1000-Hz 

https://en.wikipedia.org/wiki/Time_derivative
https://en.wikipedia.org/wiki/Position_(vector)
https://en.wikipedia.org/wiki/Frame_of_reference
https://en.wikipedia.org/wiki/Speed
https://en.wikipedia.org/wiki/Kinematics
https://en.wikipedia.org/wiki/Classical_mechanics
https://en.wikipedia.org/wiki/Motion_(physics)
https://en.wikipedia.org/wiki/Vector_(geometry)
https://en.wikipedia.org/wiki/Physical_quantity
https://en.wikipedia.org/wiki/Scalar_(physics)
https://en.wikipedia.org/wiki/Absolute_value
https://en.wikipedia.org/wiki/Magnitude_(mathematics)
https://en.wikipedia.org/wiki/International_System_of_Units
https://en.wikipedia.org/wiki/Metres_per_second
https://en.wikipedia.org/wiki/Scalar_(physics)
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waveform would work out as being 1130/1000 = 1.13 feet long, and a 10,000-Hz waveform 

would be 1130/10,000 = 0.113 feet long. From these calculations, you can see that when-ever the 

frequency is increased, the wavelength decreases. 

 

Figure 1.7: Wavelengths decrease in length as frequency increases (and vice versa). 

 

2.5 REFLECTION OF SOUND 

 

Much like a light wave, sound reflects off a surface boundary at an angle that is equal to (and in 

an opposite direction of) its initial angle of incidence. This basic property is one of the 

cornerstones of the complex study of acoustics. For example, Figure 1.8a shows how a sound 

wave reflects off a solid smooth surface in a simple and straightforward manner (at an equal and 

opposite angle). Figure 1.8b shows how a convex surface will play the sound outward from its 

surface, radiating the sound outward in a wide dispersion pattern. In Figure 1.8-c, a concave 

surface is used to focus a sound inward toward a single point, while a 90° corner (as shown in 

Figure 1.8d) reflects patterns back at angles that are equal to their original incident direction. 

This holds true both for the 90° corners of a wall and for intersections where the wall and floor 

meet. The secorner reflections help to provide insights into how volume levels often build up in 

the corners of a room (particularly at wall-to-floor corner intersections).corner reflections help to 

provide insights into how volume levels often build up in the corners of a room (particularly at 

wall-to-floor corner intersections). 

 



   (a)                                       (b)                                           (c)                                    (d)

 

Figure 1.8: Incident sound waves striking surfaces with varying shapes: (a) single-planed, solid, 

smooth surface; (b) convex surface; (c) concave surface; (d) 90° corner reflection. 

2.6 DIFFRACTION OF SOUND 

Sound has the inherent ability to diffract around or through a physical acoustic barrier. In other 

words, sound can bend around an object in a manner that reconstructs the signal back to its 

original form in both frequency and amplitude. For example, in Figure 1.9a, we can see how a 

small obstacle will scarcely impede a larger acoustic waveform. Figure 1.9b shows how a larger 

obstacle can obstruct a larger portion of the waveform; however, past the obstruction, the signal 

bends around the area in the barrier’s wake and begins to reconstruct itself. Figure 1.9c shows 

how the signal is able to radiate through an opening in a large barrier. Although the signal is 

greatly impeded (relative to the size of the opening), it nevertheless begins to reconstruct itself in 

wavelength and relative amplitude and begins to radiate outward as though it were a new point of 

origin. Finally, Figure 1.9d shows how a large opening in a barrier lets much of the waveform 

pass through relatively unimpeded. 

2.7 FREQUENCY RESPONSE 

The charted output of an audio device is known as its frequency response curve (when supplied 

with a reference input of equal level over the 20- to 20,000-Hzrange of human hearing). 

                                                               

            Fig a                        Fig b 



                                                      

Fig c                       Fig d 

Figure1.9: The effects of obstacles on sound radiation and diffraction. (a) A small obstacle will 

scarcely impede a longer wavelength signal. (b) A larger obstacle will obstruct the signal to a 

greater extent; the waveform will also reconstruct itself in the barrier’s wake. (c) A small 

opening in a barrier will greatly impede a signal; the waveform will emanate from the opening 

and reconstruct itself as a new source point. (d) A larger opening allows sound to pass 

unimpeded, allowing it to quickly diffract back into its original shape. 

This curve is used to graphically represent how a device will respond to the audio spectrum and, 

thus, how it will affect a signal’s overall sound. As an example, Figure 1.10 shows the frequency 

response of several unidentified devices. In these and all cases, the x-axis represents the signal’s 

measured frequency, while the y-axis represents the device’s measured output signal. These 

curves are created by feeding the input of an acoustic or electrical device with a constant-

amplitude reference signal that sweeps over the entire frequency spectrum. The results are then 

charted on an amplitude versus frequency graph that can be easily read at a glance. If the 

measured signal is the same level at all frequencies, the curve will be drawn as a flat, straight line 

from left to right (known as a flat frequency response curve). This indicates that the device 

passes all frequencies equally (with no frequency being emphasized or de-emphasized). If the 

output lowers or increases at certain frequencies, these changes will easily show up as dips or 

peaks in the chart. 

2.8 PHASE 

Because we know that a cycle can begin at any point on a waveform, it follows that whenever 

two or more waveforms are involved in producing a sound, their relative amplitudes can (and 

often will) be different at any one point in time. For simplicity’s sake, let’s limit our example to 

two pure tone waveforms (sine waves) that have equal amplitudes and frequency but start their 

cyclic periods at different times. Such waveforms are said to be out of phase with respect to each 

other. Variations in phase, which are measured in degrees (°), can be described as a time delay 



between two or more waveforms. These delays are often said to have differences in relative 

phase degree angles (over the full rotation of a cycle, e.g., 90°, 180°, or any angle between 0° 

and 360°). The sine wave (so named because its amplitude follows a trigonometric sine function) 

is usually considered to begin at 0° with an amplitude of zero; the waveform then increases to a 

positive maximum at 90°, decreases back to a zero amplitude at 180°, increases to a negative 

maximum value at 270°, and finally returns back to its original level at 360°, simply to begin all 

over again. 

 

Fig a 

 

Fig b 

 

Fig c 



 

Figure 1.10: Frequency response curves: (a) curve showing a bass boost; (b) curve showing a 

boost at the upper end; (c) curve showing a dip in the midrange. 

Whenever two or more waveforms arrive at a single location out of phase, their relative signal 

levels will be added together to create a combined amplitude level at that one point in time. 

Whenever two waveforms having the same frequency, shape and peak amplitude are completely 

in phase (meaning that they have no relative time difference), the newly combined waveform 

will have the same frequency, phase and shape … but will be double in amplitude (Figure 1.11a). 

If the same two waves are combined completely out of phase (having a phase difference of 

180°), they will cancel each other out when added, which results in a straight line of zero 

amplitude (Figure 1.11b). If the second wave is only partially out of phase (by a degree other 

than 180°), the levels will be added at points where the combined amplitudes are positive and 

reduced in level where the combined result is negative (Figure 1.11c). 

 

Fig 1.11 a 

 

 

Fig1.11 b 



 

 

Fig1.11c 

PHASE SHIFT 

Phase shift is a term that describes one wave-form’s lead or lag in time with respect to another. 

Basically, it results from a time delay between two (or more) waveforms (with differences in 

acoustic distance being the most common source of this type of delay). For example, a 500-Hz 

wave completes one cycle every 0.002 sec. If you start with two in phase, 500-Hz waves and 

delay one of them by 0.001sec (half the wave’s period), the delayed wave will lag the other by 

one-half a cycle, or 180°. Another example might include a single source that’s being picked up 

by two microphones that have been placed at different distances (Figure 1.12), thereby creating a 

corresponding time delay when the mics are mixed together. Such a delay can also occur when a 

single microphone picks up direct sounds as well as those that are reflected off of a nearby 

boundary. These signals will be in phase at frequencies where the path-length difference is equal 

to the signal’s wavelength and out of phase at those frequencies where the multiples fall at or 

near the half-wavelength distance. In all the above situations, these boosts and cancellations 

combine to alter the signal’s overall frequency response at the pickup. For this and other reasons, 

acoustic leakage between microphones and reflections from nearby boundaries should be kept to 

a minimum whenever possible. 



 

Figure 1.12: Cancellations can occur when a single source is picked up by two microphones. 

2.9 HARMONIC CONTENT 

Up to this point, the discussion has centered on the sine wave, which is com-posed of a single 

frequency that produces a pure sound at a specific pitch. Fortunately, musical instruments rarely 

produce pure sine waves. If they did, all of the instruments would basically sound the same, and 

music would be pretty boring. The factor that helps us differentiate between instrumental 

“voicings” is the presence of frequencies (called partials) that exist in addition to the 

fundamental pitch that’s being played. Partials that are higher than the fundamental frequency 

are called upper partials or overtones. Overtone frequencies that are whole-number multiples of 

the fundamental frequency are called harmonics. For example, the frequency that corresponds to 

concert A is 440Hz (Figure 1.13a). An 880-Hz wave is a harmonic of the 440-Hz fundamental 

because it is twice the frequency (Figure .113b). In this case, the 440-Hz fundamental is 

technically the first harmonic because it is 1 times the fundamental frequency, and the 880-Hz 

wave is called the second harmonic because it is 2 times the fundamental. The third harmonic 

would be 3 times 440Hz, or 1320Hz (Figure 1.13c). Some instruments, such as bells, xylophones 

and other percussion instruments, will often contain overtone partials that aren’t harmonically 

related to the fundamental at all. 



 

Figure 1.13: An illustration of harmonics: (a) first harmonic “fundamental waveform”; (b) 

second harmonic; (c) third harmonic. 

The ear perceives frequencies that are whole, doubled multiples of the fundamental as being 

related in a special way (a phenomenon known as the musicaloctave). For example, as concert A 

is 440Hz (A3), the ear hears 880Hz (A4) as being the next highest frequency that sounds most 

like concert A. The next related octave above that will be 1760Hz (A5). Therefore, 880Hz is said 

to be one octave above 440Hz, and 1760Hz is said to be two octaves above 440Hz, etc. Because 

these frequencies are even multiples of the fundamental, they’re known as even harmonics. Not 

surprisingly, frequencies that are odd multiples of the fundamental are called odd harmonics. In 

general, even harmonics are perceived as creating a sound that is pleasing to the ear, while odd 

harmonics will create a dissonant, harsher tone. 

                                                

Fig a       Fig b 

Fig c 

Figure 1.14: Simple waveforms: (a) square waves; (b) triangle waves; (c) saw tooth waves. 

Because musical instruments produce sound waves that contain harmonics with various 

amplitude and phase relationships, the resulting waveforms bear little resemblance to the shape 

of the single-frequency sine wave. Therefore, musical waveforms can be divided into two 



categories: simple and complex. Square waves, triangle waves and saw tooth waves are 

examples of simple waves that contain a consistent harmonic structure (Figure 1.14). They are 

said to be simple because they’re continuous and repetitive in nature. One cycle of a square wave 

looks exactly like the next, and they are symmetrical about the zero line. 

Complex waves, on the other hand, don’t necessarily repeat and often are not symmetrical about 

the zero line. An example of a complex waveform (Figure 1.15) is one that’s created by any 

naturally occurring sound (such as music or speech). Although complex waves are rarely 

repetitive in nature, all sounds can be mathematically broken down as being an ever-changing 

combination of individual sine waves. 

 

Figure 1.15: Example of a complex waveform. 

Regardless of the shape or complexity of a wave-form that reaches the eardrum, the inner ear is 

able to perceive these component waveforms and transmit the stimulus to the brain. This can be 

illustrated by passing a square wave through a band pass filter that’s set to pass only a narrow 

band of frequencies at any one time. Doing this would show that the square wave is composed of 

a fundamental frequency plus a number of harmonics that are made up of odd number multiple 

frequencies (whose amplitudes decrease as the frequency increases). In Figure 1.16, we see how 

individual sine-wave harmonics can be combined to form a square wave. 



 

Figure 1.16: Breaking a square wave down into its odd-harmonic components:  (a) square wave 

with frequency f; (b) sine wave with frequency f; (c) sum of a sine wave with frequency f and a 

lower amplitude sine wave of frequency 3f; (d) sum of a sine wave of frequency find lower 

amplitude sine waves of 3fand 5f, which is beginning to resemble a square wave. 

If we were to analyze the harmonic content of sound waves that are produced by a violin and 

compare them to the content of the waves that are produced by a viola (with both playing concert 

A, 440Hz), we would come up with results like those shown in Figure 1.17. Notice that the 

violin’s harmonics differ in both degree and intensity from those of the viola. The harmonics and 

their relative intensities (which determine an instrument’s characteristic sound) are called the 

timbre of an instrument. If we changed an instrument’s harmonic balance, the sonic character of 

the instrument would also be changed. For example, if the violin’s upper harmonics were 

reduced, the violin would sound a lot like the viola. 

                             

Figure 1.17: Harmonic structure of concert A-440: (a) played on a viola; (b) played on a violin. 

Because the relative harmonic balance is so important to an instrument’s sound, the frequency 

response of a microphone, amplifier, speaker and all other elements in the signal path can have 



an effect on the timbre (tonal balance) of a sound. If the frequency response isn’t flat, the timbre 

of the sound will be changed. For example, if the high frequencies are amplified less than the 

low and middle frequencies, then the sound will be duller than it should be. For this reason, a 

specific mic, mic placement or an equalizer can be used as tools to vary the timbre of an 

instrument, thereby changing its subjective sound. 

In addition to the variations in harmonic balance that can exist between instruments and their 

families, it is common for the harmonic balance to vary with respect to direction as sound waves 

radiate from an instrument. Figure 1.18 shows the principal radiation patterns as they emanate 

from a cello (as seen from both the side and top views). 

 

Figure 1.18: Radiation patterns of a cello as viewed from the side (left) and top (right). 

2.10 ENVELOPE 

Timbre isn’t the only characteristic that lets us differentiate between instruments. Each one 

produces a sonic envelope that works in combination with timbre to determine its unique and 

subjective sound. The envelope of a wave-form can be described as characteristic variations in 

level that occur in time over the duration of a played note. The envelope of an acoustic or 

electronically generated signal is composed of four sections that vary in amplitude over time: 

 Attack refers to the time taken for a sound to build up to its full volume when a note is 

initially sounded. 

 Decay refers to how quickly the sound levels off to a sustain level after the initial attack 

peak. 

 Sustain refers to the duration of the ongoing sound that’s generated following the initial 

attack decay. 

 Release relates to how quickly the sound will decay once the note is released. 



Figure 1.19a illustrates the envelope of a trombone note. The attack, decay times and internal 

dynamics produce a smooth, sustaining sound. A cymbal crash (Figure 1.19b) combines a high-

level, fast attack with a longer sustain and decay that creates a smooth, lingering shimmer. Figure 

1.19c illustrates the envelope of a snare drum. Notice that the initial attack is much louder than 

the internal dynamics … while the final decay trails off very quickly, resulting in a sharp, 

percussive sound. 

It’s important to note that the concept of an envelope relies on peak waveform values, while the 

human perception of loudness is proportional to the average wave intensity over a period of time 

(rms value). Therefore, high-amplitude portions of the envelope won’t make an instrument sound 

loud unless the amplitude is maintained for a sustained period. Short high-amplitude sections 

tend to contribute to a sound’s overall character, rather than to its loudness. By using a 

compressor or limiter, an instrument’s character can often be modified by changing the dynamics 

of its envelope without changing its timbre. 

 

fig a  fig b 

        

fig c 

Figure 1.19: Various musical waveform envelopes: (a) trombone, (b) cymbal crash, and (c) 

snare drum, where A = attack, D = decay, S = sustain, and R = release. 

 

3 Sound measurement and its unit 

The ear operates over an energy range of approximately 10
13

:1 (10,000,000,000,000:1), 

which is an extremely wide range. Since it’s difficult for us humans to conceptualize number 

ranges that are this large, a logarithmic scale has been adopted to compress the measurements 

into figures that are more manageable. The unit used for measuring sound-pressure level 



(SPL), signal level and relative changes in signal level is the decibel (dB), a term that literally 

means 1/10th of a Bell … a telephone transmission measurement unit that was named after 

Alexander Graham Bell, inventor of the telephone. In order to develop an understanding of 

the decibel, we first need to examine logarithms and the logarithmic scale (Figure 1.20). The 

logarithm (log) is a mathematical function that reduces large numeric values into smaller, 

more manageable numbers. Because logarithmic numbers increase exponentially in a way 

that’s similar to how we perceive loudness (e.g., 1, 2, 4, 16, 128, 256, 65,536), it expresses 

our perceived sense of volume more precisely than a linear curve can. 

Before we delve into a deeper study of this important concept and how it deals with our 

perceptual senses, let’s take a moment to understand the basic concepts and building block 

ideas behind the log scale, so as to get a better understanding of what examples such as 

“+3dB at 10,000Hz” really mean. Be patient with yourself! Over time, the concept of the 

decibel will become as much a part of your working vocabulary as ounces, gallons and miles 

per hour. 

 

    

Figure 1.20: Linear and logarithmic curves: (a) linear; (b) logarithmic. 

3.1 LOGARITHM BASICS 

In audio, we use logarithmic values to express the differences in intensities between two levels 

(often, but not always, comparing a measured level to a standard reference level). Because the 

differences between these two levels can be really, really big, a simpler system would make use 

of expressed values that are mathematical exponents of 10. To begin, finding the log of a number 



such as 17,386 without a calculator is not only difficult … it’s unnecessary! All that’s really 

important to help you along are three simple guidelines: 

 The log of the number 2 is 0.3. 

 When a number is an integral power of 10 (e.g., 100, 1000, 10,000), the log can 

be found simply by adding up the number of zeros. 

 Numbers that are greater than 1 will have a positive log value, while those less 

than 1 will have a negative log value. 

The first one is an easy fact to remember: The log of 2 is 0.3 … this will make sense shortly. The 

second one is even easier: The logs of numbers such as 100, 1000 or 10,000,000,000,000 can be 

arrived at by simply counting up the zeros. The last guideline relates to the fact that if the 

measured value is less than the reference value, the resulting log value will be negative. For 

example: 

log.2=0.3 

log1/2 = log 0.5 =−0.3 

log10,000,000,000,000=13 

log1000=3 

log100=2 

log10=1 

log1=0 

log0.1=−1 

log0.01=−2 

log0.001=−3 

All other numbers can be arrived at by using a scientific calculator (most computers and many 

cell phones have one built in); however, it’s unlikely that you will ever need to know any log 

values beyond understanding the basic concepts that are listed above. 

 

 



3.2 THE DECIBEL 

Now that we’ve gotten past the absolute bare basics, I’d like to break with tradition again and 

attempt an explanation of the decibel in a way that’s less complex and relates more to our day-to-

day needs in the sound biz. First off, the decibel is a logarithmic value that “expresses 

differences in intensities between two levels.” From this, we can infer that these levels are 

expressed by several units of measure, the most common being sound-pressure level (SPL), 

voltage (V) and power (wattage, or W). Now, let’s look at the basic math behind these three 

measurements. 

3.3 SOUND-PRESSURE LEVEL 

Sound-pressure level is the acoustic pressure that’s built up within a defined atmospheric area 

(usually a square centimeter, or cm2). Quite simply, the higher the SPL, the louder the sound 

(Figure 1.21). 

 

Figure 1.21: Chart of sound-pressure levels. (Courtesy of General Radio Company.) 



 In this instance, our measured reference (SPLref) is the threshold of hearing, which is defined as 

being the softest sound that an average person can hear. Most conversations will have a SPL of 

about 70dB, while average home stereos are played at volumes ranging between 80 and 90dB 

SPL. Sounds that are so loud as to be painful have SPLs of about 130 to 140dB 

(10,000,000,000,000 or more times louder than the 0-dB reference). We can arrive at an SPL 

rating by using the formula: 

dB SPL= 20 log SPL/SPLref 

where SPL is measured sound pressure (in dyne/cm
2 

). SPLrefis a reference sound pressure (the 

threshold limit of human hearing, 0.02 millipascals = 2 ten-billionths of our atmosphere). 

From this, I feel that the major concept that needs to be understood is the idea that SPL levels 

change with the square of the distance (hence, the 20 log part of the equation). This means that 

whenever a source/pickup distance is doubled, the SPL level will be reduced by 6dB (20log 0.5/1 

= 20 ×−0.3 =−6dB SPL); as the distance is halved, it will increase by 6dB (20 log 2/1 =20 × 0.3 

= 6dB SPL), as shown in Figure 1.22. 

 

Figure 1.22: Doubling the distance of a pickup will lower the perceived direct signal level by 6dB SPL. 

dBm=10logP/Pref 

where P is the measured wattage, and Prefis referenced to 1 milliwatt (0.001watt). 

The simple heart of the matter 

I am going to stick my neck out and state that, when dealing with decibels, it’s far more common 

for working professionals to deal with the concept of power. The dBm equation expresses the 

spirit of the decibel term when dealing with the markings on an audio device or the numeric 

values in a computer dialog box. This is due to the fact that power is the unit of measure that’s 

most often expressed when dealing with audio equipment controls; therefore, it’s my personal 

opinion that the average working stiff only needs to grasp the following basic concepts: 



 A 1-dB change is barely noticeable to most ears. 

 Turning something up by 3dB will double the signal’s level (believe it or not, doubling 

the signal level won’t increase the perceived loudness as much as you might think). 

 Turning something down by 3dB will halve the signal’s level (likewise, halving the 

signal level won’t decrease the perceived loudness as much as you might think). 

 The log of an exponent of 10 can be easily figured by simply counting the zeros (e.g., the 

log of 1000 is 3). Given that this figure is multiplied by 10 (10 log P/Pref), turning 

something up by 10dB will increase the signal’s level 10-fold, 20dB will yield a 100-fold 

increase, 30dB will yield a 1000-fold increase, etc. 

Most pros know that turning a level fader up by 3dB will effectively double its energy output 

(and vice versa). Beyond this, it’s unlikely that anyone will ever ask, “Would you please turn 

that up a thousand times?” It just won’t happen! However, when a pro asks his or her assistant to 

turn the gain up by 20dB, that assistant will often instinctively know what 20dB is … and what it 

sounds like. I guess I’m saying that the math really isn’t nearly as important as the ongoing 

process of getting an instinctive feel for the decibel and how it relates to relative levels within 

audio production. 

4 THE EAR 

The ear is the organ of hearing and, balance. A sound source produces acoustic waves by 

alternately compressing and rarefying the air molecules between it and the listener, causing 

fluctuations that fall above and below normal atmospheric pressure. The human ear is a sensitive 

transducer that responds to these pressure variations by way of a series of related processes that 

occur within the auditory organs … our ears. When these variations arrive at the listener, sound-

pressure waves are collected in the aural canal by way of the outer ear’s pinna. These are then 

directed to the eardrum, a stretched drum-like membrane (Figure 1.23), where the sound waves 

are changed into mechanical vibrations, which are transferred to the inner ear by way of three 

bones known as the hammer, anvil and stirrup. These bones act both as an amplifier (by 

significantly increasing the vibrations that are transmit-ted from the eardrum) and as a limiting 

protection device (by reducing the level of loud, transient sounds such as thunder or fireworks 

explosions). The vibrations are then applied to the inner ear (cochlea)—a tubular, snail-like 

organ that contains two fluid-filled chambers. Within these chambers are tiny hair receptors that 

are lined up in a row along the length of the cochlea. These hairs respond to certain frequencies 

depending on their placement along the organ, which results in the neural stimulation that gives 

us the sensation of hearing. Permanent hearing loss generally occurs when these hair/nerve 

combinations are damaged or as they deteriorate with age. 



 

Figure 1.23:   Outer, middle, and inner ear. 

Hearing 

Sound waves travel through the outer ear, are modulated by the middle ear, and are transmitted 

to the vestibule cochlear nerve in the inner ear. This nerve transmits information to the temporal 

lobe of the brain, where it is registered as sound. 

Sound that travels through the outer ear impacts on the eardrum, and causes it to vibrate. The 

three ossicles bones transmit this sound to a second window (the oval window) which protects 

the fluid-filled inner ear. In detail, the pinna of the outer ear helps to focus a sound, which 

impacts on the eardrum. The malleus rests on the membrane, and receives the vibration. This 

vibration is transmitted along the incus and stapes to the oval window. Two small muscles, 

the tensor tympani and stapedius, also help modulate noise. The two muscles reflexively 

contract to dampen excessive vibrations. Vibration of the oval window causes vibration of the 

endolymph within the vestibule and the cochlea. (Hall, 2005) 

The inner ear houses the apparatus necessary to change the vibrations transmitted from the 

outside world via the middle ear into signals passed along the vestibulo cochlear nerve to the 

brain. The hollow channels of the inner ear are filled with liquid, and contain a 

sensory epithelium that is studded with hair cells. The microscopic "hairs" of these cells are 

structural protein filaments that project out into the fluid. The hair cells 

are mechanoreceptors that release a chemical neurotransmitter when stimulated. Sound waves 
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moving through fluid flows against the receptor cells of the organ of Corti. The fluid pushes the 

filaments of individual cells; movement of the filaments causes receptor cells to become open to 

receive the potassium-rich endolymph. This causes the cell to depolarise, and creates an action 

potential that is transmitted along the spiral ganglion, which sends information through the 

auditory portion of the vestibulo cochlear nerve to the temporal lobe of the brain.  

The human ear can generally hear sounds with frequencies between 20 Hz and 20 kHz (the audio 

range). Sounds outside this range are considered infrasound (below 20 Hz) (Greinwald, 2002) 

or ultrasound (above 20 kHz) (Collins English Dictionary, 2016). Although hearing requires an 

intact and functioning auditory portion of the central nervous system as well as a working ear, 

human deafness (extreme insensitivity to sound) most commonly occurs because of 

abnormalities of the inner ear, rather than in the nerves or tracts of the central auditory system. 

4.1 Threshold of hearing 

The hearing threshold is defined as the lowest threshold of acoustic pressure sensation, possible 

to perceive by an organism. It is a subjective value which may differ individually. The hearing 

threshold forms the lowest limit of the hearing range (the highest limit is formed by the threshold 

of pain).  

The measured threshold of hearing curve shows that the sound intensity required to be heard is 

quite different for different frequencies. The standard threshold of hearing at 1000 Hz is 

nominally taken to be 0 dB, but the actual curves show the measured threshold at 1000 Hz to be 

about 4 dB. 
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In the case of SPL, a convenient pressure-level reference is the threshold of hearing, which is the 

minimum sound pressure that produces the phenomenon of hearing in most people and is equal 

to 0.0002 microbar. One microbar is equal to 1 millionth of normal atmospheric pressure, so it’s 

apparent that the ear is an amazingly sensitive instrument. In fact, if the ear were any more 

sensitive, the thermal motion of molecules in the air would be audible! When referencing SPLs 

to 0.0002 microbar, this threshold level usually is denoted as 0dB SPL, which is defined as the 

level at which an average person can hear a specific frequency only 50% of the time. 

4.2 Threshold of feeling 

The threshold of 'feeling' is the sound pressure level at which people feel discomfort 50 per cent 

of the time. Approximately 118 dB SPL at 1 KHz. The threshold of 'pain' is the sound pressure 

level at which people feel actual pain 50 per cent of the time. Approximately 140 dB SPL at 1 

KHz. 

An SPL that causes discomfort in a listener 50% of the time is called the thresh-old of feeling. It 

occurs at a level of about 118dB SPL between the frequencies of 200Hz and 10kHz. 

4.3 Threshold of pain 

The threshold of pain or pain threshold is the point along a curve of increasing perception of a 

stimulus at which pain begins to be felt. It is an entirely subjective phenomenon. 

The SPL that causes pain in a listener 50% of the time is called the threshold of pain and 

corresponds to an SPL of 140dB in the frequency range between 200Hz and 10kHz. 

 



4.4 Taking care of your hearing 

During the 1970s and early 1980s, recording studio monitoring levels were often turned so high 

as to be truly painful. In the mid-1990s, a small band of powerful producers and record 

executives banded together to successfully reduce these average volumes down to tolerable 

levels (85 to 95dB) … a practice that continues to this day. Live sound venues and acts often 

continue the practice of raising house and stage volumes to chest-thumping levels. Although 

these levels are exciting, long-term exposure can lead to temporary or permanent hearing loss. So 

what types of hearing loss are there? 

 Acoustic trauma: This happens when the ear is exposed to a sudden, loud noise in excess 

of 140 dB. Such a shock could lead to permanent hearing loss. 

 Temporary threshold shift: The ear can experience temporary hearing loss when exposed 

to long-term, loud noise. 

 Permanent threshold shift: Extended exposure to loud noises in a specific or broad 

hearing range can lead to permanent hearing loss in that range. In short, the ear becomes 

less sensitive to sounds in the damaged frequency range leading to a reduction in 

perceived volume. … What? 

Here are a few hearing conservation tips (courtesy of the House Ear Institute, www.hei.org)that 

can help reduce hearing loss due to long-term exposure of sounds over 115dB: 

 Avoid hazardous sound environments; if they are not avoidable, wear hearing protection 

devices, such as foam earplugs, custom-molded ear-plugs, or in-ear monitors. 

 Monitor sound-pressure levels at or around 85dB. The general rule to follow is if you’re 

in an environment where you must raise your voice to be heard, then you’re monitoring 

too loudly and should limit your expo-sure times. 

 Take 15-minute “quiet breaks” every few hours if you’re being exposed to levels above 

85dB. 

 Musicians and other live entertainment professionals should avoid practicing at concert-

hall levels whenever possible. 

 Have your hearing checked by a licensed audiologist. 

 

  



Self Assessment Questions 

Q 1 Name the basic characteristics of a wave form? 

Q2 Define and explain the following 

A amplitude frequency  

B frequency 

C wavelength 

Q3 fill in the blanks 

1 The number of cycles that occur within a second is called its _________  

2 The measurement of either the maximum positive or negative signal level of a wave is 

called its ____________ 

3 rms voltage = _________ x ________ 

4 peak voltage = _________ x ____  

5 The wavelength of a waveform frequently represented by the ______ 

Answers 

1) Frequency   2) Peak amplitude value (or peak value) 

3) Peak voltage × 0.707 4)rms voltage ×1.414  5) Greek letter lambda, λ 

Q4  Draw the following wave forms 

 A  sine wave 

 B saw tooth wave 

 C  square wave 

Q5 Describe the envelope of a waveform. Explain its four sections that vary in amplitude 

over time? 

Q6 Explain the working of human ear as a transducer? 

Q. 7 Explain the primary function of the human ear.  

Q. 8 What do you understand by frequency, amplitude, wavelength, velocity, phase and 

intensity of sound? 
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INTRODUCTION 

Dear student this chapter will introduce acoustics which is the science of sound, that is, 

wave motion in different medium, and the effects of such wave motion. Thus the scope of 

acoustics ranges from fundamental physical acoustics to, say, psychoacoustics and music, and 

includes technical fields such as transducer technology, sound recording and reproduction, and 

noise control. The purpose of this unit is to give an introduction to fundamental acoustic 

concepts, to the physical principles of acoustic wave motion, and to acoustic measurements.  By 

introducing you the basics, give you the better understanding of the properties of sound 

 In this unit you will also learn the detailed behavior of a sinusoidal waveform producing 

oscillations and the variation of these oscillations producing the effects in standard 

terminologies. You will get a better idea that how the sound waves propagate and you will be 

able to distinguish between types of waves used to transmit energy through a medium or 

substance, and the relationship between the speed of sound and its effect with the change in 

frequency. You will also get an idea of another cause in the deviation of sound which is the 

humidity factor in air, you will learn that how the humidity effects sound propagation. 

This unit will cover another major area in acoustics that is psychoacoustics which is a 

multidisciplinary field that deals with the physical (e.g. vibrations, wave theory), physiological 

(e.g. construction of the ear), and perceptual (e.g. auditory sensations) correlates of sound 

production, transmission, and reception.  More specifically, it forges a link among the physical, 

physiological, and perceptual frames of reference. It deals with how and why the brain interprets 

a particular sound stimulus in a certain way. As the ear is a nonlinear device means that hearing 

can be changed by many factors and the behavior of ear at different frequency response changes 

with the loudness of the perceived signal. As a result of the nonlinearities in the ear’s response, 

tones will often interact with each other rather than being perceived as being separate. The type 

of interaction that effect different tones will also be studied and student will able to differentiate 

between Beats, different Combination of tones and Masking. 

As soon the sound passes through ear, it stops being a physical phenomenon and becomes 

a matter of perception. Next thing that you will learn from this chapter is the sound perception 

which is mostly dependent on the two major factors out of these two first is the direction and the 

other one is space. The study of this topic will allow you to perceive the direction of a sound’s 

origin which is either from the left , right, front, behind or below. And the study will also allow 



you to have a better idea of perceiving the direct sound, early reflection, reverberation and 

doubling of sound field types that are generated within an enclosed space. 

During the study of this unit you will learn the behavior of sound by applying the 

electronically controlled circuit variations in the frequency range. The unit will provide you a 

complete idea of the four major types of filters and their frequency response curves which shows 

that how filters are used for stopping high frequencies and allows the low frequency range to 

pass through them and vice versa. You will also study that how a range of frequency technically 

called bandwidth can easily be pass or stop while using the filters. The study of the chapter also 

helps you in finding the working of all the filters in a combine formation which we normally 

called equalizers and a brief idea about the working of graphic equalizers 

While using equalizers you may get a better response or required response 

butyouhavetobeawareofthedamagethatyou’reinflictingonsomeotherpartsofthesignal. The chapter 

will also cover the study of major noises and the ways through which we can efficiently control 

them.  

OBJECTIVES: 

After studying this unit you will be able to: 

1. explain about the acoustic and its types i.e. psycho acoustics and electro acoustics 

2. Identify the harmonics and overtones. 

3. Know about the speed of sound and its deviation with speed and humidity 

4. Differentiate between beats combinational tones and masking 

5. Know about the perception of sound with space. 

6. Differentiate between direct sound, reflections and reverberation of sound due to 

direction. 

7. Explain the function types and the purpose of filters and equalizers. 

8. Explain different types of noises and their causes. 

 

 

 

 



1. PRESSURE 

If you listen to the radio in the mornings, they’ll give you the news, the sports, the traffic and the 

weather. Part of the weather report is to tell you that the barometric pressure is something around 

100 kilopascals (abbreviated kPa). What does this mean? Well, the air particles around you are 

all under pressure due to things like gravity and the weight of the air particles above them and 

other meteorological things that are outside the scope of this unit. That pressure determines the 

amount of physical space between molecules in the air. When there’s a higher barometric 

pressure, there’s less space between the molecules than there is on a day with a lower barometric 

pressure. 

We call this the stasis pressure and abbreviate it ℘o. 

When all of the particles in a gaseous medium (like air) in a given volume (like a room) are at 

normal pressure, then the gas is said to be at its volume density (also known as the constant 

equilibrium density), abbreviated ρo, and measured in kg/m
3
. Remember that this is actually 

kilograms of air per cubic meter – if you were able to trap a cubic meter and weigh it, you’d find 

out that it’s about 1.3 kg. 

These molecules like to stay at the same pressure all over, so if you bunch them up in one place 

in a room somehow, they’ll move around to try and equalize the difference. This is kind of like 

when you pour a glass of water into a bucket, the water level of the entire bucket equalizes and 

therefore rises, rather than the water from the glass all bunching up in a little mound of water 

where you poured it in... 

Let’s think of this as a practical example. We’ll hang the piece of paper in front of a fan. If we 

turn on the fan, we’re essentially increasing the pressure of the air particles in front of the blades. 

The fan does this by removing air particles from the space behind it, thus reducing the pressure 

of the particles behind the blades, and putting them in front. Since the pressure in front of the fan 

is greater than any other place in the room, we have a situation where there is a greater air 

pressure on one side of the piece of paper than the other. The obvious result is that the paper 

moves away from the fan. 

This is a large-scale example of how you hear sound. Let’s say hypothetically for a moment, that 

you are sitting alone in a sealed room on a day when the barometric pressure is 100 kPa. Let’s 
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also say that you have a clarinet with you and that you play a concert A. What physically 

happens to convert air coming out of your mouth into a concert A coming in your ears? 

To begin with, let’s pretend that a clarinet is just a tube with a hole in each end. One of the holes 

has a springy piece of wood next to it which, if you press on it, will close up the hole. 

1. When you blow into the hole, you bunch up the air particles and create a little area of 

high pressure inside the mouthpiece. 

2. Blowing into the hole with the reed on it also has the effect of pushing the reed against 

the hole and sealing it so that no more air can enter the clarinet. 

3. At that point the little high pressure area moves down the clarinet and leaves a low 

pressure behind it. 

4. Remember that the reed is springy, and it doesn’t like being pushed up against the hole in 

the mouthpiece, so it bounces back and lets more air in. 

5. Now the cycle repeats and goes back to step 1 all over again. 

6. In the meantime, all of those high and low pressure areas move down the clarinet and 

radiate out the bell into the room like ripples on a lake when you throw in a rock. 

7. From there, they get to your ear and push your eardrum in and out (high pressure pushes 

in, low pressure pulls out) 

Those little fluctuations in the air pressure are small variations in the stasis pressure ℘o. They’re 

usually very small, never more than about ±1 Pa (though we’ll elaborate on that later...). At any 

given moment at a specific location, we can measure the the instantaneous pressure, ℘, which 

will be close to the stasis pressure, but slightly different because there’s a sound source causing it 

to change. 

Once we know the stasis pressure and the instantaneous pressure, we can use these to figure out 

the instantaneous amplitude of the sound level, (also called the acoustic pressure or the excess 

pressure) abbreviated p, using Equation 2.1. 

        …………………(2.1) (3.1) 
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Figure 2.1: A graphic representation of the values ℘o (the stasis pressure), p (instantaneous 

amplitude) , ℘ (instantaneous pressure), and P (maximum peak pressure). 

To see an animation of what this looks like, check out 

www.gmi.edu/ drussell/Demos/waves/wavemotion.html. 

A sinusoidal oscillation of this pressure reaches a maximum peak pressure P which is used to 

determine the sound pressure level or SPL. In air, this level is typically expressed in decibels as a 

logarithmic ratio of the effective pressure Pe referenced to the threshold of hearing, the 

commonly-accepted lowest sound pressure level audible by humans at 1 kHz, 20 microPascals, 

using Equation 2.2 [Woram, 1989].  

             ……………. (2.2) 
(3.2) 

Note that, for sinusoidal waveforms, the effective pressure can be calculated from the peak 

pressure using Equation 2.3 

                         ………. (2.3) 

2. SIMPLE HARMONIC MOTION 

Take a weight (a little one...) and hang it on the end of a Slinky which is attached to the ceiling 

and wait for it to stop bouncing. 

Measure the length of the Slinky. This length is determined by the weight and the strength of the 

Slinky. If you use a bigger weight, the Slinky will be longer – if the slinky is stronger, it will be 

better able to support the weight and therefore be shorter. 
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This is the point where the “system” is at rest or stasis. 

Pull down on the weight a little bit and let go. The Slinky will pull the weight up to the stasis 

point and pass it. 

By the time the whole thing slows down, the weight will be too high and will want to come back 

down to the stasis point, which it will do, stopping at the point where we let it go in the first 

place (or almost anyway...) 

If we attached a pen to the weight and ran piece of paper along by it as it sat there bobbing up 

and down, the line it would draw a sinusoidal waveform. The picture the weight would draw is a 

graph of the vertical position of the weight (the y-axis) as it relates to time (the x-axis). 

If the graph is a perfect sinusoidal shape, then we call the system (the Slinky and the weight on 

the end) a simple harmonic oscillator. 

3 DAMPING 

Let’s look at that system I just described. We’ll put a weight hung on a spring as is shown in 

Figure 2.2 

  

Figure 2.2: A mass supported by a spring. 
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If there was no such thing as air friction, and if the spring was perfect, then, if you started the 

mass bobbing up and down, then it would continue doing that forever. Since, as we saw in the 

previous section, that this is a simple harmonic oscillator, if we graph its vertical displacement 

over time, then we get a perfect sinusoidal waveform as shown in Figure 2.3 

  

Figure 2.3: The vertical displacement of the mass versus time if there is no loss of energy due to 

friction. Notice that the frequency and amplitude of the oscillation never change. The mass will 

bob up and down exactly the same, forever. 

In real life, however, there is friction. The mass pushes through the air and loses energy on each 

bob up and down. Eventually, it loses so much energy that it stops moving. An example of this 

behaviour is shown in Figure 2.4 

  

Figure 2.4: The vertical displacement of the mass versus time if there is loss of energy due to 

friction. Notice that the fundamental frequency of the oscillation never changes, but that the 

amplitude decays over time. Eventually, the mass will bob up and down so little that it can be 

considered to be stopped. 

There is a technical term that describes the difference between these two situations. The system 

with friction, shown in Figure 2.4 is called a damped oscillator. Since the oscillator is damped, 
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then it loses energy over time. The higher the damping, the faster it loses energy. For example, if 

the same mass and spring were put in water, the system would be more highly damped than if it 

were in air. If they’re put in oil, the system is more highly damped than it is in water. 

Since a system with friction is said to be damped, then the system without friction is therefore 

called an un damped oscillator. 

4. OVERTONES 

Some people call the fundamental and its harmonics overtones but you have to be careful here. 

There is a common misconception that overtones are harmonics and vice versa. In fact, in some 

books, you’ll see people saying that the first overtone is the second harmonic; the second 

overtone is the third harmonic and so on. This is not necessarily the case. A sound’s overtones 

are the harmonics that it contains, which is not necessarily all harmonics. As we’ll see later, not 

all instruments’ sounds contain all harmonics of the fundamental. There are particular cases, for 

example, where an instrument’s sound will only contain the odd harmonics of the fundamental. 

In this particular case, the first overtone is the third harmonic; the second overtone is the fifth 

harmonic and so on. 

In other words, harmonics are a mathematical idea – frequencies that are related to a fundamental 

frequency whereas overtones are the frequencies that are produced by the sound source. 

Another example showing that overtones are not harmonics occurs in many percussion 

instruments such as bells where the overtones have no harmonic relationship with the 

fundamental frequency – which is why these overtones are said to be enharmonically related. 

5.  LONGITUDINAL VS. TRANSVERSE WAVES 

There are basically three types of waves used to transmit energy through a medium or substance. 

1. Transverse 

2. Longitudinal 

3. Torsional 

We’re only really concerned with the first two. 
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Transverse waves are the kind we see every day in ropes and puddles. They’re the kind where 

the motion of the particles is perpendicular to the direction of the wave propagation as can be 

seen in Figure2.5. What does this mean? It’s easy to see if we go fishing. A boat on the surface 

of the ocean will sit there bobbing up and down as the waves roll past it. The waves are traveling 

towards the shore along the surface of the water, but the water itself only moves up and down, 

not sideways (we know this because the boat would move sideways as well if the water was 

doing so...) So, as the water molecules move vertically, the wave propagates horizontally. 

 

Figure 2.5: A snapshot of a transverse wave on a string. Think of the wave as moving from left to 

right – but remember that the string is really only moving up and down. 

Longitudinal waves are a little tougher to see. They involve the compression (bunching together) 

and refraction (pulling apart) of the particles in the medium such that the motion of the particles 

is parallel with the direction of propagation of the wave. The easiest way to see a longitudinal 

wave is to stretch out a Slinky between two people, squeeze together a small section of it and let 

go. The compressed part will appear to move back and forth bouncing between the two ends of 

the spring. This is essentially the way sound travels through air particles. 

Torsional waves don’t apply to anything we’re doing in this book, but they’re waves in which 

the particles rotate around the axis along which the wave propagates (like a twisting rod). This 

type of wave can be seen on a Shive wave machine at physics demonstrations and science and 

technology museums. 

6. DISPLACEMENT   VS   VELOCITY 

Think back to our original discussions concerning sound. We said that there are really two things 

moving in a sound wave – the air molecules (which are compressing and expanding) and the 

pressure wave which propagates outwardly from the sound source. We compared this to a wave 

moving along a rope. The rope moves up and down, but the wave moves in another direction 

entirely. 
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Let’s now think of this difference in terms of displacement and velocity – not of the sound wave 

itself (which is about 344 m/s at room temperature) but of the air molecules. 

When a sound wave goes by a bunch of molecules, they compress and expand. In other words, 

they move closer together, then stop moving, then move further apart, then stop moving, then 

move closer together and so on. When the displacement is at its absolute maximum, the 

molecules are at the point where they’re stopped and about to head back towards a low pressure. 

When the displacement is 0 (and therefore at whatever barometric pressure the radio said it was 

this morning) the molecules are moving as fast as they can. If the displacement is at a maximum 

in the opposite direction, the molecules are stopped again. 

When pressure is 0, the particle velocity is at a maximum (or a minimum) whereas when 

pressure is at a maximum (or a minimum) the particle velocity is 0. 

This is identical to swinging on a playground swing. When you’re at the highest point off the 

ground, you’re stopped and about to head in the direction from which you just came. Therefore 

at the point of maximum displacement, you have a velocity of 0. When you’re at the point 

closest to the ground (where you started before you were moving) your velocity is highest. 

So, in addition to measurements like instantaneous pressure, we can also talk about 

an instantaneous particle velocity, u. In addition, a sinusoidal oscillation results in a peak particle 

velocity, U. 

Always remember that the particle velocity is dependent on the change in displacement, 

therefore it is equivalent to the instantaneous slope (or the partial derivative) of the displacement 

function. As a result, the velocity wave precedes the displacement wave by  radians (or 90∘) as 

is shown in Figure 2.6. 
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Figure 2.6: The relationship between the displacement (in blue), the velocity (in red) and the 

acceleration (in black) of a particle or a pendulum. Note that none of these is on any particular 

scale – the important things to notice are the relationships between the zero, maximum and 

minimum points on the two graphs as well as their relative instantaneous slopes. 

One other important thing to note here is that the velocity is also related to frequency (which is 

discussed below). If we maintain the same peak pressure, the higher the frequency, the faster the 

particles have to move back and forth, therefore the higher the peak velocity. So, remember that 

particle velocity is proportional both to pressure (and therefore displacement) and frequency. 

2.7 SPEED OF SOUND 

Pay attention during any thunder and lightning storm and you’ll be able to figure out that sound 

travels slower than light. Since the lightning and the thunder occur simultaneously and since the 

light flash arrives at you earlier than the clap of thunder (unless you’re extremely unlucky...) then 

this must be true. In fact, the speed of sound, abbreviated c is around 344 m/s although it changes 

with temperature, pressure and humidity. 

Note that we’re talking about the speed of the wave front – not the velocity of the air molecules. 

This latter velocity is dependent on the waveform, as well as its frequency and the amplitude. 

The equation we normally use for c in meters per second is 

 

(3.7) 

where t is the temperature in ∘C 
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There is a small deviation of c with frequency shown in Table 2.1, though this is small and 

therefore generally ignored 

  

Frequency Deviation 
  

100 Hz -30 ppm 

200 Hz -10 ppm 

400 Hz -3 ppm 

1.25 kHz 0 ppm 

4 kHz +5 ppm 

10 kHz +10 ppm 
  

 

Table 2.1: Deviation in the speed of sound with frequency. [Kutruff, 1991] 

Changes in humidity change the value of c as is seen in Table 2.2. 

  

Humidity Deviation 
  

0% 0 ppm 

20% +415 ppm 

40% +1136 ppm 

60% +1860 ppm 

80% +2590 ppm 

100% +3320 ppm 
  

Table 2.2: Deviation in the speed of sound with air humidity levels. [Kutruff, 1991] 

The difference at a humidity level of 100% of 0.33% is bordering on our ability to detect a pitch 

shift. 

Also – in case you were wondering, “ppm” stands for “parts per million.” It’s just like “percent” 

really, except that you divide by 1000000 instead of 100 so it’s useful for really small numbers. 

Therefore 1000 ppm is  = 0.001 = 0.1%. 

8. PSYCHO ACOUSTICS 

The area of psychoacoustics deals with how and why the brain interprets a particular sound 

stimulus in a certain way. Although a great deal of study has been devoted to this subject, the 

primary device in psychoacoustics is the all-elusive brain … which is still largely unknown to 

present-day science. 

 

 

http://www.tonmeister.ca/main/textbook/intro_to_sound_recordingch4.html#x19-1760041
http://www.tonmeister.ca/main/textbook/intro_to_sound_recordingli2.html#Xkutruff:91
http://www.tonmeister.ca/main/textbook/intro_to_sound_recordingch4.html#x19-1760052
http://www.tonmeister.ca/main/textbook/intro_to_sound_recordingli2.html#Xkutruff:91


9. AUDITORY PERCEPTION 

From the outset, it’s important to realize that the ear is a nonlinear device (what’s received at 

your ears isn’t always what you’ll hear). It’s also important to note that the ear’s frequency 

response (its perception of timbre) changes with the loudness of the perceived signal. The 

loudness compensation switch found on many hi-fi preamplifiers is an attempt to compensate for 

this decrease in the ear’s sensitivity to low- and high-frequency sounds at low listening levels. 

The Fletcher–Munson equal-loudness contour curves (Figure 2.7) indicate the ear’s average 

sensitivity to different frequencies at various levels. These indicate the sound-pressure levels that 

are required for our ears to hear frequencies along the curve as being equal in level to a 1000-Hz 

reference level (measured in phons). Thus, to equal the loudness of a 1-kHz tone at 110dB SPL 

(a level typically created by a trumpet-type car horn at a distance of 3 feet), a 40-Hztone has to 

be about 6dB louder, whereas a 10-kHz tone must be 4dB louder in order to be perceived as 

being equally loud. At 50dB SPL (the noise level present in the average private business office), 

the level of a 40-Hz tone must be 30dB louder and a 10-kHz tone 13dB louder than a 1-kHz tone 

to be perceived as having the same volume. Thus, if a piece of music is mixed to sound great at a 

level of 85 to 95dB, its bass and treble balance will actually be boosted when turned up (often a 

good thing). If the same piece were mixed at 110dB SPL, it would sound both bass and treble 

shy when played at lower levels … because no compensation for the ear’s response was added to 

the mix. Over the years, it has generally been found that changes in apparent frequency balance 

are less apparent when monitoring at levels of 85dB SPL. 

 

 



Figure 2.7 The Fletcher–Munson curve shows an equal loudness contour for pure tones as 

perceived by humans having an average hearing acuity. These perceived loudness levels are 

charted relative to sound-pressure levels at 1000Hz. 

In addition to the above, whenever it is subjected to sound waves that are above a certain 

loudness level, the ear can produce harmonic distortion that doesn’t exist in the original signal. 

For example, the ear can cause a loud 1-kHz sine wave to be perceived as being a combination of 

1-, 2-, 3-kHz waves, and so on. Although the ear might hear the overtone structure of a violin (if 

the listening level is loud enough), it might also perceive additional harmonics (thus changing 

the timbre of the instrument). This is one of several factors that implies that sound monitored at 

very loud levels could sound quite different when played back at lower levels. 

The loudness of a tone can also affect our ear’s perception of pitch. For example, if the intensity 

of a 100-Hz tone is increased from 40 to 100dB SPL, the ear will hear a pitch decrease of about 

10%. At 500Hz, the pitch will change about 2% for the same increase in sound-pressure level. 

This is one reason why musicians find it difficult to tune their instruments when listening 

through loud headphones. 

As a result of the nonlinearities in the ear’s response, tones will often interact with each other 

rather than being perceived as being separate. Three types of interaction effects can occur: 

 Beats 

 Combination tones 

 Masking. 

10. BEATS 

Two tones that differ only slightly in frequency and have approximately the same amplitude will 

produce an effect known as beats. This effect sounds like repetitive volume surges that are equal 

in frequency to the difference between these two tones. The phenomenon is often used as an aid 

for tuning instruments, because the beats slow down as the two notes approach the same pitch 

and finally stop when the pitches match. In reality, beats are a result of the ear’s inability to 

separate closely pitched notes. This results in a third frequency that’s created from the phase sum 

and difference values between the two notes. 

11. COMBINATION TONES 

Combination tones result when two loud tones differ by more than 50Hz. In this case, the ear 

perceives an additional set of tones that are equal to both the sum and the difference between the 



two original tones … as well as being equal to the sum and difference between their harmonics. 

The simple formulas for computing the fundamental tones are: 

sum tone= f 1+f 2 

difference tone= f 1−f 2 

Difference tones can be easily heard when they are below the frequency of both tones’ 

fundamentals. For example, the combination of 2000 and 2500Hz produces a difference tone of 

500Hz. 

12. MASKING 

Masking is the phenomenon by which loud signals prevent the ear from hearing softer sounds. 

The greatest masking effect occurs when the frequency of the sound and the frequency of the 

masking noise are close to each other. For example, a 4-kHz tone will mask a softer 3.5-kHz tone 

but has little effect on the audibility of a quiet 1000-Hz tone. Masking can also be caused by 

harmonics of the masking tone (e.g., a 1-kHz tone with a strong 2-kHz harmonic might mask a 

1900-Hz tone). This phenomenon is one of the main reasons why stereo placement and 

equalization are so important to the mixdown process. An instrument that sounds fine by itself 

can be completely hidden or changed in character by louder instruments that have a similar 

timbre. Equalization, mic choice or mic placement might have to be altered to make the 

instruments sound different enough to overcome any masking effect. 

13 PERCEPTION OF SOUND WITH DIRECTION 

Although one ear can’t discern the direction of a sound’s origin, two ears can. This capability of 

two ears to localize a sound source within an acoustic space is called spatial or binaural 

localization. This effect is the result of three acoustic cues that are received by the ears: 

 Interaural intensity differences 

 Interaural arrival-time differences 

 The effects of the pinnae (outer ears). 

Middle to higher frequency sounds originating from the right side will reach the right ear at a 

higher intensity level than the left ear, causing an interaural intensity difference. This volume 

difference occurs because the head casts an acoustic block or shadow, allowing only reflected 



sounds from surrounding surfaces to reach the opposite ear (Figure 2.25). Because the reflected 

sound travels farther and loses energy at each reflection—in our example the intensity of sound 

perceived by the left ear will be greatly reduced, resulting in a signal that’s perceived as 

originating from the right. 

This effect is relatively insignificant at lower frequencies, where wavelengths are large compared 

to the head’s diameter, allowing the wave to easily bend around its acoustic shadow. For this 

reason, a different method of localization (known as interaural arrival-time differences) is 

employed at lower frequencies (Figure 2.26). In both Figures 2.8 and 2.9, small time differences 

occur because the acoustic path length to the left ear is slightly longer than the path to the right 

ear. The sound pressure therefore arrives at the left ear at a later time than the right. This method 

of localization (in combination with interaural intensity differences) helps to give us lateral 

localization cues over the entire frequency spectrum. 

 

Figure 2.8The head casts an acoustic shadow that helps with localization at middle to upper frequencies. 

 

Figure 2.9Interaural arrival-time differences occurring at lower frequencies. 

Intensity and delay cues allow us to perceive the direction of a sound’s origin but not whether the 

sound originates from the front, behind or below. The pinna (Figure 2.9), however, makes use of 

two ridges that reflect sound into the ear. These ridges introduce minute time delays between the 

direct sound (which reaches the entrance of the ear canal) and the sound that’s reflected from the 

ridges (which varies according to source location). It’s interesting to note that beyond 130° from 

the front of our face, the pinna is able to reflect and delay sounds by 0 and 80 microseconds 



(µsec), making rear localization possible. Ridge 2 (see Figure 2.9) has been reported to produce 

delays of between 100 and 330 µsec that help us to locate sources in the vertical plane. The 

delayed reflections from both ridges are then combined with the direct sound to produce 

frequency–response colorations that are compared within the brain to deter-mine source location. 

Small movements of the head can also provide additional position information. 

 

Figure 2.9 The pinna and its reflective ridges for determining vertical location information. 

If there are no differences between what the left and right ears hear, the brain assumes that the 

source is the same distance from each ear. This phenomenon allows us to position sound not only 

in the left and right loud-speakers but also monophonically between them. If the same signal is 

fed to both loudspeakers, the brain perceives the sound identically in both ears and deduces that 

the source must be originating from directly in the center. By changing the proportion that’s sent 

to each speaker, the engineer changes the relative interaural intensity differences and thus creates 

the illusion of physical positioning between the speakers. This placement technique is known as 

panning (Figure 2.10). 



 

Figure 2.10 Pan pot settings and their relative spatial positions. 

14. PERCEPTION OF SOUND WITH SPACE 

In addition to perceiving the direction of sound, the ear and brain combine to help us perceive the 

size and physical characteristics of the acoustic space in which a sound occurs. When a sound is 

generated, a percentage reaches the listener directly, without encountering any obstacles. A 

larger portion, however, is propagated to the many surfaces of an acoustic enclosure. If these 

surfaces are reflective, the sound is bounced back into the room and toward the listener. If the 

surfaces are absorptive, less energy will be reflected back to the listener. Three types of 

reflections are commonly generated within an enclosed space (Figure 2.11) 

 

Figure 2.11 The three sound field types that are generated within an enclosed space. 

 



 Direct sound 

 Early reflections 

 Reverberation. 

15 DIRECT SOUND 

In air, sound travels at a constant speed of about 1130 feet per second, so a wave that travels 

from the source to the listener will follow the shortest path and arrive at the listener’s ear first. 

This is called the direct sound. Direct sounds determine our perception of a sound source’s 

location and its size and conveys the true timbre of the source. 

16. EARLY REFLECTIONS 

Waves that bounce off of surrounding surfaces in a room must travel further than direct sound to 

reach the listener and therefore arrive after the direct sound and from a multitude of directions. 

These waves form what are called early reflections. Early reflections give us clues as to the 

reflectivity, size and general nature of an acoustic space. These sounds generally arrive at the 

ears less than 50msec after the brain perceives the direct sound and are the result of reflections 

off of the largest, most prominent boundaries within a room. The time elapsed between hearing 

the direct sound and the beginning of the early reflections helps to provide information about the 

size of the performance room. Basically, the farther the boundaries are from the source and 

listener, the longer the delay before it’s reflected back to the listener. 

Another aspect that occurs with early reflections is called temporal fusion. Early reflections 

arriving at the listener within 30msec of the direct sound are not only audibly suppressed, but are 

also fused with the direct sound. In effect, the ear can’t distinguish the closely occurring 

reflections and considers them to be part of the direct sound. The 30-msec time limit for 

temporal fusion isn’t absolute; rather, it depends on the sound’s envelope. Fusion breaks down at 

4msec for transient clicks, whereas it can extend beyond 80msec for slowly evolving sounds 

(such as a sustained organ note or legato violin passage). Despite the fact that the early 

reflections are suppressed and fused with the direct sound, they still modify our perception of the 

sound, making it both louder and fuller. 

17. REVERBERATION 

Whenever room reflections continue to bounce off of room boundaries, a randomly decaying set 

of sounds can often be heard after the source stops in the form of reverberation. A highly 

reflective surface absorbs less of the wave energy at each reflection and allows the sound to 



persist longer after the initial sound stops (and vice versa). Sounds reaching the listener 50-msec 

later in time are perceived as a random and continuous stream of reflections that arrive from all 

directions. These densely spaced reflections gradually decrease in amplitude and add a sense of 

warmth and body to a sound. Because it has undergone multiple reflections, the timbre of the 

reverberation is often quite different from the direct sound (with the most notable difference 

being a roll-off of high frequencies and a slight bass emphasis). 

The time it takes for a reverberant sound to decrease to 60 dB below its original level is called its 

decay time or reverb time and is determined by the room’s absorption characteristics. The brain 

is able to perceive the reverb time and timbre of the reverberation and uses this information to 

form an opinion on the hardness or softness of the surrounding surfaces. The loudness of the 

perceived direct sound increases rapidly as the listener moves closer to the source, while the 

reverberation levels will often remain the same, because the diffusion is roughly constant 

throughout the room. This ratio of the direct sound’s loudness to the reflected sound’s level helps 

listeners judge their distance from the sound source. 

Whenever artificial reverb and delay units are used, the engineer can generate the necessary cues 

to convince the brain that a sound was recorded in a huge, stone-walled cathedral—when, in fact, 

it was recorded in a small, absorptive room. To do this, the engineer programs the device to mix 

the original un-reverberated signal with the necessary early delays and random reflections. 

Adjusting the number and amount of delays on an effects processor gives the engineer control 

over all of the necessary parameters to determine the perceived room size, while decay time and 

frequency balance can help to determine the room’s perceived surfaces. By changing the 

proportional mix of direct-to-processed sound, the engineer/producer can place the sound source 

at either the front or rear of the artificially created space. 

Doubling 

By repeating a signal using a short delay of 4 to 20msec (or so), the brain can be fooled into 

thinking that the apparent number of instruments being played is doubled. This process is called 

doubling. Often, acoustic doubling and tripling can be physically re-created during the overdub 

phase by recording a track and then going back and laying down one or more passes while the 

musicians listen to the original track. When this isn’t possible, delay devices can be cost 

effectively and easily used to simulate this effect. If a longer delay is chosen (more than about 

35msec), the repeat will be heard as discrete echoes, causing the delay (or series of repeated 



delays) to create a slap echo or slap back. This and other effects can be used to double or thicken 

up a sound … anybody want vocals that sound like a 1950s pop star? 

18.  FILTERS 

Beforedivingstraightinandtalkingabouthowequalizersbehave,we’llstartwiththebasicsandlookatfo

urdifferenttypesoffilters.Justlikeacoffeefilterkeepscoffeegrindstrappedwhileallowingcoffeetoflow

through,anaudiofilterletssomefrequenciespassthroughunaffectedwhilereducingthelevelofothers. 

Low-pass Filter 

Oneoftheconceptuallysimplestfiltersisknownasalow-

passfilterbecauseitallowslowfrequenciestopassthroughit.Thequestion,ofcourse,is“howlowislow?

”Theanswerliesinasinglefrequencyknownasthecutofffrequencyorfc.Thisisthefrequencywheretheo

utputofthefilteris3.01dBlowerthanthemaximumoutputforanyfrequency(althoughwenormallyrou

ndthisoffto-3dBwhichiswhyit’susuallycalledthe3dBdownpoint).“What’ssospecial about -3dB?” I 

hearyoucry. This particular numberischosenbecause-

3dBisthelevelwherethesignalisatonehalfthepowerofasignalat0dB.So, 

ifthefilterhasnoadditionalgainincorporatedintoit,thenthecutofffrequencyistheonewheretheoutput

isexactlyonehalfthepoweroftheinput.(Whichexplainswhysomepeoplecallitthehalf-powerpoint.) 

Asfrequenciesgethigherandhigher,theyareattenuatedmoreandmore.Thisresultsinaslopeinthefreq

uencyresponsegraphwhichcanbecalculatedbyknowingtheamountofextraattenuationforagivencha

ngeinfrequency.Typically, thisslopeisspecifiedindecibelsperoctave.Sincethe higher we go, the 

more weattenuate inalow pass filter,thisvalue willalwaysbenegative. 

Theslopeofthefilterisdeterminedbyitsorder.Ifweoversimplifyjusta little,afirst-orderlow-

passfilterwillhaveaslope of-6.02dBper octaveaboveitscutofffrequency(usuallyroundedto-

6dB/oct).Ifwe 

wanttobetechnicallycorrectaboutthis,thenwehavetobealittlemorespecificaboutwherewefinallyreach

thisslope.TakealookatthefrequencyresponseplotinFigure 

2 .12 .Noticethatthegraphhasanicegradualtransitionfromaslopeof0(ahorizontalline)inthereallylowf

requenciestoaslopeof -

6dB/octinthereallyhighfrequencies.Intheareaaroundthecutofffrequency,however,theslopeischangin

g.Ifwewanttobereallyaccurate,thenwehave tosay that the slope of the frequency response is really 

0 forfrequencieslessthanone tenth ofthecutofffrequency.Inother 

words,forfrequenciesmorethanonedecadebelowthecutofffrequency. Similarly,the 



slopeofthefrequencyresponseisreally-

6.02dB/octforfrequenciesmorethanonedecadeabovethecutofffrequency. 

Ifwehaveahigher-orderfilter,thecutofffrequencyisstilltheonewherethe outputdropsby3 

dB,howeverthe slopechangestoa 

valueof−6.02ndB/oct,wherenistheorderofthefilter.Forexample,ifyouhavea3rd-

orderfilter,thentheslopeis 

 

slope= order∗−6.02dB/oct 

 

              (2.4) 

= 3∗−6.02dB/oct (2.5) 

= −18.06dB/oct (2.6) 

 

 
  

 

 

 

Figure 2 . 1 2 :Thefrequencyresponseofafirst-orderlowpassfilterwithacutoff 

frequencyof1kHz.Notethatthecutofffrequencyiswheretheresponsehasdropped 

inlevelby3dB.Theslopecanbecalculatedbydividingthedropinlevelbythechange 

infrequencythatcorrespondstothatparticulardrop. 

High-passFilter 

Ahigh-passfilterisessentiallyexactlythesameasalow-

passfilter,however,itpermitshighfrequenciestopassthroughwhileattenuatinglowfrequenciesascanbe

seeninFigure2.13.Justlikeintheprevioussection,thecutofffrequencyiswheretheoutputhasalevelof-



3.01dBbutnowtheslopebelowthecutofffrequencyispositivebecausewegetlouderasweincreaseinfreq

uency.Justlikethelow-passfilter,theslopeofthehigh-

passfilterisdependentontheorderofthefilterandcanbecalculatedusingtheequation6.02ndB/oct,where

nistheorderofthefilter. 

 
Frequency(Hz) 

Figure 2.13: Thefrequencyresponseofafirst-orderhighpassfilterwithacutofffrequencyof1kHz. 

 

Rememberaswellthattheslopeonlyappliestofrequenciesthatareatleastonedecadeawayfromthe 

cutofffrequency. 

Band-passFilter 
 

Let’stakeasignalandsenditthroughahigh-passfilterandalow-passfilterinseries,sothe 

outputofonefeedsintotheinputoftheother.Let’salsoassumeforamomentthatthetwocutofffrequencies

aremorethanadecadeapart. 

Theresultofthisprobablywon’tholdanysurprises.Thehigh-passfilterwillattenuate 

thelowfrequencies,allowingthehigher frequencies topassthrough.Thelow-

passfilterwillattenuatethehighfrequencies,allowingthelowerfrequenciestopassthrough.Theresultisth

atthehighandlowfrequenciesareattenuated,withamiddleband(calledthepassband)that’sallowedtopas

srelativelyunaffected. 

 



Bandwidth 

Thisresultingsystemiscalledabandpassfilterandithasacoupleofspecifi-

cationsthatweshouldhavealookat.Thefirstisthewidthofthepassband.Thisbandwi

dthiscalculatedusingthedifferencetwocutofffrequencieswhichwe’lllabelfc1forth

eloweroneandfc2forthehigherone.Consequently,thebandwidthiscalculatedusing

theequation: 

BW=fc2−fc1 (2.7) 

So,usingtheexampleofthefilterfrequencyresponse shown 

inFigure4,thebandwidthis10,000Hz–20Hz=9980Hz. 

 

CentreFrequency 

Wecanalsocalculatethemiddleofthepassbandusingthesetwofrequencies.It’snotquitesos

impleaswe’dlike,however.Unfortunately,it’snotjustthefrequencythat’shalf-

waybetweenthelowandhighfrequencycutoff’s.Thisisbecausefrequencyspecificationsd

on’treallycorrespondtothewaywehearthings.Humansdon’tusuallytalkaboutfrequency

–

theytalkaboutpitchesandnotes.Theysaythingslike“MiddleC”insteadof“262Hz.”Theyal

sosaythingslike“oneoctave”or“onesemitone”insteadofthingslike“abandwidthof262Hz.

” 

Considerthat,ifwe playtheAbelowMiddleConawell-tuned 

piano,we’llhearanotewithafundamentalof220Hz.Theoctaveabovethatis440Hzandtheo

ctaveabovethatis880Hz.Thismeansthatthebandwidthofthefirstofthesetwooctavesis220

Hz(it’s440Hz–220Hz),butthebandwidthofthesecondoctaveis440Hz(880Hz–

440Hz).Despitethefactthattheyhavedifferentbandwidths,we hearthemeach 

asoneoctave,andwehearthe440Hznoteasbeinghalf-

waybetweentheothertwonotes.So,howdowecalculatethis?Wehavetofindwhat’sknowna

sthegeometricmeanofthetwofrequencies.Thiscanbefoundusingtheequation 

fcentre=  (fc1fc2) (2..8) 

Q 

Let’ssaythatyouwanttobuildabandpassfilterwithabandwidthofoneoctave.Thisisn’tdifficultifyoukno

wthecentrefrequencyandifit’snevergoingtochange.Forexample,ifthecentrefrequencywas440Hz,and



the bandwidthwas one octave wide,thenthe cutoff frequencies 

wouldbe311Hzand622Hz(wewon’tworrytoomuchabouthowIarrivedatthesenumbers).Whathappens

ifweleavethebandwidththesameat311Hz,butchangethecentrefrequencyto880Hz?Theresultisthatthe

bandwidthisnownolongeranoctavewide–it’sonehalfofanoctave.So,wehavetolinkthe 

bandwidthwiththecentrefrequencyso that we candescribeitin 

termsofafixedmusicalinterval.Thisisdoneusingwhatisknownasthe 

qualityorQofthefilter,calculatedusingtheequation: 

Q =F center / BW 

Now,insteadoftalkingaboutthebandwidthofthefilter,wecanusetheQwhichgivesusanideaofthewidtho

fthefilterinmusicalterms.Thisisbecause,asweincreasethecentrefrequency,wehavetoincreasetheband

widthproportionatelytomaintainthesameQ.Noticehowever,thatifwemaintainacentrefrequency,thes

mallerthebandwidthgets,thebiggertheQbecomes,soifyou’reusedtotalkingintermsofmusicalintervals

,youhave tothinkbackwards.AbigQisasmallerinterval ascanbeseenintheplotofanumber 

ofdifferentQ’sinFigure2.14. 

 

Figure 2.14: The frequency responses of variousbandpassfilters withdifferentQ’sand a matchedcentrefrequency  of  1  kHz. 

 

NoticeinFigure 

2.14thatyoucanhaveaveryhighQ,andthereforeaverynarrowbandwidthforabandpassfilter.Allofthe

definitionsstillhold,however.Thecutofffrequenciesarestillthepointswherewe’re3dBlowerthanthe

maximumvalueandthebandwidthisstillthedistanceinHertzbetweenthesetwopointsandsoon... 



Band-rejectFilter 

Althoughbandpassfiltersareveryusefulataccentuatingasmallbandoffrequencieswhileattenuatingoth

ers,sometimeswewanttodotheopposite. 

Wewanttoattenuateasmallbandoffrequencieswhileleavingtherestalone.Thiscanbeaccomplishedusin

gaband-reject 

filter(alsoknownasabandstopfilter)which,asitsnameimplies,rejects(orusuallyjustattenuates)abandof

frequencieswithoutaffectingthesurroundingmaterial.AscanbeseeninFigure 

2.15,thiswindsuplookingverysimilartoabandpassfilterdrawnupsidedown. 

 

Figure 2.15:Thefrequencyresponseofaband-rejectfilterwithacentrefrequencyof1kHz. 

Thethingtobecarefulofwhendescribingband-

rejectfiltersisthefactthatcutofffrequenciesarestilldefinedasthepointswhere 

we’vedroppedinlevelby3dB.Therefore,wedon’treallygetanintuitiveideaofhowmuchwedropatthecen

trefrequency.LookingatFigure2.15wecanseethat,althoughtheband-

rejectfilterlooksjustlikethebandpassfilterupsidedown,thebandwidthisquitedifferent.Thisisafairlyim

portantpointtoremember alittlelateroninthesectiononsymmetry. 

Equalizers 

Unlikeitscounterpartfromthedaysoflong-

distancephonecalls,amodernequalizerisadevicethatiscapableofattenuatingandboostingfrequenciesaccording



tothedesireandexpertiseoftheuser.Therearefourbasictypesofequalizers,butwe’llhavetotalkaboutacoupleofiss

uesbeforegettingintothenitty-gritty. 

Anequalizertypicallyconsistsofacollectionoffilters,eachofwhichpermitsyoutocontroloneormoreofthreething

s:thegain,centre 

frequencyandQofthefilter.Therearesomeminordifferencesinthesefiltersfromtheoneswediscussedabove,butw

e’llsortthatoutbeforemovingon. 

Also,thefiltersintheequalizermaybeconnectedinparallelorinseries,dependingonthetypeofequalizerandthema

nufacturer. 

Tobeginwith,as we’llsee,a 

filterinanequalizercomesinthreebasicmodels,thebandpass,andthebandreject,whicharetypicallychosenbytheu

serbymanipulatingthegainofthefilter.Onadecibelscale, 

positivegainresultsinabandpass,whereasnegativegainproducesabandreject.Inaddition,thereistheshelvingfilte

rwhichisavariationonthehighpassandlowpassfilters. 

TheprincipaldifferencebetweenfiltersinanequalizerandthefiltersdefinedinSection1isthat,inatypicalequalizer,

insteadofattenuatingallfrequenciesoutsidethepassband,thefiltertypicallyleavesthematagainof0dB.Anexampl

eofthiscanbeseenintheplotofanequalizer’sbandpassfilterinFigure 

2.16.Noticenowthat,ratherthanattenuatingall 

unwantedfrequencies,thefilterisapplyingaknowngaintothepassband.Thefurther away 

yougetfromthepassband,thelessthesignalisaffected.Notice,however,thatwestillmeasurethebandwidthusingth

etwopointsthat are 3 dBdownfrom thepeak ofthe curve. 

 

Figure 
2.16:Thefrequencyresponseofabandpassfilterwithacentrefrequencyof1kHz,aQof

4,andagainof12dBinatypicalequalizer. 



GraphicEqualizer 

Graphicequalizersareseenjustabouteverywherethesedays,primarilybe-

causethey’reintuitivetouse.Infact,theyareprobablythemost-

usedpieceofsignalprocessingequipmentinrecording.Thename“graphicequalizer”comesfromthe

factthatthedeviceismadeupofanumberoffilterswithcentrefrequenciesthatareregularlyspaced,eac

hwithasliderusedforgaincontrol.Theresultisthatthearrangementoftheslidersgivesagraphicrepres

entationofthefrequencyresponseoftheequalizer.Themostcom-

monfrequencyresolutionsavailableareone-octave,two-third-octaveandone-third-

octave,althoughresolutionsasfineasone-twelveth-octaveexist.Theslidersonmost 

graphicequalizersuse 

ISOstandardizedbandcenterfrequencies.Theyvirtuallyalwaysemployreciprocalpeak/dipfilterswi

redinparallel.Asaresult,whentwoadjacentbandsareboosted,thereremainsacomparativelylargedi

pbetweenthetwopeaks.Thisprovestobeagreatdisadvantagewhenattemptingtoboostafrequencybe

tweentwocenterfrequencies.Drasticallyexcessiveamountsofboostmayberequiredattheband 

centers in order toproperly adjust the desiredfrequency.This 

problemiseliminatedingraphicEQ’susingthemuch-less-

commoncombiningfilters.Inthissystem,thefilterbanksarewiredinseries,thusadjacentbandshavea

cumulativeeffect.Consequently,inordertoboostafrequencybetweentwocenterfrequencies,thegive

nfiltersneedonlybeboostedaminimalamounttoresultinahigher-boostedmid-frequency. 

VirtuallyallgraphicequalizershavefixedfrequenciesandafixedQ.Thismakes themsimple to 

useandquick toadjust,howeverthey 

aregenerallyacompromise.Althoughquitesuitableforgeneralpurposes,insituationswhereaspecifi

cfrequencyorbandwidthadjustmentisrequired,theywillprovetobeinaccurate. 

ParagraphicEqualizer 

Oneattempttoovercomethelimitationsofthegraphicequalizeristhepara-

graphicequalizer.Thisisagraphicequalizerwithfinefrequencyadjustmentoneachslider.Thisgivest

heusertheabilitytosweepthecenterfrequencyofeachfiltersomewhat,thusgivinggreatercontrolovert

hefrequencyreponseofthesystem. 

19. LOUDNESS AND NOISE REDUCTION 

 Loudness 

Althoughwerarelyliketoadmitit,we 

humansaren’tperfect.Thisistrueinmanyrespects,butforthepurposesofthisdiscussion,we’llconcentr



atespecificallyonourabilitiestohearthings.Unfortunately,ourearsdon’thavethesamefrequencyresp

onseatalllisteninglevels.Atveryhighlisteninglevels,wehavea relativelyflat 

frequencyresponse,butasthe 

leveldrops,sodoesoursensitivitytohighandlowfrequencies.Asaresult,ifyoumixatune at a very 

highlistening level and thenreduce the level,it 

willappeartolacklowendandhighend.Similarly,ifyoumixatalowlevelandturnitup,you’lltendtogetm

orelowendandhighend. 

Onepossibleuseforanequalizeristocompensatefortheperceivedlackof information in 

extremefrequency ranges at low listening levels.Essentially, when you turndown 

themonitorlevels,youcanuseanequalizertoincreasethelevelsofthelowandhighfrequencycontenttoc

ompensatefordeficienciesinthehumanhearing mechanism.Thisfilteringisidentical 

tothatwhichisengagedwhenyoupressthe“loudness”buttononmosthomestereosystems.Ofcourse,th

edangerwithsuchequalizationisthatyoudon’tknowwhatfrequencyrangestoalter,andhowmuchtoalte

rthem–soitisnotrecommendabletodosuchcompensationwhenyou’re 

mixing,onlywhenyou’reathomelisteningtosomethingthat’salreadymeenmixed. 

NoiseReduction 

It’spossibleinsomespecificcasestouseequalizationtoreducenoiseinrecordings,butyouha

vetobeawareofthedamagethatyou’reinflictingonsomeotherpartsofthesignal. 

 

High-frequencyNoise(Hiss) 

Let’ssaythatyou’vegotarecordingofanelectricbassonareallynoisyanalogtapedeck.Since

mostoftheperceivablenoiseisgoingtobehigh-

frequencystuffandsincemostofthesignalthatyou’reinterestedinisgoingtobelow-

frequencystuff,allyouneedtodoistorolloffthehighendtoreducethenoise.Ofcourse,thisisb

ebestofallpossibleworlds.It’smorelikelythatyou’regoingtobecopingwithasignalthathas

somehigh-

frequencycontent(likeyourleadvocals,forexample...)soifyoustartrollingoffthehighendt

oomuch,youstartlosingalotofbrightnessandsparklefromyoursignal,possiblymakingthee

ndresultworsethatyoustarted.Ifyou’reusingequalizationtoreducenoiselevels,don’t 

forgettooccasionallyhitthe“bypass”switchoftheequalizeronceandawhiletoheartheorigi

nal.Youmayfindwhenyourefreshyourmemorythatyou’vegonealittletoofarinyourattemp

tstomakethingsbetter. 

 



Low-frequencyNoise(Rumble) 

Almosteveryconsoleintheworldhasalittlebuttononeveryinputstripthathasasymbolthatlo

okslikealittlerampwiththeslopeontheleft.Thisisahigh-passfilterthatistypicallyasecond-

orderfilter with 

acutofffrequencyaround100Hzorso,dependingonthemanufacturerandtheyearitwasbuil

t.Thereasonthatfilteristhereistohelptherecordingorsoundreinforcementengineergetrid

oflow-

frequencynoiselike“stagerumble”ormicrophonehandlingnoise.Inactualfact,thisfilterw

on’t eliminate 

allofyourproblems,butitwillcertainlyreducethem.Rememberthatmostsignalsdon’tgobe

low100Hz(thisisaboutanoctaveandahalfbelowmiddleConapiano)soyouprobablydon’t

needeverythingthatcomesfromthemicrophoneinthisfrequencyrange–

infact,chancesare,unlessyou’rerecordingpipeorgan,electricbassorspaceshuttlelaunches,

youwon’tneednearlyasmuchasyouthinkbelow100Hz. 

Hummmmmmm... 

Therearemanyreasons,forgivableandunforgivable,whyyoumaywindupwithanunwantedhuminyou

rrecording.Perhapsyouworkwithapoorly-

installedsystem.Perhapsyourrecordingtookplaceunderabuzzingstreetlamp.Whateverthereason,yo

ugetasinglefrequency(andperhapsanumberofitsharmonics)singingallthewaythroughyourrecordin

g.Thenicethingaboutthissituationisthat,mostofthetime,thehumisatapredictablefrequency(depend

ingonwhereyoulive,it’slikelyamultipleofeither50Hzor60Hz)andthatfrequencyneverchanges.Ther

efore,inordertoreduce,oreveneliminatethishum,youneedaverynarrowband-

rejectfilterwithalotofattenuation.Justthesortofjobforanotchfilter.Thedrawbackisthatyoualsoattenu

ateanyofthemusicthathappenstobeatorverynearthenotchcentrefrequency,soyoumayhavetoreachac

ompromisebetweeneliminatingthehumandhavingtoodetrimentalofaneffectonyoursignal. 

 

 

 

 

 

 

 



Self Assessment Questions 

 

Q 1 Draw a sinusoidal waveform and highlight graphic representation of the values ℘o (the 

stasis pressure), p (instantaneous amplitude) , ℘ (instantaneous pressure), 

and P (maximum peak pressure). 

 

Q2 Define the following 

  A damping with the help of an example 

B Transverse wave 

C Longitudinal wave 

D Torsional wave 

 

Q3 what are the three major types of interaction effects explain them briefly? 

 

Q4 Explain the behavior of ear due to the perception of sound with direction? 

 

Q5 Describe filter and types of filters? 

 

Q6 briefly describe the following 

 A Hiss 

 B Rumble 

 C Hmmmmm 
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INTRODUCTION 

Dear students a good engineer will have made hundreds of recordings using dozens of 

different microphones. Each session is an opportunity to make a new discovery. The engineer 

will make careful notes of the setup, and will listen to the results many times to build an 

association between the technique used and the sound achieved.  

David Edward Hughes invented a carbon microphone in the 1870s. The first microphone that 

enabled proper voice telephony was the loose-contact carbon microphone.  

Dear students the microphones are of different types. In this unit we will learn about how 

different microphones convert the sound signal into an electrical signal. This will help the 

students in choosing microphone according to the recording requirement.  

 

Dear Students the microphone generates an electrical current which is very small sometimes 

before using the signal its needs to be amplified. Students the microphone's directionality or 

polar pattern indicates how sensitive it is to sounds arriving at different angles. In this unit 

the students will also learn the practice of microphone placement and how to achieve better 

results for different environments. 

 

Dear Students microphones every microphone have a frequency response which refers to the 

way a microphone responds to different frequencies. For example, a frequency response 

which favors low frequencies means that the resulting audio output will sound more bass 

than the original sound. 

In this unit students will explore the microphone and will learn the professional use of the 

microphone.     

 

 

 

 



OBJECTIVES 

After completion of this lesson student will: 

 

 Be able to identify the different types of microphones. 

 Be able to discuss issues regarding microphones. 

 Learn polar pattern indicates how sensitive it is to sounds arriving 

 Select a microphone that effectively matches the characteristics of an instrument. 

 Position a microphone in a way that accommodates an instrument's complex sound 

radiation patterns. 

 Devise multiple microphone configurations in order to attain more accurate or 

compelling recordings. 

 Learn about microphone placement to achieve better results for different environments 

 Work with close as well as distant microphone configurations. 

 Utilize stereo microphones to convey the spatial qualities of instruments and ensembles. 

 Execute a moderately complex recording session with multiple simultaneous performers. 

 

 

 

 

 

 

 

 

 

  



1. MICROPHONE 

A microphone is an electronic device that converts sound into an electrical signal. 

Electromagnetic transducers facilitate the conversion of acoustic signals into electrical 

signals.  Sound information exists as patterns of air pressure; the microphone changes this 

information into patterns of electric current. The recording engineer is always interested in 

the accuracy of this transformation. Microphones are used in many applications such as 

public address systems, motion picture production, live and recorded audio engineering, two-

way radios, megaphones, radio and television broadcasting. 

Most microphones today use electromagnetic induction (dynamic microphones), capacitance 

change (condenser microphones) or piezoelectricity (piezoelectric microphones) to produce 

an electrical signal from air pressure variations. Microphones typically need to be connected 

to a preamplifier before the signal can be amplified with an audio power amplifier and a 

speaker or recorded. 

 

Electronic Symbol 

Different types of microphone have different ways of converting energy but they all share 

one thing in common: The diaphragm, this is a thin piece of material (such as paper, plastic 

or aluminum) which vibrates when it is struck by sound waves. In a typical hand-held 

microphone like the one below, the diaphragm is located in the head of the microphone. 

 

Location of Microphone Diaphragm 

 



When the diaphragm vibrates, it causes other components in the microphone to vibrate. 

These vibrations are converted into an electrical current which becomes the audio signal. 

 

2. TYPES OF MICROPHONE 

There are a number of different types of microphone in common use. The differences can be 

divided into two areas: 

 

a. The type of conversion technology they use 

This refers to the technical method the microphone uses to convert sound into electricity. The 

most common technologies are dynamic, condenser, ribbon and crystal. Each has advantages 

and disadvantages, and each is generally more suited to certain types of application.  

 

b. The type of application they are designed for 

Some microphones are designed for general use and can be used effectively in many different 

situations. Others are very specialized and are only really useful for their intended purpose.  

 

2.1 Dynamic Microphones 

Dynamic microphones are versatile and ideal for general-purpose use. They use a simple 

design with few moving parts. They are relatively strong and flexible to rough handling. 

They are also better suited to handling high volume levels, such as from certain musical 

instruments or amplifiers. They have no internal amplifier and do not require batteries or 

external power. 

When a magnet is moved near a coil of wire an electrical current is generated in the wire. 

Using this electromagnet principle, the dynamic microphone uses a wire coil and magnet to 

create the audio signal. 

The diaphragm is attached to the coil. When the diaphragm vibrates in response to incoming 

sound waves, the coil moves backwards and forwards past the magnet. This creates a current 

in the coil which is channeled from the microphone along wires. A common configuration is 

shown below. 

 



 

Cross-Section of Dynamic Microphone 

 

Earlier we mentioned that loudspeakers perform the opposite function of microphones by 

converting electrical energy into sound waves. This is demonstrated perfectly in the dynamic 

microphone which is basically a loudspeaker in reverse. When you see a cross-section of a 

speaker you'll see the similarity with the diagram above. Dynamics do not usually have the 

same flat frequency response as condensers. Instead they tend to have tailored frequency 

responses for particular applications. 

Neodymium magnets are more powerful than conventional magnets, meaning that 

neodymium microphones can be made smaller, with more linear frequency response and 

higher output level. 

Advantages 

Robust and durable, can be relatively inexpensive, insensitive to changes in humidity, need 

no external or internal power to operate, can be made fairly small. 

Disadvantages 

 Resonant peak in the frequency response, typically weak high frequency response beyond 

10kHz. 

 



The ribbon microphone 

The ribbon microphone operates almost the same as the moving coil microphone. The major 

difference is that the transducer is a strip of extremely thin aluminum foil wide enough and 

lights enough to be vibrated directly by the moving molecules of air of the sound wave, so no 

separate diaphragm is necessary. However, the electrical signal generated is very small 

compared to a moving coil microphone, so an output transformer is needed to boost the 

signal to a usable level. 

 

Block diagram of ribbon microphone 

Like the dynamic microphone, the high frequency response is governed by the mass of the 

moving parts. But because the diaphragm is also the transducer, the mass is usually a lot less 

than a dynamic type. As a result, the upper frequency response tends to reach slightly higher, 

to around 14kHz. The frequency response is also generally flatter than for a moving coil 

microphone. 

All good studio ribbon mics provide more opportunity to EQ to taste since they “take” EQ 

well. Ribbon mics have their resonance peak at the bottom of their frequency range, which 

means that a ribbon just doesn’t add any extra high frequency hype like condenser mics do. 

 

Advantages 

 Relatively fl at frequency response, extended high frequency response as compared to 

dynamics, needs no external or internal power to operate. 



Disadvantages 

 Fragile—requires care during operation and handling, moderately expensive. 

 

2.3 Condenser Microphones 

Condenser means capacitor, an electronic component which stores energy in the form of an 

electrostatic field. The term condenser is actually obsolete but has stuck as the name for this 

type of microphone, which uses a capacitor to convert acoustical energy into electrical 

energy. 

Condenser microphones require power from a battery or external source. The resulting audio 

signal is stronger signal than that from a dynamic. Condensers also tend to be more sensitive 

and responsive than dynamics, making them well-suited to capturing faint nuances in a 

sound. They are not ideal for high-volume work, as their sensitivity makes them flat to 

distort. 

 

Cross-Section of a Typical Condenser Microphone 

A capacitor has two plates with a voltage between them. In the condenser microphone, one of 

these plates is made of very light material and acts as the diaphragm. The diaphragm vibrates 

when struck by sound waves, changing the distance between the two plates and therefore 

changing the capacitance. Specifically, when the plates are closer together, capacitance 

increases and a charge current occurs. When the plates are further apart, capacitance 

decreases and a discharge current occurs. A voltage is required across the capacitor for this to 



work. This voltage is supplied either by a battery in the microphone or by external phantom 

power. 

Advantages Excellent high frequency and upper harmonic response can have excellent low 

frequency response. 

Disadvantages Moderate to very expensive, requires external powering, can be relatively 

bulky; low cost (and some expensive) models can suffer from poor or inconsistent frequency 

response, two mics of the same model may sound quite different, humidity and temperature 

affect performance. 

 

2.4 The Electret Condenser Microphone 

The electret condenser microphone uses a special type of capacitor which has a permanent 

voltage built in during manufacture. This is somewhat like a permanent magnet, in that it 

doesn't require any external power for operation. However, good electret condenser 

microphones usually include a pre-amplifier which does still require power. 

Other than this difference, you can think of an electret condenser microphone as being the 

same as a normal condenser. 

 Condenser microphones have a flatter frequency response than dynamics. 

 A condenser microphone works in much the same way as an electrostatic tweeter 

(although obviously in reverse). 

 

3. MIC LEVEL & LINE LEVEL 

The electrical current generated by a microphone is very small. Referred to as mic level, this 

signal is typically measured in millivolts. Before it can be used for anything serious the 

signal needs to be amplified, usually to line level (typically 0.5 -2V). Being a stronger and 

more robust signal, line level is the standard signal strength used by audio processing 

equipment and common domestic equipment such as CD players, tape machines, VCRs, etc. 

This amplification is achieved in one or more of the following ways: 

 Some microphones have tiny built-in amplifiers which boost the signal to a high mic 

level or line level. 

 The microphone can be fed through a small boosting amplifier, often called a line amp. 

http://www.mediacollege.com/audio/phantom-power/
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 Sound mixers have small amplifiers in each channel. Attenuators can accommodate 

microphones of varying levels and adjust them all to an even line level. 

 The audio signal is fed to a power amplifier, a specialized amp which boosts the signal 

enough to be fed to loudspeakers. 

 

4. PHANTOM POWER 

Phantom power is a means of distributing a DC current through audio cables to provide 

power for microphones and other equipment. 

The supplied voltage is usually between 12 and 48 Volts, with 48V being the most common. 

Individual microphones draw as much current from this voltage as they need. 

A balanced audio signal connected to a 3 pin XLR has the audio signal traveling on the two 

wires – usually connected to pin 2 (+ve) and pin 3 (-ve). Pin 1 is connected to the shield, 

which is earthed. The audio signal is an AC (alternating current), whereas phantom power is 

DC (direct current). 

The DC phantom power is transmitted simultaneously on both pin 2 and 3, with the shield 

(pin 1) being the ground. Since the DC voltage on the ‘hot’ and ‘cold’ pins (2 & 3) is 

identical, it is seen by equipment as “common mode” noise and rejected, or ignored, by the 

equipment. 

If you put a volt meter on pins 1 & 2, or pins 1 & 3, you will see the 48v DC phantom power, 

but if you meter pins 2 & 3 (the audio carrying wires) you will see no voltage. 

 

http://www.mediacollege.com/audio/microphones/
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Schematic diagram of phantom power system 

The DC voltage can be harnessed however, and used to power microphones, mic-line amps, 

or indeed a video camera (in this case the DC voltage would travel up the video cable – and 

would need special equipment to filter this voltage). 

In summary, audio signals transmit as AC current, whereas powered equipment requires DC 

current to operate. Phantom power is a clever way of using one cable to transmit both 

currents. 

 

Generate Phantom Power 

Phantom power can be generated from sound equipment such as mixing consoles and 

preamplifiers. Special phantom power supplies are also available. 

 

Phantom Power effecton Audio 

Despite occasional reports of damage or unwanted audio disturbance, it is generally accepted 

that phantom power does not affect the quality of audio and is quite safe to use. However it is 

recommended that you do not supply phantom power to microphones which do not require it, 

especially ribbon microphones. 

 

 

 



Note: 

 Most earth-lift switches will disable phantom power. 

 High-impedance microphones, or microphones with unbalanced outputs, are not 

compatible with phantom power. 

 Some non-standard consumer components use a feature they call phantom power, but is 

not true phantom power. These devices may cause damage when connected to a true 

phantom-powered device. 

 

5. MICROPHONE POLAR PATTERNS 

A microphone's directionality or polar pattern indicates how sensitive it is to sounds arriving 

at different angles about its central axis. Some microphone designs combine several 

principles in creating the desired polar pattern.  

 

Directional Properties 

Every microphone has a property known as directionality. This describes the microphone's 

sensitivity to sound from various directions. Some microphones pick up sound equally from 

all directions; others pick up sound only from one direction or a particular combination of 

directions. The types of directionality are divided into three main categories: 

 

1. Omnidirectional 

 Picks up sound evenly from all directions (omni means "all" or "every"). 

2. Unidirectional 

 Picks up sound predominantly from one direction. This includes cardioid and hyper 

cardioid microphones. 

3. Bidirectional 

 Picks up sound from two opposite directions. 

To help understand the directional properties of a particular microphone, user manuals often 

include a graphical representation of the microphone's directionality. This graph is called 

a polar pattern.  

 



Omnidirectional 

 

Omnidirectional pattern 

An omnidirectional microphone response is generally considered to be a perfect sphere in 

three dimensions. As with directional microphones, the polar pattern for an "omnidirectional" 

microphone is a function of frequency. The body of the microphone is not infinitely small 

and, as a consequence, it tends to get in its own way with respect to sounds arriving from the 

rear, causing a slight flattening of the polar response. This flattening increases as the 

diameter of the microphone reaches the wavelength of the frequency. Therefore, the smallest 

diameter microphone gives the best omnidirectional characteristics at high frequencies. 

Captures sound equally from all directions. It is used for capturing ambient noise; Situations 

where sound is coming from many directions; Situations where the microphone position must 

remain fixed while the sound source is moving. 

Notes: 

 Although omnidirectional microphones are very useful in the right situation, picking up 

sound from every direction is not usually what you need. Omni sound is very general and 

unfocused - if you are trying to capture sound from a particular subject or area it is likely to 

be overwhelmed by other noise. 

 

 



Cardioid 

 

Cardioid pattern 

Cardioid means "heart-shaped", which is the type of pick-up pattern these microphone use. A 

cardioid pickup pattern is a highly flexible pickup pattern that is great for all-purpose 

use. Cardioid microphones come in all shapes and sizes. A cardioid microphone is slightly 

directional. Cardioid microphones will still pickup background noise if they are not in a 

controlled environment. Sound is picked up mostly from the front, but to a lesser extent the 

sides as well. It is used for emphasizing sound from the direction the microphone is pointed 

even as leaving some latitude for microphone movement and ambient noise. 

Notes: 

 The cardioid is a very versatile microphone, ideal for general use.  

 Handheld microphones are usually cardioid. 

 There are many variations of the cardioid pattern (such as the hypercardioid). 

 

 

 

 

 

 

 



Hypercardioid 

 

Hypercardioid pattern 

It is very directional and eliminates most sound from the sides and rear. Due to the long thin 

design of hypercardioids, they are often referred to as shotgun microphones. It is used 

for isolating the sound from a subject or direction when there is a lot of ambient noise. 

Notes: 

 By removing all the ambient noise, unidirectional sound can sometimes be a little 

unnatural.. 

 You need to be careful to keep the sound consistent. If the microphone doesnot stay 

pointed at the subject you will lose the audio. 

 Shotguns can have an area of increased sensitivity directly to the rear. 

 

 

 

 

 

 

 



Bidirectional 

 

Bidirectional pattern 

A bidirectional microphone is designed to pick-up audio equally from the front and back 

of the microphone. Typically, bidirectional microphones are used for radio interview 

recording.Uses a figure-of-eight pattern and picks up sound equally from two opposite 

directions. It is used as you can imagine, there aren't a lot of situations which require this 

polar pattern. One possibility would be an interview with two people facing each other (with 

the microphone between them). 

 

6.  MICROPHONE IMPEDANCE 

When dealing with microphones, one consideration which is often misunderstood or 

overlooked is the microphone's impedance rating factor. In order to ensure the best quality 

and most reliable audio, attention should be given in getting this factor right. 

Impedance 

Impedance is an electronics term which measures the amount of opposition a device has to an 

AC current. Technically speaking, it is the combined effect of capacitance, inductance, and 

resistance on a signal. The letter "Z" is often used as shorthand for the word impedance, for 

example, Hi-Z or Low-Z. 



Impedance is measured in ohms, shown with the Greek Omega symbol "Ω".A microphone 

with the specification 600Ω has an impedance of 600 ohms.  

Microphone Impedance 

All microphones have a specification referring to their impedance. This specification may be 

written on the microphone itself, or you may need to consult the manual.  

You will often find that microphones with a hard-wired cable and 1/4" plug are high 

impedance, and microphones with separate balanced audio cable and XLR connector are low 

impedance. 

There are three general classifications for microphone impedance. Different manufacturers 

use slightly different guidelines but the classifications are roughly: 

1. Low Impedance (less than 600Ω) 

2. Medium Impedance (600Ω - 10,000Ω) 

3. High Impedance (greater than 10,000Ω) 

 

Impedance to Choose 

High impedance microphones are usually quite cheap. Their main disadvantage is that they 

do not perform well over long distance cables - after about 5 or 10 meters they begin 

producing poor quality audio. In any case these microphones are not a good choice for 

serious work. In fact, although not completely reliable, one of the clues to a microphone's 

overall quality is the impedance rating. 

Low impedance microphones are usually the preferred choice. 

Matching Impedance with Other Equipment 

Microphones are not the only things with impedance. Other equipment, such as the input of 

a sound mixer, also has an ohms rating. Again, you may need to consult the appropriate 

manual or website to find these values. Be aware that what one system calls "low impedance" 

may not be the same as your low impedance microphone - you really need to see the ohms 

value to know exactly what you're dealing with. 

A low impedance microphone should generally be connected to an input with the same or 

higher impedance. If a microphone is connected to an input with lower impedance, there will 

http://www.mediacollege.com/audio/mixer/


be a loss of signal strength. In some cases you can use a line matching transformer, which 

will convert a signal to different impedance for matching to other components. 

7. MICROPHONE FREQUENCY RESPONSE 

Frequency response refers to the way a microphone responds to different frequencies. It is a 

characteristic of all microphones that some frequencies are exaggerated and others are 

attenuated (reduced). For example, a frequency response which favors high frequencies 

means that the resulting audio output will sound more trebly than the original sound. 

 

Frequency Response Charts 

A microphone's frequency response pattern is shown using a chart like the one below and 

referred to as a frequency response curve. The x axis shows frequency in Hertz, the y axis 

shows response in decibels. A higher value means that frequency will be exaggerated, a 

lower value means the frequency is attenuated. In this example, frequencies around 5 - kHz 

are boosted while frequencies above 10kHz and below 100Hz are attenuated. This is a typical 

response curve for a vocal microphone. 

 

 

Frequency -Cycles per Second 

 

 

 

 



 Response Curve 

An ideal "flat" frequency response means that the microphone is equally sensitive to all 

frequencies. In this case, no frequencies would be exaggerated or reduced (the chart above 

would show a flat line), resulting in a more accurate representation of the original sound. We 

therefore say that a flat frequency response produces the purest audio. 

In the real world a perfectly flat response is not possible and even the best "flat response" 

microphones have some deviation. 

More importantly, it should be noted that a flat frequency response is not always the most 

desirable option. In many cases a tailored frequency response is more useful. For example, a 

response pattern designed to emphasize the frequencies in a human voice would be well 

suited to picking up speech in an environment with lots of low-frequency background noise. 

The main thing is to avoid response patterns which emphasize the wrong frequencies. For 

example, a vocal microphone is a poor choice for picking up the low frequencies of a bass 

drum. 

Frequency Response Ranges 

You will often see frequency response quoted as a range between two figures. This is a 

simple way to see which frequencies a microphone is capable of capturing effectively. For 

example, a microphone which is said to have a frequency response of 20 Hz to 20 kHz can 

reproduce all frequencies within this range. Frequencies outside this range will be reproduced 

to a much lesser extent or not at all. 

This specification makes no mention of the response curve, or how successfully the various 

frequencies will be reproduced. Like many specifications, it should be taken as a guide only. 

Condenser vs. Dynamic 

Condenser microphones generally have flatter frequency responses than dynamic. All other 

things being equal, this would usually mean that a condenser is more desirable if accurate 

sound is a prime consideration. 

 



8. TYPICAL PLACEMENT 

 

8.1 Single microphone 

Use of a single microphone is pretty straightforward. Having chosen one with appropriate 

sensitivity and pattern, (and the best distortion, frequency response, and noise 

characteristics), you simply mount it where the sounds are. The practical range of distance 

between the instrument and the microphone is determined by the point where the sound 

overloads the microphone or console at the near end, and the point where ambient noise 

becomes objectionable at the far end. Between those extremes it is largely a matter of taste 

and experimentation. 

If you place the microphone close to the instrument, and listen to the results, you will find the 

location of the microphone affects the way the instrument sounds on the recording. The 

timbre may be odd, or some notes may be louder than others. That is because the various 

components of an instrument's sound often come from different parts of the instrument body, 

and we are used to hearing an evenly blended tone. A close in microphone will respond to 

some locations on the instrument more than others because the difference in distance from 

each to the microphone is proportionally large. A good rule of thumb is that the blend zone 

starts at a distance of about twice the length of the instrument. If you are recording several 

instruments, the distance between the players must be treated the same way. 

 If you place the microphone far away from the instrument, it will sound as if it is far away 

from the instrument. We judge sonic distance by the ratio of the strength of the direct sound 

from the instrument  to the strength of the reverberation from the walls of the room. When 

we are physically present at a concert, we use many cues beside the sounds to keep our 

attention focused on the performance, and we are able to ignore any distractions there may 

be. When we listen to a recording, we don't have those visual clues to what is happening, and 

find anything extraneous that is very audible annoying. Some engineers prefer to use close 

miking techniques to keep noise down and add artificial reverberation to the recording, others 

solve the problem by mounting the microphone very high, away from audience noise but 

where adequate reverberation can be found. 



8.2 Stereo 

Stereo sound is an illusion of spaciousness produced by playing a recording back through 

two speakers. The success of this illusion is referred to as the image. A good image is one in 

which each instrument is a natural size, has a distinct location within the sound space, and 

does not move around. The main factors that establish the image are the relative strength of 

an instrument's sound in each speaker, and the timing of arrival of the sounds at the listener's 

ear. In a studio recording, the stereo image is produced artificially. Each instrument has its 

own microphone, and the various signals are balanced in the console as the producer desires. 

In a concert recording, where the point is to document reality, and where individual 

microphones would be awkward at best, it is most common to use two microphone, one for 

each speaker. 

 

Microphone placement for stereo recording 

8.3 Spaced microphones 

The simplest approach is to assume that the speakers will be eight to ten feet apart, and place 

two microphones eight to ten feet apart to match. Either omnis or cardioids will work. When 

played back, the results will be satisfactory with most speaker arrangements. The big 

disadvantage of this technique is that the microphones must be rather far back from the 

ensemble-at least as far as the distance from the leftmost performer to the rightmost. 

Otherwise, those instruments closest to the microphones will be too prominent. There is 



usually not enough room between stage and audience to achieve this with a large ensemble, 

unless you can suspend the microphones or have two very tall stands. 

 

8.4. Coincident cardioids 

There is another disadvantage to the spaced technique that appears if the two channels are 

ever mixed together into a monophonic signal or broadcast over the radio. Because there is a 

large distance between the microphones, it is quite possible that sound from a particular 

instrument would reach each microphone at slightly different times (sound takes 1 

millisecond to travel a foot). This effect creates phase differences between the two channels, 

which results in severe frequency response problems when the signals are combined. You 

seldom actually lose notes from this interference, but the result is an uneven, almost 

shimmery sound. The various coincident techniques avoid this problem by mounting both 

microphones in almost the same spot. 

This is most often done with two cardioid microphones, one pointing slightly left, one 

slightly right. The microphones are often pointing toward each other, as this places the 

diaphragms within a couple of inches of each other, totally eliminating phase problems. No 

matter how they are mounted, the microphone that points to the left provides the left channel. 

The angle between the microphones is critical, depending on the actual pickup pattern of the 

microphone. If the microphones are too parallel, there will be little stereo effect. If the angle 

is too wide, instruments in the middle of the stage will sound weak, producing a hole in the 

middle of the image.  

You may place the microphones fairly close to the instruments when you use this technique. 

The problem of balance between near and far instruments is solved by aiming the 

microphones toward the back row of the ensemble; the front instruments are therefore off 

axis and record at a lower level. You will notice that the height of the microphones becomes 

a critical adjustment. 

8.5 M.S. or Middle side technique 

The most elegant approach to coincident miking is the M.S. or middle-side technique. This is 

usually done with a stereo microphone in which one element is omnidirectional, and the 

other bidirectional. The bidirectional element is oriented with the axis running parallel to the 



stage, rejecting sound from the center. The omni element, of course, picks up everything. To 

understand the next part, consider what happens as instrument is moved on the stage. If the 

instrument is on the left half of the stage, a sound would first move the diaphragm of the 

bidirectional microphone to the right, causing a positive voltage at the output. If the 

instrument is moved to center stage, the microphone will not produce any signal at all. If the 

instrument is moved to the right side, the sound would first move the diaphragm to the left, 

producing a negative voltage. The instruments on one side of the stage are 180 degrees out of 

phase with those on the other side, and the closer they are to the center, the weaker the signal 

produced. 

Now the signals from the two microphones are not merely kept in two channels and played 

back over individual speakers. The signals are combined in a circuit that has two outputs; for 

the left channel output, the bidirectional output is added to the omni signal. For the right 

channel output, the bidirectional output is subtracted from the omni signal. This gives stereo, 

because an instrument on the right produces a negative signal in the bidirectional 

microphone, which when added to the omni signal, tends to remove that instrument, but 

when subtracted, increases the strength of the instrument. An instrument on the left suffers 

the opposite fate, but instruments in the center are not affected, because their sound does not 

turn up in the bidirectional signal at all. 

 M.S. produces a very smooth and accurate image, and is entirely mono compatible. The only 

reason it is not used more extensively is the cost of the special microphone and decoding 

circuit. 

8.6 Large ensembles 

The above techniques work well for concert recordings in good halls with small ensembles. 

When recording large groups in difficult places, you will often see a combination of spaced 

and coincident pairs. This does produce a kind of chorusing when the signals are mixed, but 

it is an attractive effect and not very different from the sound of string or choral ensembles 

any way. When balance between large sections and soloists cannot be achieved with the 

basic setup, extra microphones are added to highlight the weaker instruments. A very 

common problem with large halls is that the reverberation from the back seems late when 



compared to the direct sound taken at the edge of the stage. This can be helped by placing a 

microphone at the rear of the audience area to get the ambient sound into the recording.  

 

8.7 Studio techniques 

These are just a few things you might see if you dropped in on the middle of a session. 

 

Individual microphones on each instrument 

This provides the engineer with the ability to adjust the balance of the instruments at the 

console, or, with a multi-track recorder. There may be eight or nine microphones on the drum 

set alone. 

 

Close microphone placement 

The microphones will usually be placed rather close to the instruments. This is partially to 

avoid problems that occur when an instrument is picked up in two non-coincident 

microphones, and partially to modify the sound of the instruments. 

 

Acoustic fences around instruments, or instruments in separate rooms 

The interference that occurs when an instrument is picked up by two microphones that are 

mixed is a very serious problem. You will often see extreme measures, such as a bass drum 

stuffed with blankets to muffle the sound, and then electronically processed to make it sound 

like a drum again. 

 

Everyone wearing headphones 

Studio musicians often play to "click tracks", which are not recorded metronomes, but 

someone tapping the beat with sticks and occasionally counting through tempo changes. This 

is done when the music must be synchronized to a film or video, but is often required when 

the performer cannot hear the other musicians because of the isolation measures described 

above. 

 

20 or 30 takes on one song. 

Recordings require a level of perfection in intonation and rhythm that is much higher than 

that acceptable in concert. The finished product is usually a composite of several takes. 

 



Pop filters in front of microphones 

Some microphones are very sensitive to minor gusts of wind-so sensitive in fact that they 

will produce a loud pop if you breathe on them. To protect these microphones engineers will 

often mount a nylon screen between the microphone and the artist. This is not the most 

common reason for using pop filters but vocalists like to move around when they sing; in 

particular, they will lean into microphones. If the singer is very close to the microphone, any 

motion will produce drastic changes in level and sound quality. Many engineers use pop 

filters to keep the artist at the proper distance. The performer may move slightly in relation to 

the screen, but that is a small proportion of the distance to the microphone. 

 

9. LOOKING AFTER YOUR MICROPHONES 

 Obey the normal common-sense rules of electronic equipment care, e.g. avoid 

very high temperatures, dust, dampness, high humidity, physical shocks, etc. 

 Many performers think it's cool to swing the microphone by its lead and generally 

throw it around the place. Unless you own the microphone and you can afford to 

replace it regularly, don't do this. 

 Don't blow into the microphone. The diaphragm is designed to respond to sound 

waves, not wind. 

 Don't tap the head of the microphone. This can damage the microphone and/or 

speakers. 

 If applicable, turn microphone off when not in use. Remove and replace batteries 

regularly. The action of removing and inserting batteries can help keep the 

contacts clean. 

 Don't subject microphones to volume levels greater than their design capabilities. 

 Always be careful with phantom power. Although it will not generally harm your 

microphone, it's prudent to play it safe. 

 Keep all leads safely secured. If someone trips over a lead there may be all sorts 

of problems from damaged microphones to lawsuits. 



 If the performance of a microphone deteriorates over time, it may be possible to 

have the diaphragm cleaned. You will need to talk to the supplier or manufacturer 

for details. 

 

  



Self Assessment Questions 

 

1. Define different microphone types? 

2. Explain different studio techniques for using a microphone? 

3. How to use a microphone by middle-side technique? 

4. Describe the maintenance of a microphone? 

5. Explain the placement of single microphone?  

6. Define cardiod and hypercardiod pattern? 

 

 

  



Suggested Readings/Reference 

 

 http://www.shure.eu/support_download/videos/how-to/microphone-basics 

 

 http://www.mediacollege.com/audio/microphones/how-microphones-work.html 

 

 http://artsites.ucsc.edu/ems/music/tech_background/te-20/teces_20.html 

 

 https://soundtech.wordpress.com/education/the-fundamentals-of-audio/microphone-

basics/ 

 http://en.wikipedia.org/wiki/Microphone 

 

 

 https://www.youtube.com/watch?v=27dLLnisH2M 

 

 https://www.youtube.com/watch?v=jGj27JkDcpc 

 

 https://www.youtube.com/watch?v=PQWeQHy6HV0&list=PLnLOmVwRMCqQmQ

aiT58c94oKm8A7w5ZT0&index=6 

 

 https://www.youtube.com/watch?v=1Uf79xgcKdI 
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https://soundtech.wordpress.com/education/the-fundamentals-of-audio/microphone-basics/
https://soundtech.wordpress.com/education/the-fundamentals-of-audio/microphone-basics/
http://en.wikipedia.org/wiki/Microphone
https://www.youtube.com/watch?v=27dLLnisH2M
https://www.youtube.com/watch?v=jGj27JkDcpc
https://www.youtube.com/watch?v=PQWeQHy6HV0&list=PLnLOmVwRMCqQmQaiT58c94oKm8A7w5ZT0&index=6
https://www.youtube.com/watch?v=PQWeQHy6HV0&list=PLnLOmVwRMCqQmQaiT58c94oKm8A7w5ZT0&index=6
https://www.youtube.com/watch?v=1Uf79xgcKdI
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INTRODUCTION 

 

There is a range of ways to record audio – from the smart phone in your pocket (perhaps) to 

digital recorders, microphones and laptops, to fully kit out recording studios. Basically, the 

equipment you use should be appropriate to what you want the audio for – and appropriate to how 

you’re going to be doing the recording (e.g. using a smart phone may be the easiest way of 

recording whilst ‘on the move’). 
 

However, there are also a range of challenges in recording audio, which may mean you don’t get 

the result you want. Remember: If you have a bad audio recording to begin with, you won’t be able 

to ‘make it good’ in the edit. You should consider from the beginning what kind of equipment 

you’ll need, and anticipate some of the audio recording challenges you’ll be likely to face. 
 

To start with the quality audio recording/editing you required a professional studio with the 

sound lock environment to achieve the quality productions. 
     

Control room has a vital role for any kind of audio broadcasting. All broadcasting and recording 

studios are attached with the control room to ensure the studios activity and control and monitoring 

the broadcasted signals. 
      

Most of the portable studios designed professionally for the different locations only for the 

recording/editing the audio productions. 
     

Outdoor audio recording is a salient feature of audio productions. Live on location recording 

purposely cover the live events or to record the impressions/interviews at the location. 
 

Professional peoples behind any audio project are the important and like the backbone of any audio 

productions. 
     

Recording process is an essential segment of any audio production. Engineers/Producers make 

necessary arrangements before recordings to ensure the broadcasted quality.  

 

Another audio production segment is the audio dubbing/editing, sequence editing, mix down the 

project and finally mastering. It is much important to finish any audio recording project before it 

goes on air.  



OBJECTIVES 

 
 

After reading this unit the student will be able to:  

 

 

1. Learning after the recording environment in a digital environment in detail will provide the 

students a practical professional knowledge for their professional carrier. 

2. This course leads the maximum practical skills for those professional students who made 

their future in the field of audio broadcasting. 

3. This is digital era and the audio productions completely deal with the digital technology as 

the audio productions are the computer aided productions. 

4. After the completion of this task the students will be able to handle any type of digital audio 

recordings for their best performance in the field of audio productions. 

 

 

 

 

 

 

 

 

 

 

 

 
 



1 RECORDING STUDIO 

 

How to Make a Cheap Recording Studio 
 

As computer technology has developed, more and more performance is possible on a lower and 

lower budget. As a result, building a simple home recording studio around your existing computer 

can be quite inexpensive. Learning how to make a cheap recording studio at home requires an 

assessment of exactly what you'll be using the studio for and what quality of sound you need. The 

guide below outlines what to look for in each piece of equipment. 

 
 

Steps 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Step 1 
 

Purchase a computer. If you don't already have a computer to use in your recording setup, you will 

need to purchase one. Important considerations are processing speed and amount of memory, as 

recording software tends to use your computer's resources heavily. Both Windows and Mac 



platforms will work well; however, Windows machines typically allow for easier upgrading of the 

sound card. Factory installed sound cards are not usually robust enough to produce high-quality 

recordings, so upgrading is a good idea 

 

Step 2 

Choose a piece of recording software.  The recording software provides the interface through which 

you will manage your recordings on your computer. There are several options for small budgets. 

Generally, the more expensive applications offer greater functionality and flexibility. 

For recording on a very small budget, you can use recording software licensed as freeware or 

shareware. Audacity and Garage Band are 2 popular choices for low budget recording. 

With a slightly higher budget, you can purchase near professional quality recording software such 

as Ableton Live or Cakewalk Sonar. Both of these applications are also available in entry level 

versions that are less expensive but less powerful. 



Step 3 

Purchase and install an audio interface. An audio interface. An audio interface is a piece of 

hardware that replaces your computer's sound card and allows you to connect your instruments 

and microphones to your computer through a mixer. On a PC, you will usually install your audio 

interface in an empty PCI slot. On a Mac, you may need to purchase an interface that can be 

connected through a USB or FireWire cable. 

At the least, make sure your audio interface has 2 input and 2 output jacks.  This will allow you to 

record in stereo. For more flexibility, choose an interface with 4 input jacks. 

One of the top manufacturers of audio interfaces for home use is M-Audio. They produce both 

entry level and high end models. 
 

Step 4 

Buy an audio mixer. A mixer is an essential piece of equipment for any home recording studio. 

The mixer handles all your inputs (such as microphones, guitars, and keyboards), allows you to 

adjust each input's settings, and routes the output to your audio interface and into your computer. 

The basic functions on an inexpensive mixer will usually be adequate for home recording needs. 

At the least, make sure each channel on your mixer includes adjustments for panning, volume, and 

3-band equalization. Four channels will be more than adequate for home recording. 
 
 
Popular brands for entry-level mixers are Behringer, Alesis, and Yamaha. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Step 5 
Chose studio monitors and headphones for your studio. The speakers you use to listen to your mix 

during editing are called studio monitors (sometimes referred to as reference speakers). Studio 

monitors differ from other speakers in that they are meant to deliver a perfectly flat frequency 

response. This means that you are hearing your recording exactly as it exists digitally, without any 

frequency adjustment. 

When choosing studio monitors, make sure to look for "near-field" models. These are de-signed to 

be listened to from about a yard (1 m) away, and so eliminate any effects due to the acoustics of 

your room. 

Studio monitors can be purchased used from online classifieds sites or audio retailers. The robust, 

simple construction of loudspeakers makes them an ideal component to buy used and save money. 

In addition to or in place of monitors, you can buy a set of headphones. Headphones pro-vide the 

advantage of being cheaper, smaller, and less likely to disturb a neighbor or housemate. 

Headphones can be used in conjunction with studio monitors to assess very low-volume 

components of your recordings. 

 

Step 6 

Decide on a microphone(s) to use in your studio. An inexpensive home recording studio can be 

managed with only a single microphone if necessary. 
 

If you only buy 1 mic, make sure to choose a dynamic mic. This type of construction is more 

robust and versatile, and is self-powered. An industry standard dynamic mic is the Shure SM-

57, which can be used for vocals and instruments. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



If you need to record very quiet or expressive instruments, such as an acoustic guitar orpiano, a 

condenser mic will provide better results. Condenser mics aren't as rugged or versatile as dynamic 

mics, but provide more sensitive response. A cheap recording studio can readily make do with 1 

dynamic and 1 condenser microphone. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Answered Questions 
 
 
 

Is a mixer necessary? 
 
If you are working with more than one instrument, it is necessary since you want to be able to 

change the tone of each instrument so it does not out-sound another. If you are planning to use one 

instrument, such as a guitar, you might need a guitar mixer, which take cares of all the sounds and 

tones of a guitar. There are different mixers for different instruments, including voice. So, if you 

are using more than one, then definitely consider buying one. If you are using only one 

instrument, you could still get one but it's not necessary. 

 
Will a headset with a mic work? 
 
Yes, but headsets with mics generally don't have very good quality. You'll get better sound if you 

use a real microphone and separate headphones. 

 

 



How can I make a soundproof device? 
 
You can use a sound cancellation material, like star foam or the package your eggs come in. 

I am new in this field. What instruments do I need? 
 
The most essential instrument has got to be the Midi keyboard. If you have any money to spare, 

you can also get a drum kit. 

 
Tips 
 
Building your recording studio inexpensively often means building from what you already own. 

Using existing components such as microphones and computers, even when they are not ideally 

suited to the task at hand, will keep your budget low.  

• Additional equipment may be needed depending on your recording needs. If you are interested 

in using the "soft-synth" instruments including with your recording software, for instance, you 

will need a MIDI interface and keyboard.  

• If you do not have any recording equipment, you can get the following to set up a reasonably 

cheap yet efficient set up:  

• Apple Mac Mini  

• 2.3GHz Quad-Core Intel Core i7 (Turbo Boost up to 3.3GHz) with 6MB L3 cache  

• 1TB (5400-rpm) hard drive2  

• Intel HD Graphics 4000  

• 4GB (two 2GB) of 1600MHz DDR3 memory  

• M Audio Studiophile AV 30  

• Focusrite Scarlett 2i2 USB 2.0 Audio Interface  

• Samson C01 Large Diaphragm Condenser  

• Samson RH300/Samson SR850/ Audio Technica ATH M30 or JVC Harx 700 Reference 

Headphones  

 

Things You'll Need 
 
• Computer  

• Recording software  

• Audio interface  

• Audio mixer  

• Studio monitors  

• Headphones  

• Microphones  

• MIDI keyboards  



2 CONTROL ROOM 

 

Radio studio and control room 
 

Area with two rooms separated by a glass window where audio programs are produced, recorded 

or broadcast.



Control room 
 

Room adjacent to the studio that is equipped with sound control and recording equipment; the 

director monitors the on-air program from here. 

 
 

Bargraph type peak meter 
 

Instrument measuring peak sound intensity in a predetermined time period. 

 
 

Audio console 
 

Console made up of all the devices used to control, adjust and mix sound. 

 
 

Jack field 
 

Series of connector sockets (jacks) allowing various pieces of equipment to be linked to the audio 

console. 

 
 

Producer turret 
 

Control unit with a microphone that is used by the program’s producer to communicate with the 

announcer. 

 

 

Stop watch 
 

Instrument that precisely measures time in minutes, seconds and fractions of seconds. 

 
 
 

Cassette deck 
 

Device used to play back and record sounds on a recording tape cassette.  





 
Playing window 
 

Opening allowing the recording tape to advance in front of the playback head of the cassette tape 

deck.  
Housing tape-guide 
 

Part that holds and guides the recording tape in front of the playing window. 

 

Guide roller 
 

Spool that guides the recording tape. 

 

Recording tape 
 

Flexible tape whose surface is covered with a magnetic substance; it is used as a recording 

medium. 

  
Take-up reel 
 

Cylindrical part on which the recording tape winds. 
 
 
 

Compact disc player 
 

Device using a laser beam to play back sounds recorded on a compact disc (CD).  





 
Remote control sensor 

Device that receives infrared signals emitted by a remote control so that certain functions can be 

operated from a distance. 

 

Fast operation buttons 

Buttons that accelerate forward or backward sound reproduction. 

 

Track search buttons 

Buttons used to move to the next or previous track. 

 

Stop/clear button 

Button that interrupts playback of a disc or erases programs held in memory. 

 

Play/pause button 

Button that temporarily starts or stops playback of a disc. 

 

Disc compartment control 

Button that opens and closes the disc tray. 

 

Power button 

Mechanical connection that turns the player on or off. 

 

Disc compartment 

Compartment that contains the tray into which discs are inserted for playback. 

 

Track number 

Liquid crystal display that shows the number of the track being played. 

 

Indicators 

Indicator lights showing the operations carried out or the functions selected. 

 

Memory button 

Button for programming playback of a number of tracks in a given order. 



Repeat buttons 

Buttons allowing repeated playback of one or several tracks. 

 

Digital audio tape recorder 

Device using a small magnetic tape cartridge to digitally record a program for later broad-cast. 
 
 

Cartridge tape recorder 

Device for analog recording of a program for later broadcast using a magnetic tape cart-ridge. 
 

 

Tone leader generator 

Device producing the tracking or technical tuning signals that is inserted at the beginning of  

a recording. 
 

Clock 
 
Clock used to time a program. 
 
 

Volume unit meters 

Instruments measuring the relative intensity of the various sounds being broadcast or re-

corded. 
 
 

Audio monitor 

Device that reproduces the audio portion of an on-air program to monitor its sound 

quality. 

 

Loudspeakers 

Case enclosing one or several speakers, which convert electric pulses into sound waves by 

means of an amplifier. 

 

 
 
 
 
 
 
 
 
 

 

 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Left channel 
 
Speaker cover 

Thin grille made of fabric or metal that covers and protects the speakers. 

 
 
Right channel 
 
Diaphragm 

Cone-shaped flexible part that vibrates to create sound waves in the air. 
 
 

Woofer 

Loudspeaker designed to reproduce the low frequencies of the sound signal. 
 
 

Midrange 

Loudspeaker designed to reproduce the middle frequencies of the sound signal. 
 
 

Tweeter 

Loudspeaker designed to reproduce the high frequencies of the sound signal. 

 

 

On-air warning light 

Light indicating that a program is being broadcast. 



Announcer turret 
 

Control unit used by a program host or announcer mainly to turn a microphone on or off. 
 
 
Microphone 
 

Device that converts electric pulses into broadcast or recorded sounds.  

Dynamic microphone. 



 
 
 
 
Cable Housing Connector 

Device used to connect the cable to the microphone.  
 

On-off switch 

Power-connecting device used to turn the microphone on or off. 
 
 

Windscreen 

Screen covering and protecting a microphone; it muffles the speaker’s breathing and the sound of 

the wind. 
 
 
Studio 

Soundproof area designed for sound recording; radio programs are produced here. 
 
 
 

3 PROJECT STUDIO 

 

Dear students for the details of Project Studio we found a very effective video clip which 

elaborated well the concept of this studio. Please watch this video at the link given below. 

 

https://youtu.be/2q9H2pfFcuo 

 

4 PORTABLE STUDIO 

 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

                                                 A simple portable recording studio. 



Peter Valentino/Stock Xchng 
 

The most important piece of equipment in any portable studio is the digital audio work-station 

(DAW), also known as a computer. Depending on the software on the computer, a DAW could act 

as a recording device, mixer and sequencer. By handling so many tasks, a good DAW reduces the 

need for additional equipment. 

 

Handling audio files requires a lot of computer horsepower, particularly if you're mixing lots of 

channels. For that reason, it's important to choose a computer with a fast micro-processor. For a 

while, it seemed like Mac computers would always reign supreme in the world of media computing. 

But some audio engineers say that the differences between Mac and PC performance are negligible. 

As long as the computer you pick has a powerful CPU and a large, fast hard drive, you're in good 

shape. 

 

Another piece of the portable studio setup is the audio interface. While many computers have input 

and output ports and sound cards, they aren't always capable of recording or playing back 

professional-quality sound. For that reason, many engineers who set up portable studios rely on 

additional audio interface devices. These devices range in size from a handheld gadget to a machine 

the size of a hefty VCR. 
 
 

Audio interface devices usually have multiple input and output ports. Many have both analog and 

digital ports, which covers all musical instruments and microphones. Some also act as analog-to-

digital converters (ADCs). That means the device can accept an analog signal and then digitize it. 

It converts sound into information that a computer can manipulate. 
 

 

Analog signals are continuous waves that vary in frequency and amplitude. An analog audio 

signal's frequency corresponds to the sound's pitch. The wave's amplitude represents the sound's 

volume. Digital signals aren't continuous. Instead, a digital signal is a series of snapshots called 

samples. The number of times a computer takes a snapshot of an analog signal per second is the 

sampling rate. Higher sampling rates translate into smoother, more natural sound. 



An analog sound wave is continuous. 
 

Not all audio interfaces are also ADCs. Some audio engineers might prefer to use a dedicated 

ADC, then run the signal coming from the ADC through the audio interface and into the DAW. 

Either way, the audio interface carries the signal to the DAW. Audio engineers use the DAW to 

manipulate individual channels and mix the sound into a final track. 
 
 

The DAW might be the most important hardware component in a portable studio, but it's useless 

without the right software. Keep reading to learn about the applications audio engineers use to 

produce music. 
 

 

Channels and Mixing 
 

You've probably heard terms like 4-channel or 16-channel devices. What does that mean? In 

general, it means the equipment can accept a certain number of individual input devices when 

recording. A 4-channel device can accept four inputs, for example. In re-cording, each channel 

remains separate from the other channels. That's where a mixer comes in. Audio engineers use 

mixers to tweak each channel before combining all inputs into a single recording. 
 

 

The Rest of the Gear 
 

Audio experts like eSessions.com CEO Gina Fant-Saez suggest audio engineers purchase an 

external hard drive to augment their DAWs. That's because computer hard drives tend to record 

more slowly than external hard drives. To record audio reliably, you need a hard drive that can 

spin at faster speeds [source: O'Reilly Digital Media]. Other hardware an audio engineer needs to 

complete a portable studio includes: 

 
 
Headphones 
 
Microphones 

Speakers 

Cables 



5 LIVE ON LOCATION RECORDING 

 

The 5 Best Methods for Recording on Location 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

While musicians have access to state-of-the-art recording studios, many travel to record their 

tunes on location. Challenging perhaps, for producers to get the sound quality they need, the 

practice of recording on location is a rewarding way to make music. 

 

Moreover, there are many possibilities for recording music with top-notch production and great 

sounds that rival the studio setting. The following five methods are among the best ways to record 

in a non-studio setting. 



1. Choose Location with Care 
 

Many artists choose to record at a particular location due to its optimal acoustics. 
 

Some rooms are known for their great drum sound while some locations may enhance vocals. If 

you’re recording indoors, it’s essential to prevent leakage from heating or coo-ling elements from 

getting through to your microphones and muddying the clarity of your recordings. 
 
 

While a lot of tweaking can be accomplished by editing with modern recording programs, it’s 

somehow always better when you get that organically pure sound. Depending on whether you’re 

recording a single musician or an orchestra, consider your location with care; discover its pros and 

cons before you fly the band in so you’re ready to tackle any issues before they can detract from 

your recording process. 
 

 

2. Field Recording 
 

If you are in a situation where the natural sounds of your setting won’t interfere and may even 

complement your live recording, you can opt for field recording. 
 
Ocean waves might have more ambiance than the local airport, but there are many natural settings 

that can enhance the acoustics of a performance. Of course, if you are recording a band, it is still 

best to lay down vocal tracks separately. The various nuances of a vocal performance can easily be 

lost in a live recording situation even with the best of microphones. 

Of course, there’s no harm in trying, but whenever possible, it’s usually recommended to record 

vocals in isolation from other instruments to avoid muddied lyrics and so forth. Zoom Handheld 

Recorders are now popularly used for many types of field recordings. 
 
 
3. Microphones—Best You Can Buy 
 

There’s always a lot of hype about various recording programs—the latest and greatest 

upgrades Pro Tools has to offer! 
 

However, no matter what program you choose, you can avoid a lot of editing headaches simply 

by recording with the best microphones for your recording situation. Stereo microphones and a 

minimum of leakage can allow you to capture a great recording outside of the studio. 
 
 



It’ll take some time to set up the microphones to capture each instrument as perfectly as possible, 

but tweaking your microphone setup is one key method of getting the most out of a recorded 

performance. 
 

 

4. Mobile Studio 
 

At one time, you had to be as successful as the Rolling Stones to afford a portable studio. 
 

Today, there are many recorders you can easily move from place to place and remain well in 

budget. Today’s technology will allow you to record with a laptop given the right soft-ware. 

Whether you are going with a minimum of gear or a bus-full of recording equipment, you can now 

bring the studio to just about any setting you want to record at. 
 
 
5. Self-Recording Keyboards 
 

Keyboards like the Korg MS-1 that specialize in sampling can also record music. You won’t 

capture a lengthy performance the way you would with a laptop, but using an instrument typically 

keyboards—that can record themselves along with other sounds is another interesting method to 

use when on location. Its built-in microphone is also handy and its editing capabilities and 

software make this particular keyboard ideal for recording situations. 
 
Recording on Location 

Recording outside of the studio setting is more popular than ever. Given the right equipment for 

your plans, you can capture a performance anywhere. 
 

You can also take your tracks back to a studio to tweak them or dump them into your editing 

program to make the changes you need. Research your gear and try to hire the best recording 

engineer for the job and no one is ever likely to know you recorded anywhere but in a professional 

recording studio. 
 
 

6 PEOPLE BEHIND THE PRODUCT 

 

• Engineers  
 
• Producers  
 
• Technicians  
 
• Composers  
 
• Editors  



 

7 RECORDING PROCESS 

 

PHASES OF THE RECORDING PROCESS 
 
 
Following are the typical phases of the recording process: 
 
PRE-PRODUCTION 
 

During this stage, all the initial decisions are made regarding the recording. What is the purpose of 

the recording (i.e., demo for shopping or submission, indie release, song for download sales, just for 

fun, etc.)? What style of music will you be recording? Who will be playing what instruments, or 

what sounds will you use for the recording? Where will you record, mix and master the recording? 

Where is the budget coming from, and/or how will you raise the money for the project? How many 

songs will you be recording, and who will be involved in the writing? Will you need to hire 

musicians to play on the recording or will you and/or your band perform everything? When do you 

need to complete the recording by? 
 

 

SOUND SOURCE SELECTION 
 

This does not have to be a ‘formal’ process, but is nonetheless an important part of the project 

recording process. Everything that happens down the line in terms of the quality of the recording 

will be influenced by the sound source selection. Sound sources include the brand and model of 

instruments, the quality of the samples, and the caliber of the soft synths and virtual instruments. Of 

course, the vocals are an important sound source, so the quality of the vocalist counts as well. Use 

sound sources of low quality, and you will be paying the price the rest of the way. Great sounding 

sound sources (performed and recorded well, of course) will make it much easier to mix the songs 

later on. 

 

SELECTION OF PERFORMERS 
 

Naturally, if you are either in a band or performing as a solo artist, you will most likely pick 

yourself or your band members to play all the instruments and handle all the performances. The 

selection of the performers is the next most important thing after the sound source selection. Great 

sounding (high-quality and well maintained) instruments played with passion by great performers 

can overcome even a bad recording. Therefore, put your ego aside and get the best performers to 

perform on the recording. If you consider yourself the best performer by virtue of the fact that it is 

your music and you a unique passion for the performance and understand the songs the best, then 

that can also be a valid argument for performing the songs yourself. 



 

 

WRITING 

Once the pre-production is complete, the writing process can proceed efficiently. Time isn’t 

wasted trying to figure out all the things that have already been covered in the pre-production 

stage, and instead everyone can focus on writing the best songs they can possibly come up with 

for the recording. 
 

 

REHEARSAL 
 

Not all bands have the time or patience to rehearse prior to their recording. Nevertheless, it is a 

crucial part of the process because this is where you can discover different ways to perform the 

song; including what the right key is, how the tempo feels, etc. Often, this part is combined with the 

writing process. Some performers use the recording process to rehearse, which is a waste of time 

and money. 
 

 

RECORDING 
 
This is the stage where the actual recording happens. Important decisions will be made regarding 

the best ways to capture the sounds. This is where an experienced and/or knowledgeable engineer 

plays a crucial role. Unless you already have the sounds in your computer, or on tape (e.g., from 

samples, soft synths, and/or virtual instruments), there are only three ways to record a sound; either 

by microphone, or via direct injection (DI), or a combination of the two. The quality of your 

microphones and DI boxes are extremely important to the final results, along with the mic-pres, 

additional processors (e.g., compressor, deesser, EQ, etc.), and A/D converter. Of additional 

importance is ‘sound’ of the room in which you are recording, the maintenance of the equipment 

being recorded, along with mic placement, the quality and length of mic cables, the techniques used 

by the recording engineer, among other things. Along with great sound sources and great 

performers (and performances), getting the recording right will carry you into a great sounding mix 

and master. 

 
EDITING 
 
Once everything is recorded, additional editing can be done in order to get the recording to sound 

perfect (if perfection is what you are after) and get the tracks ready for mixing. Some musicians 

prefer to leave the recording exactly as it was recorded for a more authentic and natural sound. For 

others, additional work is needed in order to piece together the perfect lead vocal take, create a 



powerful guitar solo, tune a voice or instrument, fix drum timing, apply time stretching to a track, 

adjust an early or late take, cut and paste background vocals from one chorus to another or replace a 

word sung in the wrong place, and so on. Editing the tracks into their final form allows the mixing 

process to be just about mixing, instead of spending valuable time editing. 

 

MIXING 

The mixing stage is the stage where you take all the individual tracks that have been re-corded (e.g., 

vocals, guitars, bass, kick, snare, keyboard, flute, violin, samples, etc.) and apply processing (e.g., 

volume levels, panning, compression, EQ, reverb, chorus, delay, flange, phaser, gating, etc.) in 

order to make everything sound as good as possible. This stage allows the most flexibility in 

manipulating the sounds, since processing can be applied to each individual track as necessary. Bad 

decisions made here will negatively affect the next stage (mastering). Any problems you have with 

the mix should be taken care of at this stage, and not left to be addressed later during the mastering 

stage where it be-comes much more difficult, if not impossible to fix things. It is infinitely easier to 

focus in on a problem area, whether it is volume, tone, or character, and manipulate it using volume 

and panning as well as processing like compression, EQ, expansion, chorus, gating, etc., during the 

mixing stage. The final result of the mix is that all the individual tracks are mixed from multiple 

tracks ‘down’ to two (2) tracks as a stereo mix. 
 
 
MASTERING 
 

The mastering stage is the stage where you take the mixed 2-track source and apply any additional 

processing that might be necessary and create a master suitable for replication. It can be said that 

good mastering creates a more ‘finished’ product that appears to have more sheen, heft, depth, 

punch, and clarity than the mix alone. Generally speaking, the processing applied during mastering 

is mainly high-quality equalization, compression, the occasional multi-band processing 

(compression, expansion) if necessary, stereo enhancement/correction, noise removal, and volume 

maximizing (limiting). All processing applied during mastering will affect the entire mix, unlike 

during mixing, where each track is processed individually. Some processes typically applied during 

the mixing stage (e.g., chorus, delay, flange, phaser, etc.) are not normally applied during the 

mastering stage, unless in moderate amounts for special effect. 
 

In addition to signal processing, some other important things take place during mastering; like 

sequencing the songs into the correct order, selecting the correct length of space (silence or room 

noise) in between each song, inserting metadata (ISRC, UPC, title, artist, copyright info, etc.), 

assuring no errors are on the final master, supplying a master (or more accurately, a pre-master) to 



the replicating plant suitable for replication, etc. Mastering will almost always make the mix sound 

better. However, the quality of the mix wills greatly affect the quality of the master. Some things 

cannot be fixed in the mastering stage, and should more suitably be dealt with at the mixing stage 

(or even further back, de-pending on the issue). 
 

 

IN CONCLUSION 
 

This is a general description of the different phases of the recording process, from conception to 

completion. The important thing to remember is that the more attention you pay to each phase in 

the process, the better (more professional) the final master will sound. Do not wait until the very 

final stage to try and correct all the mistakes made or shortcuts taken along the way. 

 
8 PREPARATION 

 

8 Tips for Preparing Audio Scripts for Recording 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Tips-for-preparing-script 

What does it take to turn a storyboard into a script that a narrator can easily read? Whether you are 

recording at a studio or in-house, whether you are using a professional voice over artist or a coerced 

colleague, there are certain conventions that make the task easier. 

Here are tips for formatting and organizing your script that apply to all types of recording at work, 

home, and in professional studios. Some are known conventions and some are simply what I have 

discovered through trial and error. 



8.1. Double-check for Errors 
 

Every script has errors. It could be incorrect content or a misuse of grammar. Each error you 

discover during the recording session slows things down and stops the narrator’s momentum. If 

the error requires contacting the SME, that can be a real headache. 
 
 

Therefore, go over that script with a thorough eye for detail and read it aloud. Ask someone else to 

review it for errors too. Making real-time corrections during a recording are not uncommon, but the 

less this happens, the smoother your recording will go. 
 
 

8.2. Indicate Emphasized Words 
 

I remember the first time I was at a recording for a script that I wrote, I was surprised that the 

voice talent didn’t always intonate sentences the way I intended. In hindsight, this seems obvious. 

How could someone else, who is not even familiar with the content, read a script with the same 

voice modulation I had in my mind. 
 

That’s when I started to add emphasis in every script. Typically this is done through text 

formatting, such as using bold or italicized text. To avoid confusion, use one method for the entire 

script and communicate this convention to your narrator in a prerecording briefing. 
 
 

8.3. Provide Pronunciation for Little Known Terms 
 

Using terms that are unique to a field can slow down a recording. If you use medical, technical or 

other specialized vocabularies, find a way to communicate the pronunciation of these words and 

acronyms in the script. Point these out to the narrator before recording begins. 
 

For example, you can write out the phonetic spelling of a term in brackets, so the narrator can 

quickly see the pronunciation. If the script uses acronyms, indicate whether the term should be 

pronounced by its letters or as a word. For example, when the letters alone are used, I write it with 

dashes, as in U-S-A. 



8.4. Indicate Where You Need Pauses 
 
 

If you allow for pauses in the script, it is easier to accommodate graphical changes on the screen, 

such as animations and progressive reveals. You can add an ellipsis (three dots) to the script or 

write the word “pause” in brackets when you need that extra half-second of silence. 
 

Let the narrator know that at these points, you would like a pause of “one beat.” That nearly 

imperceptible moment of silence will help you synchronize the audio and visuals seamlessly 

during course production. 
 
 

8.5. Insert Page Numbers 
 

During a recording at a professional studio, one of my team members created a script without page 

numbers. The audio engineer teased him about this the whole time. That was enough to ensure I 

always remember page numbers. They are essential because du-ring a live recording because 

everyone present will need to reference them. Also, be sure the page numbers are located in a very 

obvious place, such as bottom center. 
 
 

8.6. Avoid Page Turns 
 

When using a paper version of a script (which I find many professional voiceover artists prefer), be 

sure that he or she will not need to turn the page in the middle of a sentence or paragraph. The 

sound of paper turning usually gets picked up by the mic. Actually, this is a good tip even if the 

narrator is reading the script online. The time it takes to find and press the Page Down key can ruin 

the sound byte. 
 
 

8.7. Name Your Audio Files 
 

When recording for an eLearning course, I like to prepare the script so that the audio segment for 

each screen is associated with a unique file name. Devise a naming strategy that makes sense in 

your production environment. 
 

Therefore, my scripts have two columns a narrow one on the left and a wider one on the right. The 

column on the left indicates the name of the audio file; the column on the right holds the script.  

This ensures that everything is well-defined for the person (even if it’s you) doing the 

postproduction work of breaking up the audio into smaller files. 
 



8.8. Make it Easy for the Voice Talent 
 

Regardless of whether the script is read online or from a print-out, double-space the text and use 

an easy to read typeface so the script is highly legible. The physical attributes of the script should 

be transparent to the narrating process. 
 
 

Always provide the script to your narrator a few days before the recording session. Professionals 

always ask for a script ahead of time, so it makes sense to give it to your col-leagues too. Not 

only will the recording have fewer retakes, your narrator will feel more comfortable and 

prepared. 
 
 

9 RECORDING 

 

Record audio with Sound Recorder 
 

You can use Sound Recorder to record a sound and save it as an audio file on your computer. You 

can record sound from different audio devices, such as a microphone that's plugged into the sound 

card on your computer. The types of audio input sources you can record from depend on the audio 

devices you have and the input sources on your sound card. (Applies to Windows 7) 

 
 
To record audio with Sound Recorder 
 

Make sure you have an audio input device, such as a microphone, connected to your 

computer. 

 

Open Sound Recorder by clicking the Start button Picture of the Start button. In the search 

box, type Sound Recorder, and then, in the list of results, click Sound Recorder. 

 

 

Click Start Recording. 
 

To stop recording audio, click Stop Recording. 

Optional if you want to continue recording audio, click Cancel in the Save As dialog box, and 

then click Resume Recording. Continue to record sound, and then click Stop Recording. 
 

Click the File name box, type a file name for the recorded sound, and then click Save to 

save the recorded sound as an audio file.



Note 

To use Sound Recorder, you must have a sound card and speakers installed on your computer. If 

you want to record sound, you also need a microphone (or other audio input device). 

You can play the saved audio file on your computer by using a media player program. 

http://windows.microsoft.com/en-US/windows7/Record-audio-with-Sound-Recor-der 

 

10 OVERDUBBING 

The process of making an overdub, or overdubs is a technique used in audio recording, whereby a 

performer listens to an existing recorded performance (usually through headphones in a recording 

studio) and simultaneously plays a new performance along with it, which is also recorded. The 

intention is that the final mix will contain a combination of these "dubs". 

 

Tracking (or "laying the basic tracks") of the rhythm section (usually including drums) to a song, 

then following with overdubs (solo instruments, such as keyboards or guitar, then finally vocals), 

has been the standard technique for recording popular music since the early 1960s. Today, 

overdubbing can be accomplished even on basic recording equipment, or a typical PC equipped 

with a sound card, using digital audio workstation software. 

 

Examples 
 

Overdubs can be made for a variety of reasons. One of the most obvious is for convenience; for 

example, if a bass guitarist is temporarily unavailable, the recording can be made and the bass 

track added later. Similarly, if only one or two guitarists are available, but a song calls for 

multiple guitar parts, a guitarist can play both lead and rhythm guitar. Overdubbing is also used to 

solidify a weak singer; double tracking allows a singer with poor intonation to sound more in 

tune. (The opposite of this is often used with sampled instruments; detuning the sample slightly 

can make the sound more lifelike.) 

 

Overdubbing has sometimes been viewed negatively, when it is seen as being used to artificially 

enhance the musical skills of an artist or group, such as with studio-recorded inserts to live 

recordings, or backing tracks created by session musicians instead of the credited performers. The 

early records of The Monkees were made by groups of studio musicians pre-recording songs (often 

in a different studio, and some before the band was even formed), which were later overdubbed 

with the Monkees' vocals. While the songs became hits, this practice drew criticism. Michael 

Nesmith in particular disliked what overdubbing did to the integrity of the band's music. 

Additionally in working with producer Butch Vig, Kurt Cobain had expressed a disdain for double-



track recording. Vig had to reportedly convince Cobain to use the recording technique by saying, 

"The Beatles did it on everything. John Lennon loved the sound of his voice double-tracked."  

 

 

11 MIX DOWN 

In sound recording and reproduction, audio mixing (or “mix down”) is the process which 

commences after all tracks are recorded (often, tracked) and edited as individual parts. The mixing-

process can consist of various processes but are not limited to setting levels, setting equalization, 

using stereo panning, and the addition of effects. The way the song is mixed has as much impact on 

the way it sounds as each of the individual parts that have been recorded. Dramatic impacts on how 

the song affects the listeners can be created by minor adjustments in the relationship among the 

various instruments within the song. 

 

Audio mixing is utilized as part of creating an album or single. Mixing is largely dependent on both 

the arrangement and the recordings. The mixing stage often follows a multi track recording. The 

process is generally carried out by a mixing engineer, though sometimes it is the musical producer, 

or even the artist, who mixes the recorded material. After mixing, a mastering engineer prepares 

the final product for reproduction on a CD, for radio, or otherwise. 
 
 

Prior to the emergence of digital audio workstations (DAWs), the process of mixing used to be 

carried out on a mixing console. Currently, more and more engineers and independent artists are 

using a personal computer for the process. Mixing consoles still play a large part in the recording 

process. They are often used in conjunction with a DAW, although the DAW may only be used as 

a multi track recorder and for editing or sequencing, with the actual mixing being performed on 

the console. 

 



The role of audio mixing 
 

In its simplest form an audio mixer combines several incoming signals into a single output signal, 

however this is not as simple as connecting the input signals in parallel and sending them to a single 

output signal because they could influence each other. In order to combine different signals, they 

must be mixed first so that each signal has a relationship of hierarchy (each signal's volume one 

step below the next). The role of a music producer is not necessarily a technical one, with the 

physical aspects of recording being assumed by the audio engineer, and so producers often leave 

the similarly technical mixing process to a specialist audio mixer. Even producers with a technical 

background may prefer that a mixer comes in to take care of the final stage of the production 

process. Noted producer and mixer Joe Chiccarelli has said that it is often better for a project that an 

outside per-son comes in because: 
 

"when you're spending months on a project you get so mired in the detail that you can't bring all 

the enthusiasm to the final [mixing] stage that you'd like. [You] need somebody else to take over 

those responsibilities so that you can sit back and regain your objectivity.” 
 
 

Equipment 
 

Mixing Consoles 



A mixer, or mixing console, or mixing desk, or mixing board, or software mixer is the operational 

heart of the mixing process. Mixers offer a multitude of inputs, each is fed by a track from a 

multitrack recorder. Mixers typically have 2 main outputs (in the case of two-channel stereo 

mixing) or 8 (in the case of surround). 
 
 

Mixers offer three main functionalities: 
 

Mixing – summing signals together, which is normally done by a dedicated summing amplifier or 

in the case of digital by a simple algorithm. 
 

Routing – allows the routing of source signals to internal buses or external processing units 

and effects. 
 

Processing – many mixers also offer on-board processors, like equalizers and compressors. 
 
 

Simple mixing console 
 

Mixing consoles used for dubbing are often large and intimidating, with exceptional amount of 

controls. These controls luckily consist of a great deal of duplication among them, so by studying 

just one area of a console, one learns nearly all of the areas. The mixing console can at the end of 

the day be broken down into two ingredients, processing and configuration. Sound processes are 

the devices that is used to manipulate the sound, all the way from simple internal level controls to 

sophisticated outboard reverberation units whereas the configuration issues consist out the signal 

routing from the input to the output of the console through the various processes. 
 
 
Digital Audio Workstations (DAW’s) today have many mixing features which potentially have 

more processes available to that of a major console. The distinction between DAW’s equipped with 

a control surface and large consoles is usually that, if the console is digital, it will consist of 

dedicated digital signal processors for each channel and is thus designed not to “overload” under 

the burden of signal processing and which may possibly crash or lose signals. DAW’s can 

dynamically assign resources like digital audio signal processing power and so could run out if 

many signal processes were in simultaneous use. The upside of this is that this can be solved fairly 

easily by just plugging in more hardware into the DAW, but the downside would be that the cost of 

this endeavor may approach that of a major console. 



12 MASTERING 

A form of audio post production, is the process of preparing and transferring recorded audio from 

a source containing the final mix to a data storage device (the master); the source from which all 

copies will be produced (via methods such as pressing, duplication or replication). In recent years 

digital masters have become usual although analog masters, such as audio tapes, are still being 

used by the manufacturing industry, notably by a few engineers who have chosen to specialize in 

analog mastering. 
 

Mastering requires critical listening; however, software tools exist to facilitate the process. 

Mastering is a crucial gateway between production and consumption and, as such, it involves 

technical knowledge as well as specific aesthetics. Results still depend upon the accuracy of 

speaker monitors and the listening environment. Mastering engineers may also need to apply 

corrective equalization and dynamic compression in order to optimize sound translation on all 

playback systems.[2] It is standard practice to make a copy of a master recording, known as a 

safety copy, in case the master is lost, damaged or stolen. 
 
 

Digital technology 
 

Optimum Digital Levels with respect to the Full Digital Scale (dBFSD) 
 
In the 1990s, electro-mechanical processes were largely superseded by digital technology, with 

digital recordings stored on hard disk drives or digital tape and transferred to CD. 

The digital audio workstation (DAW) became common in many mastering facilities, allowing the 

off-line manipulation of recorded audio via a graphical user interface (GUI). Although many 

digital processing tools are common during mastering, it is also very com-mon to use analog 

media and processing equipment for the mastering stage. Just as in other areas of audio, the 

benefits and drawbacks of analog digital technology compared to analog technology are still a 

matter for debate. However, in the field of audio mastering, the debate is usually over the use of 

digital versus analog signal processing rather than the use of digital technology for storage of 

audio. 
 

Although there is no "optimum mix level for mastering", the example in the picture to the right 

only suggests what mix levels are ideal for the studio engineer to render and for the mastering 

engineer to process. It is important to allow enough headroom for the mastering engineer's work. 

Reduction of headroom by the mix or mastering engineer has resulted in a loudness war in 



commercial recordings. 



Steps of the process typically include the following: 

 
• Transferring the recorded audio tracks into the Digital Audio Workstation (DAW).  
 
• Sequence the separate songs or tracks as they will appear on the final release.  
 
• Adjust the length of the silence between songs.  
 

• Process or "sweeten" audio to maximize the sound quality for the intended medium (e.g. 

applying specific EQ for vinyl).  
 
• Transfer the audio to the final master format (CD-ROM, half-inch reel tape, PCM 1630 U-matic 

tape, etc.).  
 
 

Examples of possible actions taken during mastering: 
 
• Editing minor flaws.  
 
• Applying noise reduction to eliminate clicks, dropouts, hum and hiss.  
 
• Adjusting stereo width.  
 
• Adding ambience.  
 
• Equalize audio across tracks for the purpose of optimized frequency distribution.  
 
• Adjust volume.  
 
• Dynamic range compression or expansion.  
 
• Peak limit.  
 
• Dither.  
 
 

13 SEQUENCE EDITING 

Sequencing and editing options… 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



1: There are three ways to manipulate audio: using smaller, sequenced individual events, 

manipulating from within a loop or recording of a performance, or by using Live’s Slice To New 

MIDI Track function (from right-click menu) to get audio into a MIDI-controllable form. The 

latter can utilise techniques from the previous set of steps here, but our re-commendation is to 

fully explore the presets available 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2:  The first few variables for an audio file can be discovered quite easily with single sounds. 

Starting with Warp mode disabled, Transpose will let you pitch the audio up and down with vari-

speed. Extreme settings of an octave or more in either direction will cause great sonic changes 

which can generate very interesting textures and sounds to start an idea with. 

 



3: As soon as Warp mode is enabled you open up a whole new world of possibilities, the first 

being an overall time-stretch effect which, like vari-speed transpose, can create dramatic tonal 

changes at more extreme settings. Hit the half-time button a few times for an immediate granular-

type effect. 



4: Warp-based time-stretching and pitch change are easily applied to loops or recordings, but in 

order for single sounds to benefit from this you first need to turn them from a sequence into a new 

single audio file. To do this, highlight all parts on a track and select Consolidate from the Edit menu 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5: To quickly explore the effects of warp markers, use the half- and double-time buttons. Warp 

modes can be chosen from the dropdown menu below the: 2& *2 buttons and all but re-pitch 

modes will generate a unique, stretched timbre. Warp markers themselves can be moved around 

for an in-loop variation of time-stretch and compress effects. 

 



6: Transpose is another useful tool for broad variation. First open the Envelope box by 

pressing the small E button underneath the Clip box, then select Transposition 

Modulation and alter the envelope over time. All stretch modes can have their other 

parameters changed as well, so explore the new tones these can offer you. 
 
 

  



Self Assessment Question 
 

 

Q # 1.  How many steps are there to make a cheap recording studio? 
 

 

Q # 2.  What is the importance of control room? 
 

 

Q # 3.  Why a control room is necessary for a broadcasting house? 
 

 

Q # 4.  What is the most important piece of equipment in any portable studio? 
 

 

Q # 5.  How many best methods are there for recording on location? 
 

 

Q # 6.  Describe the typical phases of the recording process? 
 

 

Q # 7  What is dubbing, Please explain with example?  
 

 

Q # 8.  Where the sound card used? 
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INTRODUCTION 

Dear Students this unit provides a brief overview of audio and its recording on the computer. After 

reading this unit, you should have a general idea of sound and audio recording and some ideas 

about where to learn more. Topics include difference between digital and analogue audio, 

recording techniques, recording devices and creating first recording track through adobe audition. 

Students the modern audio recording involves an ever-expanding set of specialized tools. Each 

year, there are number of applications using audio increases. In this unit you will find many 

possible tools and technologies. In addition to what you may already have in your computer, you 

will find an abundance of shareware and freeware music and audio software available. 

Dear Students in the past 20 years, audio has moved from analog recording (tape cassettes) as the 

playback medium to totally digital recording using computers with digital surround sound 

playback.  

Dear Students today, the Musical Instrument Digital Interface (MIDI), the sequencer, sound cards, 

and synthesizers allow anyone to create music right on their desktop. Even a modest setup can 

create surprisingly realistic audio tracks. You probably have many of these tools in your computer 

already. 

Dear students, even if you're not a musician, the technology surrounds you. Songs can be 

downloaded as MIDI files that will play on your computer's soundcard. Computer-based audio 

files can now deliver your favorite songs over the Internet. Download a group of your favorite 

songs as MP3 files and then create a custom CD to listen to at your next party. In this unit the 

students will learn to create greatest hits collections of your favorite tunes to share with your 

friends, add a soundtrack and sound effects to your latest video recording. 

Dear students in this unit you will learn about creating your own music and audio files. You have 

much software for the purpose. Basically skills are important, how to produce a music file or an 

interview etc. In this unit you will learn about recording of music, program or audio file and steps 

involved in recording to a finished product. Students after this unit you will learn to create your 

own audio track. 

 



OBJECTIVES: 

After studying this unit you will be able to: 

 

1. The students will understand the difference between analog and digital audio. 

2. Well knowledge of analog and digital audio recording techniques. 

3. Comprehensive information about digital audio recorders. 

4. How to record music or an audio file from scratch to a finished product. 

So after learning difference between digital and analogue audio what do you think which audio is 

better. You can better analyse after listening both the audios recorded by an analogue or digital 

technology. 

 

  



1. DIFFERENCE BETWEEN ANALOG AND DIGITAL AUDIO 

Audio come in two basic types, analog and digital. Analog refers to audio recorded using methods 

that replicate the original sound waves. Vinyl records and cassette tapes are examples of analog 

mediums. Digital audio is recorded by taking samples of the original sound wave at a specified 

rate. CDs and Mp3 files are examples of digital mediums. 

 

 

 

 

 

 

As you can see in the diagrams, the analog sound wave replicates the original sound wave, 

whereas the digital sound wave only replicates the sampled sections of the original sound wave. 

The potential fidelity (reliability) of an analog recording depends on the sensitivity of the 

equipment and medium used to record and playback the recording.  



Among other factors, digital audio fidelity heavily depends on the rate at which the recording 

equipment sampled the original sound wave over a specified increment of time. Even with the 

newest technologies and techniques, digital audio still cannot create exact replications of an 

original sound wave.  

 

 

 

 

    

  Figure 

Many times, we hear fancy words like “Uncompressed” and “Lossless”. These words are very 

misleading as all digital audio features some compression and loss of the original signal. However, 

even the best trained human ear may not be able to tell the difference between a high quality 

digital signal and an analog audio signal. 

An easy way to visualize digital audio is to consider the difference between a regular light bulb 

and a strobe light. 

Recording basics 

Both digital and analog recordings have their merits. No matter which recording process is used, 

analog or digital, both are created by a microphone turning air pressure (sound) into an electrical 

analog signal. 

An analog recording is made by then imprinting that signal directly onto the master tape (via 

magnetization) or master record (via grooves) – from which copies can be made into cassette tapes 

and vinyl records. 



 

 

 

 

 

 

Figure: Tape Recorders 

Below are some vinyl recorders: 

 

 

 

 

 

 

 



 

 

 

 

 

 

 

 

 

Digital recordings take that analog signal and convert it into a digital representation of the sound, 

which is essentially a series of numbers fordigital software to interpret. 

After the analog signal is digitalized, the recording can be copied and placed onto a compact disc, 

hard drive or streamed online. 

 

 

 



      

 

 

 Compact Disc(CD)      

               Hard Disk 

 

Audio Bandwidth 

Bandwidth is the ability of a recorded signal to be reproduced at varying degrees of resolution. 

Think of it like enlarging a low-resolution image versus a high-resolution image. After a certain 

point, enlarging a lower-resolution image will become pixelated and difficult to see, where the hi-

resolution image will resize clearly. 

Like images, audio signals can have a limited bandwidth if recorded digitally. Once a digital 

recording is made, the bandwidth is set in place. 

An analog recording is considered unlimited. Therefore, it can move to a higher and higher 

resolution without losing its original quality. 

  

 

 

 

 

Pixelated Image 



Signal to noise ratio 

The signal-to-noise ratio (SNR) is the amount of noise generated by the recording signal to your 

speakers. Digital recordings can have a greater signal-to-noise ratio depending on the bit depth of 

the recording. 

The smooth analog signal matches the recorded sound wave better than the steps of a digital 

recording. However, the analog medium (vinyl or magnetized tape) the recording is imprinted can 

have tiny imperfections that cause cracking and popping noise. 

Mobility of Media 

Digital music can be stored, played and streamed on multiple transportable digital products (CD’s, 

phones, mp3 players, etc.). Outside of tape players, analog-recorded music is fairly immobile. 

Loss of audio quality 

Digital recordings can be played and copied endlessly without ever losing their original quality. 

Over time, vinyl records and tapes can lose their audible value when being played or copied. 

2. ANALOG RECORDING TECHNOLOGY 

Analog recording methods store signals as a continuous signal in or on the media. The signal may 

be stored as a physical texture on a phonograph record, or a fluctuation in the field strength of 

a magnetic recording.  

Following are some machines used for analog recording: 

1. The Phonograph 

2. Gramophone 

3. Telegraphon 

4. Magnetophone 

 

https://en.wikipedia.org/wiki/Continuous_signal
https://en.wikipedia.org/wiki/Phonograph_record
https://en.wikipedia.org/wiki/Field_strength
https://en.wikipedia.org/wiki/Magnetic_recording


THE PHONOGRAPH 

The Phonograph was the first machine used to capture analog sound, and was invented by the 

well-known inventor Thomas Edison in 1877.  

 

 

 

 

 

 

Edison incorporated various elements into his Phonograph that would become staples that can be 

found in recording devices to this day.  

Recording  

For a sound to be recorded by the Phonograph, it has to go through three distinct steps. First, the 

sound enters a cone-shaped component of the device, called the microphone diaphragm. That 

sound causes the microphone diaphragm, which is connected to a small metal needle, to vibrate. 

The needle then vibrates in the same way, causing its sharp tip to engrave a distinctive groove into 

a cylinder, which was made out of tinfoil. 

Playback 

In order to playback the sound recorded on one of the tinfoil cylinders, the recording process is 

essentially reversed. As the cylinder spins, the needle follows the groove created by the previous 

recording session. This causes the needle to vibrate, and then the diaphragm. This vibration comes 

out of the diaphragm, which is now functioning as a sort of sound amplification device, much like 

the bell on any wind instrument. The result is an audible reproduction of the originally recorded 

sound. 



GRAMOPHONE 

Fans of modern record players are already familiar with one very early improvement on the 

phonograph, known as the gramophone. Inventor Emile Berliner created the device in 1887, only 

ten years after Edison's original device. 

 

 

 

 

 

 

 

 

Advantages 

Berliner's main improvement to the phonograph was related to the component of the device that 

actually held the recorded information. The previously used tinfoil cylinders were awkwardly 

shaped, making them hard to store. They could also not be reproduced economically, which was 

another reason why they were not seen as a viable option for recorded music. Berliner realized 

these disadvantages, and set out to create a better version of the tinfoil cylinder. What he came up 

with was not a cylinder at all, but was rather a flat circular disc much like modern vinyl records. 

These discs could not only be easily stacked and stored for safe-keeping, but were also 

comparatively easy to reproduce. This quality allowed for the mass production of recorded discs, 

which was the first step towards commercially recorded music. 

 

  



TELEGRAPHONE 

The next great advancement in analog sound recording came in the form of the telegraphone, 

which was created by Danish inventor Valdemar Poulsen between 1898 and 1900. 

 

Early mechanical drawings of the telegraphone 

This machine was vastly different from the gramophone or the phonograph, in that instead of 

record sound mechanically, it records using a process called electromagnetism. 

MAGNETOPHON 

In 1935, inventor Fritz Pfleumer took the electromagnetic recording idea and took it to the next 

level. Rather than using heavy, expensive, and dangerous steel wire like Poulsen, Pfleumer 

realized that he could coat normal strips of paper with tiny particles of iron. The iron would allow 

the paper to be magnetized in the same way as the steel wire, but would eliminate most of its 

shortcomings. 

 

https://en.wikipedia.org/wiki/File:US_Patent_661,619_-_Magnetic_recorder.jpg
https://en.wikipedia.org/wiki/File:Ton_S.b,_tape_unit.jpg


The Magnetophon 

The magnetophon operated with a process nearly identical to that of the telegraphone. An 

inscriber, called the recording head, passes over the electromagnetic paper strip, creating patterns 

of varying magnetic polarity within it, which can later be played back. The playback is achieved 

using a reversal of the recording process. The pre-magnetized paper, which had come to be known 

as tape, passed over a coil, creating changes in magnetic flux. These changes were translated into 

an electric current, which when amplified produced a replica of the previously recorded sounds. 

Advantages 

There were many advantages of tape recording, but the most important was that it led to the 

development of multi tracking. Multi tracking occurs when multiple takes of a performance, which 

were recorded at separate times, are brought together to play simultaneously. This is the method 

all recording studios use to this day, in order to record all of the separate instruments of a song, 

and get the best possible takes from all of the musicians. 

A reel of tape could also hold far more recorded information than previous mediums. For instance, 

Berliner's discs held only a few minutes of recording, meaning that each disc usually contained a 

single song, or multiple short clips. Pfleumer's tape reels, on the other hand, could hold up to thirty 

minutes of sound. This ability is what eventually led to the concept of a music "album", or 

collection of multiple songs. 

3. DIGITAL RECORDING TECHNOLOGY 

In a Compact Disc or any other digital recording technology, the goal is to create a recording with 

very high similarity between the original signal and the reproduced signal and perfect recording 

sounds the same every single time you play it no matter how many times you play it. To 

accomplish these two goals, digital recording converts the analog wave into a stream of numbers 

and records the numbers instead of the wave. The conversion is done by a device called an analog-

to-digital converter (ADC).  

To play back the music, the stream of numbers is converted back to an analog wave by a digital-

to-analog converter (DAC). The analog wave produced by the DAC is amplified and fed to 

the speakers to produce the sound. The analog wave produced by the DAC will be the same every 

time, as long as the numbers are not corrupted. The analog wave produced by the DAC will also 

http://electronics.howstuffworks.com/cd.htm
http://electronics.howstuffworks.com/amplifier.htm
http://electronics.howstuffworks.com/speaker.htm


be very similar to the original analog wave if the analog-to-digital converter sampled at a high rate 

and produced accurate numbers. 

You can understand why CDs have such high fidelity if you understand the analog-to-digital 

conversion process better. Let's say you have a sound wave, and you wish to sample it with an 

ADC.  

The figure shows a typical wave: 

 

 

 

 

 

 

 

When you sample the wave with an analog-to-digital converter, you have control over two 

variables: 

 The sampling rate - Controls how many samples are taken per second 

 The sampling precision - Controls how many different gradations (quantization levels) are 

possible when taking the sample 

In the following figure, let's assume that the sampling rate is 1,000 per second and the precision is 

10: 



 

The green rectangles represent samples. Every one-thousand of a second, the ADC looks at the 

wave and picks the closest number between 0 and 9. The number chosen is shown along the 

bottom of the figure. These numbers are a digital representation of the original wave.  

When the DAC recreates the wave from these numbers, you get the blue line shown in the 

following figure: 

 

 

 

You can see that the blue line lost quite a bit of the detail originally found in the red line, and that 

means the fidelity of the reproduced wave is not very good. This is the sampling error. You reduce 

sampling error by increasing both the sampling rate and the precision. 

 In the following figure, both the rate and the precision have been improved by a factor of 2 (20 

gradations at a rate of 2,000 samples per second): 



 

In the following figure, the rate and the precision have been doubled again (40 gradations at 4,000 

samples per second): 

 

You can see that as the rate and precision increase, the fidelity (the similarity between the original 

wave and the DAC's output) improves. In the case of CD sound, fidelity is an important goal, so 

the sampling rate is 44,100 samples per second and the number of gradations is 65,536. At this 

level, the output of the DAC so closely matches the original waveform that the sound is essentially 

"perfect" to most human ears. 

4. DIGITAL RECORDING BASICS 

In the context of audio, “Analog” refers to the method of representing a sound wave with voltage 

fluctuations that are analogous to the pressure fluctuations of the sound wave. Analog fluctuations 

are infinitely varying rather than the discrete changes at sample time associated with digital 

recording. Simply put, “digital audio” refers to the representation of sound in digital form. 
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Portable Recorders 

At the present time, there are four mainstream types of portable digital recorders:  

1. Solid State    

Which uses flash memory. 

2. Hard-Disk Based   

Which records to an internal or external hard drive. 

3. CD Recorders    

Which records on CD (Compact Disks) 

4. Direct-to-computer recording   

Which uses an analog-to-digital converter and sends the signal into the computer 

via firewireor a USB connection. 

Recorder inputs 

Portable recorders possess a variety of input types: 

XLR inputs: 

 

 

 

XLR inputs are the highest quality analog inputs. The connection is a “balanced” signal. A 

balanced connection enables the linking of analog audio devices, including microphones, to a 

recorder through impedance-balanced cables. Usually associated with professional-level audio 

equipment, these allow for longer cable lengths and reduce the addition of external noise to the 

signal. Balanced cables have either XLR or TRS plugs. Professional level digitization will usually 
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involve balanced outputs on the analog playback device and balanced inputs on the analog-to-

digital converter.  XLR cables transport a mono signal. Stereo recorders with XLR inputs will 

contain two XLR inputs.  Single Point Stereo microphones will contain a modified version of 

XLR. In certain cases, this can be a 5-pin connector that splits into two XLR male cables. 

TRS (tip-ring-sleeve): 

A ¼ inch. TRS (tip-ring-sleeve) contains the same technology as the XLR connector, but in the 

form of a ¼ inch connector. The balanced TRS connector carries a mono signal and requires 

balanced inputs. 

 

 

 

 

 

 

 

 

This allows for greater compatibility with higher-end recorders.  A 1/4″ balanced input is fairly 

rare in portable digital audio recorders. 

1/8 in. mini-plug inputs:  

The1/8 in. mini-plug inputs are typically associated with lower-end recorders. On the connector, 

one ring signifies a mono jack and two rings signify a stereo jack.  
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The mini-plug’s advantage is portability, but the preamps associated with this input type are 

usually sub-par. The mini-plug can be temperamental because it does not lock into the microphone 

input jack and because touching the jack while plugged in can cause static. 

Recorder Settings 

Sample Rate is the number of samples or “snapshots” taken of the signal and is measured 

in hertz/second. The higher the sample rate the better the digital representation will be. CD quality 

equals 44,100 samples per second or 44.1 KHz and is the minimum recommended sample rate for 

field recordings. 

Bit Depth refers to the number of bits used to represent a single sample. For example, 16-bit is a 

common sample size. While 8-bit samples take up less memory (and hard disk space), they are 

inherently noisier than 16-bit or 24-bit samples. The higher the bit depth, the better the recording; 

however, higher bit depths also lead to larger file sizes. 

Bit Rate refers to a measurement of digital audio based on the following equation and is usually 

expressed in kilobits/second 

  Bit rate = (bit depth) x (sampling rate) x (number of channels) 

Again, CD quality equals 16-bit and should be the minimum bit depth used for field recordings. 

As flash-based storage media dramatically decreases in cost, 24-bit field recordings are beginning 

to catch on in the field. These 24-bit recordings are becoming the standard bit depth for archival 

quality. Although many repositories and individuals continue to digitize using 16-bit. 

Channels 

Single-channel recording is known as monaural or mono recording. Stereo recording involves the 

recording of two channels (left and right). In interviewing situations, the two channels associated 

with stereo recording allow the separation and isolation of a channel for the interviewer and the 

interviewee. 

Recording quality and compression 

Digital recorders provide a variety of parameters regarding recording quality. Field recordings 

should be recorded without compression. Compressed recording formats are usually measured 

by bit rate, which is calculated by an equation involving bit depth, sample rate, and the number of 

channels being recorded. 
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For archival purposes, uncompressed is the best way to record. Compressed audio is best utilized 

for creating web-deliverable files, not for recording the original interview. 

File Formats 

Uncompressed: 

The standard file formats associated with uncompressed recordings are Wave (.wav), Broadcast 

Wave, and .AIFF. Portable field recorders normally utilize Wave files. AIFF files usually are 

associated with Mac computer applications. Since both are uncompressed, the quality is the same. 

Compressed 

MPEG recording will dramatically decrease your data footprint and, thus, increase your recording 

time. The compression, however, degrades your recording quality. MPEG is ideal for placing 

audio files on the Web. IndeedMp3 files have become a standard uncompressed codec almost 

universally accepted by most computer players. Mp3 files are usually measured by bit rate rather 

than by sample rate and bit depth.  

We will learn in about file formats and audio standards in detail in unit 8. 

File Size 

File sizes for recordings are calculated by combing bit depth, sample rate, channels, and recording 

time. 

 16-bit/44.1KHz/Stereo/.wav =635.04 mb perhour 

 24-bit/96 KHz/Stereo/.wav = 2 gb per hour 

Recording Levels 

 You want to record as strong a signal as possible. 

 You do not want your recording levels to clip. 

 Higher bit depth recording is more forgiving when boosting the levels of a low-level 

recording. 

 A recording that has average peaks will normally have a greater amount of noise when the 

levels are boosted to optimal levels. I prefer to stay away from averaging because of the 
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unpredictability of an interview. If clipping occurs, don’t panic and gently back the levels 

down. 

MANUAL LEVEL CONTROL 

Manual level control involves the operator adjusting the levels by use of the input level or 

recording level controls. When recording with manual level control it is best to use a limiter to 

protect against clipping. 

LIMITER 

A limiter sets a threshold above which the signal will be gently pushed down in order to prevent 

clipping. 

 

5. SAMPLING AND QUANTIZATION 

Sampling 

Before digital recording took over the audio and video industries, everything was recorded in 

analog. Audio was recorded to devices like cassette tapes and records. Video was recorded to Beta 

and VHS tapes. The media was even edited in analog format, using multichannel audio tapes (such 

as 8-tracks) for music, and film reels for video recordings. This method involved a lot of 

rewinding and fast-forwarding, which resulted in a time-consuming process. 

 

Fortunately, digital recording has now almost completely replaced analog recording. Digital 

editing can be done much more efficiently than analog editing and the media does not lose any 

quality in the process. However, since what humans see and hear is in analog format (linear waves 

of light and sound), saving audio and video in a digital format requires converting the signal from 

analog to digital. This process is called sampling. 

Sampling involves taking snapshots of an audio or video signal at very fast intervals, usually tens 

of thousands of times per second. The quality of the digital signal is determined largely by the 

sampling rate, or the bit rate the signal is sampled at. The higher the bit rate, the more samples are 

created per second, and the more realistic the resulting audio or video file will be. For example, 

CD-quality audio is sampled at 44.1 kHz, or 44,100 samples per second. The difference between a 
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44.1 kHz digital recording and the original audio signal is imperceptible to most people. However, 

if the audio was recorded at 22 kHz (half the CD-quality rate), most people would notice the drop 

in quality right away. 

 

Samples can be created by sampling live audio and video or by sampling previously recorded 

analog media. Since samples estimate the analog signal, the digital representation is never as 

accurate as the analog data. However, if a high enough sampling rate is used, the difference is not 

noticeable to the human senses. Because digital information can be edited and saved using a 

computer and will not deteriorate like analog media, the quality/convenience tradeoff involved in 

sampling is well worthwhile. 

 

Quantization 

The simplest way to quantize a signal is to choose the digital amplitude
1
 value closest to the 

original analog amplitude. This example shows the original analog signal (green), the quantized 

signal (black dots), the signal reconstructed from the quantized signal (yellow) and the difference 

between the original signal and the reconstructed signal (red). The difference between the original 

signal and the reconstructed signal is the quantization error and, in this simple quantization 

scheme, is a deterministic function of the input signal. 
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Quantization, in mathematics and digital signal processing, is the process of mapping a large set of 

input values to a (countable) smaller set. Rounding and truncation are typical examples of 

quantization processes. Quantization is involved to some degree in nearly all digital signals 

processing, as the process of representing a signal in digital form ordinarily involves rounding. 

Quantization also forms the core of essentially all lossy compression algorithms. The difference 

between an input value and its quantized value (such as round-off error) is referred to 

as quantization error. A device or algorithmic function that performs quantization is called 

a quantizer. An analog-to-digital converter is an example of a quantizer. 

 

6.  RECORDING PROCESS 

The recording process is an exciting journey filled with art, fulfillment, and satisfaction. More 

specifically, the process is the steps required to make finished recording. The steps in the 

recording process may vary from project to project. It depends on what your end goal is. For the 

most part though, the following steps will get you on the path to successful recording. 

For the most popular recording-a CD-here is the basic recording process: 

 Choose your equipment 

 Mic placement & technique 

 Record the audio 

 Editing 

 Do any mixing needed 

 Do any mastering needed 

 Replicate your discs 

 

Let's look at each one of these steps: 

Choose you equipment 

While this is not an action step in the recording process, it is utterly important to get the right 

equipment. 



There is a lot of recording equipment available, for a lot of different uses. By defining your needs 

you can soon decide what you need and what you do not need. 

Some of the things you might need are: 

 Computer interface 

 Computer software 

 Digital recording console 

 Mixer 

 Microphones 

 Mic stands 

 Microphone preamp 

 Headphones 

 

Its looks like quite a list but you will not need all of the things listed. 

 

Mic Placement and Technique 

What makes the difference between different recordings? Why do some CD's sound better than 

others? 

The answer lies in various places, but one of the important answers is mic placement. 

Mic placement is how you position your microphones in relation to the instrument or voice. 

Technique is the general strategy used in mic placement. Where you put your mics while 

recording, will make a big difference in the sound you get. You can just plunk a mic down and 

record, but a little experimentation can go a long way in getting a better sound. 

Record the audio 

This is one of the most exciting parts of recording, when you actually record the tracks to disk. 

Before you do this, make sure you accurately follow the previous steps to get the best sound 



possible. You have quality mics, placed in excellent strategic positions. You will be recording 

with excellent equipment (digital recording console or computer). Now, just push the record 

button. 

Sit back, and enjoy the wonder of it all. 

When you are done, go back and listen to it again. Enjoy this feeling. At this stage, you are in the 

heart of the recording process. 

Editing 

Once everything is recorded, additional editing can be done in order to get the recording to sound 

perfect and get the tracks ready for mixing. In editing you can delete or cut the portions where 

something wrong is recorded or during recording there is some pause or gap. You can apply 

various sound effects on your recording in editing process.  

Mixing 

When you are baking a cake, you take the ingredients (like flour and sugar) and mix them together 

to make the chocolate cake. Everything gets mixed together, and out comes a beautiful cake (or 

sound).That is what audio mixing is about too. Only now you're dealing with audio tracks instead 

of eggs and baking powder. 

There are a lot of things you can do when mixing besides just combining 4 outputs into 1.  

You can: 

 adjust the levels of each track 

 adjust the panning of each track 

 add effects to each track 

This is where audio engineers spend most of their time during the whole recording process.  

 

Mastering 

Basically, mastering means the process of putting the final touches on your mix to make it ready. 

It is one of the final steps in the recording process. 



This can entail subtleeq, compression, and a touch of reverb, as well as adjusting the levels of each 

individual track to you can't hear a difference when you're listening to the CD. 

The goal is to make the end result work well together. 

Replication 

The last step in the recording process is replication. It means having copies made of your CDs. 

Duplication is another word that means almost the same, but with slight differences. 

In duplication, the music is burned onto blank CDs. This is usually used for small runs, like 25 - 

500 CDs. From 500 on up in quantity, it is usually more cost effective to go the replication route. 

In replication, the process is different. Make a glass copy of master copy. From this, stamp out 

your new CDs. The bottoms are silver and it looks a bit more professional. 

7.  SIGNAL DISTRIBUTION 

Signal distribution is done by an audio distribution amplifier (DA) designed to reproduce the same 

audio signal to multiple outputs. Unlike an adapter cable that simply splits the audio and produces 

a weaker signal output, a distribution amplifier ensures the same signal strength that goes into the 

unit also leaves the unit for each output. Recording studios, media production companies, and 

complicated home theatre installations typically use an audio distribution amplifier to route a 

common audio source to many locations. 

Though the design of audio distribution amplifiers changes with new technologies, their role of 

providing the same audio signal to a number of destinations remains essentially the same. They 

can be used for feeding the same audio to a number of tape duplicators, distributing audio 

throughout a home or business, or with an audio kiosk that allows a number of headphones to 

connect to the same audio source. Professionally, they can be found providing the same audio to a 

variety of components used in a recording studio. 

 

 

 



 

 

 

 

 

Generally, an audio distribution amplifier is designed according to specific purposes. Some use 

inputs and outputs that require raw wire to be attached with small retention screws or the same 

kind of connectors found on speaker components. Others are manufactured using specific kinds of 

audio connectors, such as balanced three-pin XLR or unbalanced Radio Corporation of America 

(RCA) jacks. 

 

 

 

  XLR Cables  

    RCA Jacks 

The internal circuitry typically will reflect the kind of application for which the distribution 

amplifier is designed. Some distribution amplifiers provide only a few additional outputs, while 

others provide dozens of outputs. Generally, the more outputs provided by a distribution amplifier, 

the more the device will cost. 

Additional features may include the ability to apply gain, or increase the volume, for the entire 

unit or for each individual output. An audio distribution amplifier used for professional audio 

installations typically uses high quality electronic components that maintain the original quality of 



the audio signal. Poorly manufactured units may add noise or unwanted distortion that could 

degrade the audio quality. 

Most distribution amplifiers are also designed to include video. Unlike audio, which can be split 

without noticeable degradation in quality, video cannot be split into two paths without the signal 

becoming unwatchable. Home theatre distribution amplifiers frequently include both audio and 

video signal paths in the same unit. 

Older units designed for analog audio have been replaced by digital models. Digital distribution 

amplifiers use digital audio protocols. As audio technology advances, so does the need 

to bundle outputs from a single or monophonic audio channel, to multiple audio channels. 

 

 

 

 

 

 

 

 

 

8. DIGITAL AUDIO RECORDER 

It is a device that converts sound, such as speech and other sounds, into a digital file that can be 

moved from one electronic device to another, played back by a computer, tablet or smart phone 

and stored like any other digital file. Using the proper software tools, digital audio can also be 

enhanced and edited like any other digital file. 



All compact audio recording devices use flash memory. Some of them use various types of 

removable memory but some are limited to the built-in memory. Generally, digital audio recorders 

have both built-in memory and the ability to store files on flash memory cards. Most of the audio 

recorders have a capacity to record a whole days worth of recording time. One important feature 

that is absolutely necessary is the ability to connect the device to a computer to transfer audio files. 

This feature is present in nearly all the current digital audio recorders, but some may lack this 

feature. 

 

 

 

 

 

Portable Digital Audio recorders 

Audio Quality 

There are several common file formats for storing audio recordings. The initial distinction is 

between devices designed to record music and those aimed primarily at an audio market. It may 

seem obvious that a device designed to record music would work well with voice recording. That 

may be true, but not necessarily. Some voice recording devices are designed to block out ambient 

noise which may make for poor music recording quality especially in a live concert. The Digital 

Audio Recorder supports MP3 file format. 

Some of the other formats are: 

 WAV — waveform audio file a standard for IBM and Microsoft 

 AIFF – Audio Interchange File Format developed by Apple 

 AU — AU audio file format developed by Sun Microsystems. 

For most audio only applications, MP3 files are sufficient. 
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9. DIGITAL AUDIO WORKSTATION 

A digital audio workstation (D.A.W.) is an electronic device or computer software 

application for recording, editing and producing audio files such as songs, musical pieces, human 

speech or sound effects. DAWs come in a wide variety of configurations from a single software 

program on a laptop, to an integrated stand-alone unit, all the way to a highly complex 

configuration of numerous components controlled by a central computer. Regardless of 

configuration, modern DAWs have a central interface that allows the user to alter and mix 

multiple recordings and tracks into a final produced piece. 

 

 

 

 

 

 

Music production using a digital audio workstation (DAW) with multi-monitor set-up DAWs are 

used for the production and recording of music, radio, television, podcasts, multimedia and nearly any other 

situation where complex recorded audio is needed. 

Integrated DAW 

An integrated DAW consists of a mixing console, control surface, audio converter, and data 

storage in one device. Integrated DAWs were more popular before commonly available personal 

computers became powerful enough to run DAW software. As computer power and speed 

increased and price decreased, the popularity of costly integrated systems with console 

automation dropped.  
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An integrated DAW consisted of: a control screen, 48-track digital mixer integrated on hard disk 

recorder including data storage and audio interface. 

DAW Software 

"DAW" can simply refer to the software itself, but traditionally, a computer-based DAW has four 

basic components: a computer, a sound card or audio interface, digital audio editor software, and 

at least one input device for adding or modifying data. This could be as simple as a mouse (if no 

external instruments are used) or as sophisticated as a piano-style MIDI
2
 controller keyboard or 

automated fader board for mixing track volumes. 

The computer acts as a host for the sound card/audio interface, while the software provides the 

interface and functionality for audio editing. The sound card/external audio interface typically 

converts analog audio signals into digital form, and digital back to analog audio when playing it 

back; it may also assist in further processing of the audio. The software controls all related 

hardware components and provides a user interface to allow for recording, editing, and playback. 

Computer-based DAWs have extensive recording, editing, and playback capabilities (some even 

have video-related features). For example, musically, they can provide a near-infinite increase in 

additional tracks to record on, polyphony, and virtual synthesizer or sample-based instruments to 

use for recording music. A DAW with a sampled string section emulator can be used to add string 

                                                           

MIDI (/ˈmɪdi/; short for Musical Instrument Digital Interface) is a technical standard that 

describes a protocol, digital interface and connectors and allows a wide variety of electronic 

musical instruments, computers and other related devices to connect and communicate with one 

another. 

https://en.wikipedia.org/wiki/Help:IPA_for_English
https://en.wikipedia.org/wiki/Technical_standard
https://en.wikipedia.org/wiki/Communications_protocol
https://en.wikipedia.org/wiki/Digital_electronics
https://en.wikipedia.org/wiki/Electrical_connector
https://en.wikipedia.org/wiki/Electronic_musical_instrument
https://en.wikipedia.org/wiki/Electronic_musical_instrument
https://en.wikipedia.org/wiki/Computer
https://en.wikipedia.org/wiki/File:TASCAM_X-48.jpg


accompaniment "pads" to a pop song. DAWs can also provide a wide variety of effects, such as 

reverb, to enhance or change the sounds themselves. 

Simple smart phone-based DAWs, called Mobile Audio Workstation (MAWs), are used (for 

example) by journalists for recording and editing on location.  

 

A 

screenshot of a typical software DAW (Adobe Audition). 

Common Functionality  

As software systems, DAWs are designed with many user interfaces, but generally they are based 

on a multitrack tape recorder metaphor, making it easier for recording 

engineers and musicians already familiar with using tape recorders to become familiar with the 

new systems. Therefore, computer-based DAWs tend to have a standard layout that includes 

transport controls (play, rewind, record, etc.), track controls and a mixer, and a waveform display. 

Single-track DAWs display only one (mono or stereo form) track at a time. The term "track" is 

still used with DAWs, even though there is no physical track as there was in the era of tape-based 

recording. 

Multitrack DAWs support operations on multiple tracks at once. Like a mixing console, each track 

typically has controls that allow the user to adjust the overall volume, equalization and stereo 

balance (pan) of the sound on each track. In a traditional recording studio 

additional rackmount processing gear is physically plugged into the audio signal path to add 



reverb, compression, etc. However, a DAW can also route in software or use software plug-in (or 

VSTs) to process the sound on a track. 

DAWs are capable of many of the same functions as a traditional tape-based studio setup, and in 

recent years have almost completely replaced them. Modern advanced recording studios may have 

multiple types of DAWs in them and it is not uncommon for a sound engineer and/or musician to 

travel with a portable laptop-based DAW, although interoperability between different DAWs is 

poor. 

Perhaps the most significant feature available from a DAW that is not available in analog 

recording is the ability to 'undo' a previous action, using a command similar to that of the "undo" 

button in word processing software. Undo makes it much easier to avoid accidentally permanently 

erasing or recording over a previous recording. If a mistake or unwanted change is made, the undo 

command is used to conveniently revert the changed data to a previous state. Cut, Copy, Paste, and 

Undo are familiar and common computer commands and they are usually available in DAWs in 

some form. More common functions include the modifications of several factors concerning a 

sound. These include wave shape, pitch, tempo, and filtering. 

Commonly DAWs feature some form of automation, often performed through "envelopes". 

Envelopes are procedural line segment-based or curve-based interactive graphs. The lines and 

curves of the automation graph are joined by or comprise adjustable points. By creating and 

adjusting multiple points along a waveform or control events, the user can specify parameters of 

the output over time (e.g., volume or pan). Automation data may also be directly derived from 

human gestures recorded by a control surface or controller. MIDI is a common data protocol used 

for transferring such gestures to the DAW. 

MIDI recording, editing, and playback is increasingly incorporated into modern DAWs of all 

types, as is synchronization with other audio and/or video tools. 

 

PLUG-INS 

There are countless software plugins for DAW software, each one coming with its own unique 

functionality, thus expanding the overall variety of sounds and manipulations that are possible. 

Some of the functions of these plugins include distortion, resonators, equalizers, synthesizers, 

compressors, chorus, virtual amp, limiter, phaser and flangers. Each have their own form of 

https://en.wikipedia.org/wiki/Automation
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https://en.wikipedia.org/wiki/Controller_(computing)


manipulating the sound waves, tone, pitch, and speed of a simple sound and transform it into 

something different. To achieve an even more distinctive sound, multiple plugins can be used in 

layers, and further automated to manipulate the original sounds and mold it into a completely new 

sample. 

10.  LAUNCHING THE SOFTWARE 

For recording purpose we will use software called Adobe Audition. For launching you can simple 

double click the icon of Adobe Audition on your computer desktop. 

 



It will open adobe audition on your computer screen. 

 

 

 

Screen shot of Adobe Audition 3. 

A: Title Bar B:Menu Bar C: Main Window D:Files Window E: Tool Bar F:Multitracks 

G: Workspace Menu,H: Status Bar,I:Other different menu 

 

Defining Different Panel 

Workspace It is present on the right upper corner of the main window. When you click 

workspace, you can see Edit View (Default), Multitrack View (Default), CD View (Default). You 

can chose here view for your file, in which you want to work. Different views have their related 

options and panels. You can define your own workspace and save it to your hard disk. Next time 

you want to work with your own workspace you can load it from this menu. 

H 
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In below picture you can see Title, Menu and Tool Bars 

 

Main Panel in adobe audition. 



Armed Multitrack Panelready for recording the two tracks with different inputs. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Side Panel with loaded files views, effects and favourite menus.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Window menu is very important in menu bar. When you click a drop down menu display, from 

where you can show or hide different panels like Tools, Mixer, Files, Effects etc. on the 

workspace. 

 

 

 

 



11. HOW TO RECORD WITH ADOBE AUDITION 

Steps involved in recording an audio are as below. 

Step 1: Materials 

What you'll need for this is: 

 A microphone 

 A Computer 

 Adobe Audition 

Step 2: Recording 

First things first, you need to open a new multitrack. Click File>New Session. 

 

A 

new window will open asking you sample rate for the new file you want to create.  

 



Just give an input for example for audio cd quality select 44100. As you select sample rate and 

click ok it will open a new multitrack project with at least 6 tracks open simultaneously to work 

with. 

 

Now that you have your project open you'll need to arm your track to record. To arm it click the R 

as shown in the pictures above. 

You can have all of the tracks armed at once, which will record on all the tracks. 

 



When you click R on the track it will open a new window to save the project. Assign a name to 

your multitrack project and select the location where you want to save the file. Make sure you 

chose a file name which can be easily remind you or understand you the project in future. 

 

Once you armed the track, it is ready to be recorded on. Click the red recording button on the 

bottom of your screen as shown below.  

 



Now that the track is recording, the track will turn red, and whenever you speak or it detects audio 

it will show the sound. The larger the sound bars the louder the sound. 

 

To stop recording simply press the stop button found on the same panel as the record button. 

Once you've pressed the stop button the track will go from red to green. From here you can play 

and review your clip, and make any changes you think are necessary. 

 

 

 



After making your changes, or if you're happy with what you recorded originally, you should save 

it. Click File>Save Session. That’s it. You have recorded your first file. 

Now that you have saved your work, the next step is editing and exporting the project in your 

desired format. Which you will learn in next units. 

 

  



SELF ASSESSMENT QUESTIONS 

WRITE TRUE / FALSE 

1. Audio recordings come in two basic types; analog and digital.   

2. CDs and Mp3 files are examples of digital mediums.     

3. Vinyl record is an example of digital record.      

4. Bandwidth is the ability of a recorded signal to be reproduced at varying degrees of 

resolution.          

5. The signal may be stored as zero and one on a phonograph record.   

6. Emile Berliner invented Phonograph in 1877.      

7. Thomas Edison invented Gramophone in 1997.     

8. The Magnetophone led to the development of multitracking.    

9. The sampling rate controls how many samples are taken per second.  

10. CD quality equals 44,100 samples per second.      

11. Solid State portable recorder uses hard disk.      

12. Single-channel recording is known as monaural or mono recording.    

13. Analogue recording has now almost completely replaced digital recording.  

14. A device or algorithmic function that performs quantization is called a quantizer. 

15. The steps in the recording process may vary from project to project.   

16. Mic placement is how you position your microphones in relation to the voice. 

17. Mastering means the process of editing.      

18. Replication is the first step in recording process.     

19. Signal distribution is done by an "audio distribution amplifier".   

20. All compact audio recording devices use flash memory.    

21. The digital audio recorder does not support mp3 format.    



22. .wav, .aiff and .au are video formats.       

23. An integrated DAW consists of a mixing console, control surface, audio converter, and 

data storage in one device.        

24. The term "track" is still used with DAWs.      

25. DAW stands for Dual Audio Workstation.      

26. MIDI stands for Musical Instrument Digital Interface.    

27. Adobe Audition is the only software for digital audio recording.   

28. Microphone is not a necessary item in studio recording.    

29. Sample rate for CD quality is 44100.       

30. In adobe audition you first arm the track to record.     

SHORT ANSWERS. 

1. Define Analog and Digital audio? 

2. What is Fidelity? 

3. Explain the difference between an analog and digital recording? 

4. What is an audio bandwidth, give an example? 

5. Explain Signal to Noise Ratio? 

6. Give three examples of analog recording technology. 

7. Who and When invented the Phonogragh? 

8. How the conversion from analog to digital and digital to analog is done in digital 

recording? 

9. Define sample rate and sample precision? 

10. What are the four basic types of Digital Recorders and explain? 

11. How many types of audio inputs used in recordings? 

12. Explain the two types of audio channels. 



13. How many basic types of file formats are? 

14. Explain recording levels. 

15. Define manual level control and limiter. 

16. Give short brief about sampling. 

17. What basic steps involved in recording process? 

18. If Mic placement is important in recording process then explain why? 

19. Explain in your words that editing is important after recording. 

20. Explain the process of Mixing an audio. 

21. What is Replication? 

22. Define Signal Distribution Process. 

23. Give a short brief about digital audio recorder. 

24. Define Digital Audio Workstation and its types. 

25. Which three default views in Workspace of Adobe Audition? 

ANSWER KEY TRUE / FALSE 

1. True   

2. True 

3. False 

4. True 

5. False 

6. False 

7. False 

8. True 

9. True 

10. True 

11. False 

12. True 

13. False 

14. True 

15. True 

16. True 

17. False 

18. False 

19. True 

20. True 

21. False 

22. False 

23. True 

24. True 

25. False 

26. True 

27. False 

28. False 

29. True 

30. True 
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INTRODUCTION 

 

Editing audio digitally offers a multitude of possibilities for manipulating sound. From getting rid 

of unwanted noises to sonically reshaping a recording beyond any recognisable form to the 

original, editing can be a very powerful tool. If you tune into a radio show, or play a music CD, 

what you hear will have been extensively edited. Beginning to edit audio files can be a daunting 

task and it is worth taking a little time to get familiar with the basics. Editing is a skill and 

improves with practice. Tasks that seem to take a long time will quickly speed up once you 

regularly work with digital audio. 

When you import audio files into your editing software they can be cut and separated into regions 

and moved around within an arrangement. When you are happy with the arrangement of all the 

regions, have finished editing and done all the necessary mixing, you will then be ready to render 

the arrangement into a final audio file. 

Editing tool (Software) playing an important role for editing the audio project. Computer aided 

recording/editing requires software for the computer which is dedicated for the studio. There are 

few single/multi channel editing software tools available in the market. Adobe Audition is mostly 

used for professional audio recording/editing. 

When we called interface it means the essential components which helps to communicate the audio 

signal. Sound card is an integral part of studio hardware. Sound card could be internal or external. 

There are different processes in a software (Editing tool). Processes are used according to the 

project or according to the requirement. Utilisation of software tool is an important factor for any 

audio project. 

It is important to edit your audio project in different scenarios to make your audio productions in a 

professional way by using the built-in tools like, the trim tool, the scissor tool, sound bite handling 

etc. 

  



 
 

 

OBJECTIVES 

After reading this unit the students will be able to:  

 

1. It will provide the students a practical professional knowledge for their professional carrier. 

2. This course leads the maximum practical skills for those professional students who 

made their future in the field of audio broadcasting having the knowledge of any audio 

editing as a project. 

3. This is digital era and the audio productions completely deal with the digital technology as 

the audio productions are the computer aided productions. 

4.  After the completion of this task the students will be able to handle any type of audio 

production as a project for their best performance in the field of audio productions. 

 

 

 

 

 

 

 

 

 

 

 

 



 
 

1. LAUNCHING THE SOFTWARE 

 

How to Install and Activate Adobe Audition 

Step 1 

Double click the installer 

 

 
 

 



 
 

Step 2 

Run the installation. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Step 3 

Give the serial number. After completing the installation, you will be told to activate it within 30 

days. 

 



 
 

Step 4 

Choose "more activation options" and then choose "activate by phone". You will be asked to give 

an authorization code. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Step 5 

 

Load adobe audition 2.0 after the preceding steps are completed. Now you are ready to make your 

professional recordings, mixings and mastering. Enjoy. 

 

2. TOUR OF THE INTERFACE 

Audio Interfaces 

What is an audio interface? 

An audio interface is a piece of hardware that expands and improves the sonic capabilities of a 

computer. Some audio interfaces give you the ability to connect professional microphones, 

instruments and other kinds of signals to a computer, and output a variety of signals as well. In 

addition to expanding your inputs and outputs, audio interfaces can also greatly improve the sound 

quality of your computer. Every time you record new audio or listen through speakers and 



 
 

headphones, the audio interface will reproduce a more accurate representation of the sounds. 

They’re an absolutely essential component in computer-based audio production. They’re used for 

recording music and podcasts, and in video post production for recording voice-overs and sound 

design. 

 

 

 

 

 

 

 

 

Why would I use an audio interface? 

Audio interfaces are used when more a professional level of audio performance is required from a 

computer, and when one or more professional microphones, instruments and other kinds of 

signals need to be routed into or out of a computer. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 
 

How is an audio interface different from a sound card? 

When an audio interface is used with a computer, it acts as the computer’s sound card. In this sense, 

an audio interface is very similar to a consumer sound card. However, the similarities end there. A 

good audio interface not only enables you to connect an assortment of different analog and digital 

signals, it also provides a more accurate digital clock and superior analog circuitry that improves 

the overall sound quality. You can achieve an entirely different level of audio than you would by 

just using the stock sound card that comes with a computer. 

How does an audio interface connect to my computer? 

 

Some audio interfaces connect to computers through common USB ports, while others use more 

esoteric connections like PCMCIA slots. When you’re choosing an audio interface, it’s very 

important to determine the specific kind of port that’s available on your computer. This will help 

you find an audio interface that will be compatible with your computer, and narrow down the 

number of possible models from which you can choose. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 
 

There are lots of audio interfaces available that connect through the USB 1.0 and USB 2.0 ports. 

There are also many audio interfaces that connect through FireWire ports. If you’re using a 

notebook computer, there are interfaces available that connect through various kinds of Express 

Card slots, and if you’re using a desktop computer, there are models that connect through a variety 

of PCI card slots. If you know what kind of port you’re going to use on your computer, you can 

start shopping for the ideal audio interface to suit your needs. 

 

 

 

 

 

 

Which one is the best port to use to connect an audio interface to a 

computer? 

This depends on your specific needs. If you plan on tracking and overdubbing with multiple 

microphones or instruments simultaneously, you’re better off using a high-speed port such as 

FireWire. If you don’t plan on recording with more than two microphones at a time, you’ll 

likely be fine just using a USB 1.0 interface. The more demanding your needs, the higher the 

bandwidth of an interface you’re going to need. The hierarchy of interface bandwidth speeds 

from lowest to highest goes from: USB 1.0, USB 2.0, FireWire, PCMCIA/Express Card, PCI. 

 

 

 



 
 

How many inputs and outputs am I going to need on my audio interface? 

That depends entirely on the kind of work you want to do with your audio interface. If you plan on 

recording with multiple professional microphones, you need to look for an audio interface with 

multiple XLR microphone inputs. If you’re going to be recording voice-overs for video production, 

you may need an audio interface with only a single XLR input. If you’re going to DJ with a 

computer, it’s a good idea to choose an audio interface with four line-level outputs (two outputs are 

used to send your stereo mix to the house sound system, the other two outputs are used to privately 

cue songs). 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

What features does an audio interface need in order to connect professional mics? 

If your primary need is the ability to connect microphones to a computer, you should look for an 

audio interface with XLR microphone inputs. Professional microphones connect with three-pin 

XLR jacks. XLR connectors are desirable because they lock into place and provide a more secure 

audio connection. An audio interface outfitted with microphone inputs will typically come with 

anywhere from one to eight XLR inputs. 

Many audio interfaces come with jacks called “combo” inputs. This kind of jack combines a three 

pin XLR input with a 1/4” TRS input in one socket. Combo inputs tend to confuse people, because 

they look different than XLR and 1/4” TRS inputs, yet they accept both kinds of plugs. It’s 



 
 

important to familiarize yourself with combo inputs, so you know what they are when you’re 

deciding which interface to purchase. 

 

 

 

 

 

 

 

 

 

What is “Phantom Power” and why would I need it? 

Some microphones require a little flow of electricity in order to operate, while other kinds of 

microphones are capable of picking up sound without any power at all. Certain kinds of 

microphones run on batteries, while other kinds of microphones are fed power from the device that 

they’re plugged into. It’s called “phantom power” when the device that the microphone is plugged 

into supplies it with electricity. Most audio interfaces that feature mic inputs will also supply 

phantom power. Because only certain kinds of microphones require phantom power, audio 

interfaces have a switch to turn it on and off. Phantom power tends to intimidate beginners because 

it just sounds spooky. Fear not. Using phantom power is about as complicated as flipping a light 

switch to turn on a table lamp. Besides being called phantom power, it is also referred to as 

“+48V.” 



 
 

What are line-level TRS inputs and outputs, and why would I need them? 

 

Line-level inputs and outputs can be very useful; however, to use them properly you must first 

understand the distinction between mic-level and line-level. Microphones output a very weak 

signal. The signal is so weak that it needs to be boosted up by a preamp when connected to a mic 

input. Line-level audio signals are much stronger than mic-level signals, and require no additional 

amplification. Therefore, line-level signals need a different kind of input than microphones do. 

Line-level inputs and outputs on audio interfaces usually show up as 1/4” TRS jacks or 1/4" TS 

jacks. 1/4” is the diameter of the plug and TRS stands for Tip, Ring and Sleeve; TS for Tip, Sleeve. 

TRS connections are desirable because they provide a balanced (grounded) connection, which is 

better at rejecting noise that long cable runs can pick up, or reducing "ground" hum. An example of 

when you would use line-level inputs is when you’re recording the audio from a keyboard. Most 

professional keyboards have stereo line-level outputs. You can connect these directly to the line-

level inputs on an audio interface. When you’re connecting studio monitors (powered speakers) to 

an audio interface, you plug them into the line-level outputs. You can also use line-level inputs and 

outputs to connect external effects, compressors, limiters and all kinds of stuff. Other connectors 

include 3/8" mini and RCA (phono) connectors. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 
 

What are MIDI ports, and are they important to me? 

MIDI ins and outs are found on many audio interfaces. They allow you to send MIDI information 

into and out of a computer. If you’re not familiar with MIDI, just think of it as a simple language 

that enables pieces of music-oriented hardware to communicate with each other. For example, if 

you connect the MIDI Out of your audio interface to the MIDI In on a digital piano, you can send a 

command from your audio software on your computer that tells the digital piano to play a C flat. 

 

People use MIDI ports for all kinds of things. Like in the example mentioned previously, they’re 

often used to connect external MIDI instruments. You could create a MIDI sequence on a 

synthesizer, and then bring this sequence into your audio software with the MIDI interface on your 

audio interface. The beauty is that the MIDI sequence is just a series of commands, so when you 

record it into your DAW you can completely change it and turn it into something new. MIDI ports 

are also used to connect hardware control surfaces, keyboard controllers and a wide range of other 

equipment and devices. 

 

 

 

 

 

 

 

What are S/PDIF connectors, and why would I need them? 

 

S/PDIF is simply a digital audio format. Just think of it as a digital version of an analog audio 

connection. S/PDIF stands for Sony/Phillips Digital Interconnect Format. One of the reasons 

S/PDIF tends to confuse people is that it’s used on different kinds of jacks. The most common kind 

of S/PDIF connector is a coaxial jack. Unfortunately, this just adds another layer of confusion, 

because a digital coaxial jack looks exactly like a common analog RCA phono jack. It gets more 

confusing because a single analog RCA jack can only pass a mono audio signal, while a single 

coaxial S/PDIF jack can pass a stereo signal. If you weren’t confused enough, the S/PDIF format 



 
 

can also be sent through optical TOSLINK connectors, which look nothing at all like coaxial RCA 

jacks. 

The good news is that you don’t have to worry about any of this stuff. S/PDIF connectors are found 

on many audio interfaces, and they can be really useful. S/PDIF jacks usually come in pairs, with 

one for input and the other for output. In order to put them to use, you just need other equipment 

with S/PDIF input and outputs to connect to them. For example, using S/PDIF inputs and outputs is 

a common way to connect external effects modules. 

 

 

 

 

 

 

 

 

 

What is “Direct Monitoring,” and is it something I should have? 

 

Any time you record sound into a computer with an audio interface, you are going to experience 

some degree of “latency.” If you’re not familiar with latency, think of it as the delay in time from 

the moment you make a command until the moment your command is carried out. If you strike a 

bell with a mallet, you will hear the sound of the bell ringing instantly. However, when you need to 

pipe commands through a computer, things don’t happen as immediately. 

 

When you plug a microphone into an audio interface and say “Check 1-2-3,” that sound has to 

travel on a long journey before you can hear it in your headphones: 

 

The sound is picked up by the capsule in the mic;  

Then it is sent through the mic cable into the audio interface; It’s converted into digital audio and 

sent to the computer; 

 



 
 

The computer routes the digital audio to the DAW audio software; The audio software receives, 

processes and sends it back out; The digital audio travels back to the audio interface; 

 

The audio interface converts the digital audio back into analog and sends it out to the headphones. 

That’s a pretty long trip just so you can hear “Check 1-2-3” in the headphones, right? The resulting 

latency can sometimes distract musicians and make it difficult for them to perform. This is where 

the direct monitor knob comes in. When you use direct monitoring, you hear the analog audio that 

is being plugged directly into the interface, as opposed to hearing it after it’s been sent out to the 

computer and back. This nearly eliminates the latency, and makes the musician happier. Direct 

monitoring is usually only found on USB 1.0 audio interfaces, because their slower speed makes 

them more latency prone. Unfortunately, this functionality isn’t referred to as “direct monitoring” 

by every manufacturer. Some interfaces have direct monitoring controls, but call it by another 

name. If you see a USB 1.0 interface with a knob that has “mix” on one side and “computer” on the 

other, then it has a direct monitoring feature. 

 

 

 

 

 

 

 

 

 

 

 

 

 

What accessories should I get for my audio interface? 

Audio interfaces often serve as the heart of a recording studio. Most of the essential tools used in a 

studio will be connected to the interface directly and indirectly. Of them all, powered studio 

monitors tend to be the most common tools used with audio interfaces. The cables will vary in 



 
 

length, depending on your setup, with terminations that are appropriate for each item. These might 

be ¼” TS to ¼’ TS, ¼” TRS to ¼” TRS, ¼” TRS to XLR, XLR to XLR, etc. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

With powered monitors in place, you’ll be able to properly hear what you’re working on. When 

you need to monitor your work privately, a good pair of studio headphones is an essential tool. 

 

 

 
 



 
 

 

 

 

 

 
 

 

 

 

 

The need to plug professional-quality microphones into a computer is the most common reason 

people purchase audio interfaces. Naturally, having a few good studio microphones to use with 

your audio interface is a good idea. Mix it up and buy a variety of mics. 

 

Having a solid dynamic microphone is a great place to start. Adding a large diaphragm condenser 

microphone will really expand your sonic palette and let you make good use of your phantom-

power switches. Small diaphragm condenser microphones are really great for capturing cymbals 

and various instruments. And a ribbon mic will round out your mic collection with its ability to 

capture smooth mid frequencies. 

 

 

 

 

 



 
 

The cable that you use to connect the microphone to the interface can make a difference. Spending 

a little more on a nicely made XLR cable usually proves to be a wise long-term investment 

(providing that you don’t abuse it too much). 

 

 

 

 
 

 

 

 

 

 

 

 

 

 

The Takeaway 
 

 Audio interfaces expand and improve the sonic capabilities of a computer. 

 They add inputs and outputs and can improve the sound quality of your computer. Audio 

interfaces are an absolutely essential component in computer-based audio production. 

 Audio interfaces let you plug pro mics, instruments and other signals into a computer. 

 When an audio interface is used with a computer, it can act as the computer’s sound 

card. 

 When choosing an audio interface, it’s important to determine the specific port that’s 

available on your computer for its use. 

 Audio interfaces connect through USB 1.0, USB 2.0, FireWire, PCMCIA/ExpressCard 

and PCI. 

 Professional microphones connect with three-pin XLR jacks. 



 
 

 “Combo” inputs combine a three-pin XLR input with a 1/4” TRS input in one 

socket. 

 Phantom power is a little flow of electricity that powers condenser 

microphones. 

 1/4" TRS connections provide a balanced connection, which can provide 

cleaner-sounding audio. 

 MIDI enables music-oriented hardware components to communicate with one 

another. 

 Just think of S/PDIF jacks as a digital version of an analog audio connection. 

 ADAT ports are capable of passing eight independent channels of digital 

audio. 

 Word Clock sync is not the same thing as SMPTE time code sync. 

 Latency can distract musicians and make it difficult for them to perform. 

 

3. EXPLORING THE PRINCIPLES OF EQUALIZER 

 

Principles of Equalization 

Equalization 

An equalizer, in its broad description, allows you to boost or cut the volume of specified 

frequencies. During the mix, equalization can be effectively used in different ways to correct 

problems that were created during the recording session or from incompatibility among 

instruments. Equalization can also be used in a creative way in order to produce original effects. 

 

No matter which way you are going to use an equalizer, there are few notions and concepts that 

you should know before beginning an equalization session. First, equalizers are generally used as 

inserts on the channel and not as auxiliary sends. Next, you have to be familiar with the most 

used types of equalizers in a digital audio workstation setting. Among the several types of 

equalizers available nowadays there are five main categories that have proven to be the most 

useful in a mixing situation: peak, high shelf, low shelf, high pass and low pass. Table 1 is a list 

of each equalizer’s description, parameters and common uses. In Figure 1 you can see the 

symbols with which they are usually indicated. 

 



 
 

TYPE OF EQUALIZER 

Peak 

DESCRIPTION AND PARAMETERS 

It allows you to cut or boost frequencies around the centre frequency. Centre frequency: it 

determines the frequency to cut or boost  

Gain: positive gain boosts, negative gain cuts  

Q point: it determines the “shape of the bell” or how wide the area around the cut-off point is 

going to be: the lower the value the larger the bell and vice versa the higher the value the smaller 

the bell. The Q parameter can usually (but not always) vary from a value of 0.7 (equal to a 2 

octaves frequency range) to a 2.8 (1/2 octave) 

TYPICAL USES 

A Peak Eq. is extremely versatile. It can be used to pinpoint and cut/boost a very precise 

frequency or it can be used in a broader way to correct wider acoustic problems. It is usually 

utilized in the middle of the frequency range. 

 

TYPE OF EQUALIZER 

 

High Shelf 
 
 

DESCRIPTION AND PARAMETERS 

 

It cuts or boosts the frequency at the cut-off and all the frequencies higher than the set cut-off 

point. 

It has only two parameters: the cut-off frequency and the gain. 

TYPICAL USES 

It is usually used in the mid-high and high end of the spectrum. It can be effectively used to 

brighten up a track by using a positive gain of 3 or 4 dB and a cut-off frequency of 10 kHz and 

higher (be careful because this setting can increase the overall noisiness of the track). It can also 



 
 

be used to reduce the noise of a track by reducing by 3 or 4 dB frequencies around 15 kHz and 

higher 

 

TYPE OF EQUALIZER 

Low Shelf 

DESCRIPTION AND PARAMETERS 

It cuts or boosts the frequency at the cut-off and all the frequencies lower than the set cut-off 

point. 

It has only two parameters: the cut-off frequency and the gain 

 

TYPICAL USES 

 

It is usually used in the low-mid and low range of the audible spectrum to reduce some of the 

rumble noise caused by microphone stands and other low end sources 

 

TYPE OF EQUALIZER 

High Pass 

DESCRIPTION AND PARAMETERS 

 

It cuts all the frequencies below the cut-off point. It has only one parameter which is the cut-off 

frequency. 

TYPICAL USES 

It is a very drastic filter. It is often used to cut very low rumble noises below 60 Hz 

 

TYPE OF EQUALIZER 

Low Pass 

DESCRIPTION AND PARAMETERS 

It cuts all the frequencies above the cut-off point. It has only one parameter which is the cut-off 

frequency. 

 



 
 

TYPICAL USES 

It is a very drastic filter. It is often used to cut very high hiss noises above 18 kHz. Use with 

caution in order to avoid cutting too much high end of the track. 

 

Table 1: Characteristics and parameters of the most common types of equalizer 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 1: Conventional symbols for most common types of equalizers 

Think First 

Remember that equalization is a problem-solving procedure. This means that there's no point in 

playing around with the settings if you don’t know what you want to achieve and how the final 

result should sound. A good approach to equalization is to listen carefully to the soloed track and 

come up with a list of things you might want to improve or correct. If you are using a parametric 

EQ, the next step is to bring up the gain and sweep across the frequency range until you find the 

frequency range you want to cut or boost. After that, boost or cut as desired. 



 
 

Keep in mind that when equalizing you will have to make small adjustments every time you add 

tracks to the mix since the frequencies and respective ranges of the other instruments affect the 

way an instrument sounds. The most important concept here is to be able to emphasize the 

characteristic frequencies of the track you are working on and eliminate frequencies that do not 

enhance its sonic features in any particular way. In fact, you should be able to “carve” a small 

niche inside the audible range for each instrument and section so that it is clearly intelligible and 

not masked by other instruments. If the mix sounds muddy and cluttered you should start trying 

to focus on which instruments contribute to the clutter? Try to use the equalizer to add clarity by 

gently shifting the centre of each instrument involved so that they do not overlap with each other. 

As a general rule it is always better to cut than to boost, mainly because the human ear is more 

used to a reduction than to an augmentation in intensity of frequencies. 

While it is hard to generalize, there are a few common settings that are useful to use as a starting 

point during an equalization session. That summed up in Table 2. 

 

FREQUENCIES 

20-60 Hz 

APPLICATION 

- Cut to reduce rumble and noises related to electric interferences 

COMMENTS 

It is a good idea to always reduce by 4 to 6 dB this area in order to lower the low 

frequencies noise 

FREQUENCIES 

60-80 Hz 

APPLICATION 

-  Boost to add fullness to low frequency instruments such as bass and bass drums 
 

FREQUENCIES 

100-200 Hz 
 

APPLICATION 

- Boost to add fullness to guitars, French horns, trombones, piano, snares 
 



 
 

- Cut to reduce “boomy” effect on mid-range instruments  

 

COMMENTS 

This frequency range effectively controls the powerful low-end of a mix 

FREQUENCIES 

200-300 Hz 
 

APPLICATION 

- Cut to reduce low and unwanted resonances on cymbals 
 

- Boost to add fullness to vocal tracks 
 

COMMENTS 

Be careful not to boost too much of this frequency range in order to avoid adding 

muddiness to the mix 

FREQUENCIES 

400-600 Hz 

APPLICATION 

- Cut to reduce unnatural “boxy” sound on drums 
 

- Boost to add presence and clarity to bass  

COMMENTS 

This frequency range can also be effective to boost the low range of the guitar 

 

FREQUENCIES 

1.4-1.5 kHz 

APPLICATION 

 

- Boost for intelligibility of bass and piano 

 

 

 



 
 

FREQUENCIES 

2.8-3 kHz 

APPLICATION 

 

- Boost to add clarity to bass 
 

- Boost to add attack and punch to guitars  
 

COMMENTS 

This range can also be used effectively to add clarity on vocal parts 
 

FREQUENCIES 

5-6 kHz 

APPLICATION 

- Boost for vocal presence 
 

- Boost for attack on piano, guitars and drums 

 

COMMENTS 

A general mid-range frequency area to add presence and attack. 

FREQU

ENCIE

S 7.5-9 

kHz 

APPLICATION 

- Cut to avoid sibilance on vocal and voice 
 

- Boost to add attack on percussions 
 

- Boost to add clarity, breath and sharpness to synthesizers, piano and guitars 



 
 

 
 

COMMENTS 

A mid-high range area that controls the clarity and the attack of the mid-high range instruments 

 

FREQUENCIES  

10-11 kHz 

APPLICATION 

 

- Boost to increase sharpness on cymbals 
 

- Boost to add sharpness on piano and guitars 
 

- Cut to darken piano, guitars, drums and percussions  
 

COMMENTS 

High range section that affects clarity and sharpness 

 

FREQUENCIES 

 14-15 kHz 

APPLICATION 

- Cut to reduce sharpness on cymbals, piano and guitars 
 

- Boost to add brightness on vocals 
 

- Boost to add real ambience to synthesized and sampled patches 
 

FREQUENCIES 

18 kHz 

APPLICATION 

- Cut to reduce hiss noise 
 

- Boost to add clarity to overall mix 
 

 



 
 

COMMENTS 

A delicate high range section that should require drastic positive or negative gain settings only in 

extreme situations 

 

EQ Rules of Thumb 

 

When equalizing you must pay attention to some of the most common mistakes that sometimes 

even the seasoned engineer makes. First of all try always to keep your equalization gain parameter 

at a reasonable level. As a general rule, avoid cutting or boosting by more than 6 dB unless 

absolutely necessary. If for some reason you see that some of your EQ settings go over this limit try 

to question why and see if there is a better solution to the problem. The same can be said for 

situations where you end up boosting (or cut-ting) several frequencies at the same time that have 

the only effect of raising (or lowering) the overall volume of the track without really affecting its 

sonic content. In this case try to bypass the equalizer and experiment with volume changes instead. 

You will be surprised how much a small amount of equalization can change, and hopefully improve 

your mix. Try to hear the sound in your head that you want to achieve through equalization and 

avoid playing around with the parameters trying to “find” the perfect sound. Leave luck for Las 

Vegas 

 

4. USING THE COMPRESSOR 

Compression is the process of lessening the dynamic range between the loudest and quietest parts 

of an audio signal. This is done by boosting the quieter signals and attenuating the louder signals. 

Effective Ways to Use Compression 

Amplitude compression can be one of the most confusing effects for audio engineers. 

For some engineers, compression can seem complicated and intimidating. The processing by a 

compressor depends on many factors including the threshold, ratio, attack time, release time, and 

knee. 

On some compressors these factors can be set by an engineer, while on other compressors these 

factors are fixed. For some engineers, it may not even be intuitive as to why these controls are 

helpful to use when performing amplitude compression. 



 
 

On top of all that, there is more than one way to use a compressor. From subtle dynamic range 

reduction to extreme tone shaping, a compressor can have several, dramatically different purposes 

in a mix. This is why it is so important to have all the different controls of a compressor, or at least 

be able to select the compressor with the correct fixed settings. 

I have heard from many engineers that have had similar experiences with compressors. They think, 

“Let’s see if a compressor can add anything to this track.” After routing the track through the 

compressor, they arbitrarily adjust parameters until they stumble upon a desired sound or they give-

up and stop using the compressor. This can make the use of a compressor very time consuming. 

As much as I wish I could say, “There is no wrong way to use a compressor,” nothing could be 

further from the truth. Unfortunately, there are many ways to use a compressor incorrectly. 

In fact, the incorrect use of a compressor is one of the fastest ways to ruin a mix. For this reason, it 

is my recommendation to compress with a purpose. In other words, only use a compressor when 

you have a specific reason. Whether you are trying to solve a problem in your mix or add a textural 

effect to your mix, you should be able to quickly choose which compressor to use and what settings 

to start with. 

 

Here are five basic “starting points” for a compressor and their corresponding purpose. 
 

1) Taming Transients: Fast Attack + Fast Release + High Threshold" 

 

 

 

 

 

 

 

 

 

 

 

 

Conventional downward compressors detect when a signal’s amplitude is higher than a threshold, 

and then respond by reducing the amplitude of the signal. 



 
 

By using a fast attack time and a fast release time, the compressor will respond almost 

instantaneously when a signal’s amplitude crosses the threshold. 

Therefore, gain reduction will primarily be applied only when the signal’s amplitude is above the 

threshold. When the amplitude drops below the threshold, gain reduction will not be applied. 

If the threshold is set so that only the attack of a signal triggers the compressor, then these settings 

on a compressor can be used to tame the transients of a signal and also help pre-vent a signal from 

clipping. 

The threshold can be adjusted to change how much of the transient is changed. Lowering the 

threshold and increasing the ratio will squash more of the transient, resulting in a higher relative 

amplitude for the note’s sustain. Extreme settings with this technique work well in parallel 

compression. 

This technique works well with an 1176 compressor. The field effect transistor circuit of the 

compressor means that it can respond very quickly. This technique is great for controlling the attack 

of drum hits and plucked/strummed notes on a guitar. 

This transient tamer technique can be used to perceptually push an instrument back in a mix 

because the attack does not cut through as much. 

 

2) Enhancing Transients: Medium attack + Synchronized release + High 

Threshold 

 

 

 

 

 

 

 

 

 

The complement of the transient tamer is the transient enhancer. 

 



 
 

Rather than using the compressor to reduce the amplitude of the signal’s attack, the compressor can 

be used to reduce the amplitude of the signal’s sustain. 

The threshold should still be set so that gain reduction is triggered only by the transient. However, 

the attack time should be increased so that gain reduction is delayed until after the attack passes 

through the compressor. By delaying the gain reduction, the sustain of the signal will be reduced. 

With this technique, the compressor’s release can be set so that gain reduction continues until the 

start of the next note. 

Therefore, the release time should be set to be synchronized with the notes of the instrument and 

groove. If a snare drum is playing on the 2-4 backbeat, gain reduction of the previous note should 

return to 0 dB just as the next note is played. 

 

This technique is great for drums, bass, guitar, piano, and anywhere else you want to sharpen the 

instrument’s attack. Changing the compressors ratio from low settings (2:1) to high settings (8:1) 

will change how much the sustain is squashed. 

To dial in these settings on a compressor, it can be helpful to use a compressor with fine control 

over the attack time and release time. 

The following is an order of operation that can be used to quickly dial in the appropriate settings 

based on your song. 

Start with fast attack/fast release and set the threshold to detect the signal’s transients. 

Slow down the release time so that the gain reduction lasts until just before the start of the next 

transient. 

Finally, slow down the attack time until you hear the transient pass through. 

There are also many compressors that have fixed settings that perform this technique automatically. 

The dbx 160 and LA-2A are examples of compressors that have a fixed attack time, which allows a 

signal’s transient to pass through. 

The dbx 160 is great for drums, while the LA-2A is great for bass. The release time of the LA-2A is 

program dependent, meaning that it will synchronize, in some ways, with the instrument’s notes 

automatically. 



 
 

On an SSL console, the compressor has a switch for the attack time. In one position the attack time 

is fast and in the other position the attack time is slower. Essentially the switch assumes that an 

engineer only needs two settings: either an attack time that will compress a transient or an attack 

time that will allow the transient to pass through. In general, this can be a helpful way to think 

about using a compressor’s attack control. Even though a variable knob can be used to set a wide 

range of attack times, it can be much simpler to ask the question, “Transient? Yes/no?” when 

choosing your attack setting. 

This transient enhancer technique can be used to perceptually push an instrument forward in a mix 

because the transient will cut through more. 

3) Transparent Dynamic Range Reduction: Low threshold + Low Ratio 

 

 

 

 

 

 

 

 

 

 

 

 

In theory, a compressor is an amplitude processor that can be used to reduce (compress) the 

dynamic range of a signal. This can be accomplished by reducing the amplitude of the parts of a 

signal that have high amplitude. 

However, a compressor can also be used to increase (expand) the dynamic range of a signal, 

accomplished with the transient enhancer technique. 

Nonetheless, many times the purpose of using a compressor is to actually reduce the dynamic range 

of a signal. With the transient tamer technique, the threshold is conventionally set so that the 

compressor only responds to the transient portion of a signal. Another technique to reduce a 



 
 

signal’s dynamic range is to set the threshold so that the compressor responds to both the transient 

and sustain portions of a signal. 

If a low ratio is used, this can be a very transparent method to reduce dynamic range. One place to 

start would be to use a ratio of 1.2:1 or 1.5:1. 

This technique requires a compressor with a variable ratio that goes down to 1:1. After the low ratio 

is set, the threshold can be reduced so that nearly the entire signal triggers the compressor. 

With this technique, the effective gain reduction for portions of the signal that are slightly above the 

threshold will be smaller than the effective gain reduction for portions of the signal that are 

significantly above the threshold. 

As an example: with a ratio of 1.5:1, if an input signal is 6 dB above the threshold, the output will 

be 4 dB above the threshold. The effective gain reduction is 2 dB. If an input signal is 15 dB above 

the threshold, the output will be 10 dB above the threshold for an effective gain reduction of 5 dB. 

Therefore, this technique is an effective way to slightly reduce the gain of low amplitude signals 

and gently reduce the gain of high amplitude signals. With such a low ratio, compressors can be 

very transparent. 

4) Lengthening Sustain: Conventional Upwards Compression 

 

 

 

 

 

 

 

 

 

 

 

 

 

The dynamic range of a signal can be reduced by decreasing the amplitude when it is above the 

threshold (downwards compression). 



 
 

Additionally, the dynamic range of a signal can be reduced by increasing the amplitude when it’s 

below a threshold. This is called upwards compression. 

This mode of operation was not typically found on analog hardware compressors. However, it is 

becoming more common on digital software compressors. 

This type of compression is helpful if your purpose is to change the amplitude of the quieter parts 

of your signal. One example would be if you would like to increase the amplitude of an 

instrument’s sustain. 

Common places to use this technique are for vocals, lead instruments, and bass. The result of 

upwards compression is a signal that has a much more consistent level. Therefore, it can help a 

vocal part stay out front of the rest of mix. It can also help make sure a bass sits in the context of a 

mix without ever getting too loud or too quiet. 

When it comes the compressor’s ratio, upwards compression uses a ratio less than 1:1. 

As an example: if the ratio is 0.5:1, this means an input signal 4 dB below the threshold will be 

increased so that the output is only 2 dB below the threshold. When actually setting the ratio for 

upwards compression, a little goes a long way. Even settings of 0.9:1 can have a significant impact. 

This type of compression is found on many software compressors including Waves Maxx-

Volume/MV2 and several iZotopeplug-ins. 

5) Upwards Compression: Downwards Compression + Gain 

 

 

 

 

 

 

 

 

 

 

 

 



 
 

Lastly, another version of upwards compression can be accomplished using a combination of 

downwards compression and make-up gain. 

Therefore, if your compressor does not have a specific setting for upwards compression, you can 

still achieve a similar result. 

Downwards compression can be used to reduce the amplitude of the signal when it is above a 

threshold. 

After downwards compression is performed, there is additional headroom to increase the gain of a 

signal without clipping. By applying a constant make-up gain, both the amplitude above the 

threshold and below the threshold will be increased. 

If performed carefully, this type of compression can actually increase the amplitude of the portions 

of a signal with low amplitude, while having almost no net change to the amplitude of the portions 

with high amplitude. 

This type of compression can be used very subtly or very dramatically. Try it both in series and in 

parallel. Experiment with this technique on everything: drums, vocals, piano, etc. 

Almost any compressor can be used with this technique. You could try “All Buttons Mode” on an 

1176 for your drum room mics, gentler settings with a CL-1B on vocals, or a Fair-child on the mix 

buss. 

Conclusion 

Compressors are one of the most versatile and powerful processors for an audio engineer to use. 

Even though there are many parameters and possible combinations of parameters, a compressor can 

be mastered for use in common mix situations. 

After learning several basic “starting points,” it is only a matter of making minor adjustments to 

make the compression more/less audible. 

When you compress, make sure you compress with a purpose. 



 
 

 

5. USING THE EFFECT GENERATOR 

An Effect changes the audio in some way. 

A Generator creates new audio, either in an existing track or in a new track. For further details 

please check this link: 

http://manual.audacityteam.org/man/index_of_effects_generators_and_analyzers.html 

 
 

6. CUSTOMIZING THE INTERFACE 

 

How to Customize VLC Media Player Interface 

When it comes to VLC, a lot is customizable in terms of the minimally present user interface. You 

can easily change where the play, pause, stop, next, previous and other video/audio control buttons 

are placed. You can also change the position of the individual buttons. Additionally, you can even 

change the position of all the control button set in-regards to where it shows up in the player. All 

you have to do is go to Tools > Customize Interface. 

From the customize interface or Toolbars Editor option you can drag the individual buttons around, 

add new buttons and remove the ones that you don’t need. You can also configure the time toolbar 

and customize the full screen buttons separately. Additional customization options in terms of the 

button sizes and designs are also available. 

Here are the detailed steps/explanations to customize your VLC Media Player Interface and 

buttons: 

To Access Toolbars Editor 

In the menu bar or via the right click menu, select Tools > Customize Interface. 

 

 

 

 

 

 

http://manual.audacityteam.org/man/index_of_effects_generators_and_analyzers.html


 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The Toolbars Editor will open. 

 

 

 

 

 

 

 

 

 

 

 

 

 

In the editor, you will see different tabs: 

 



 
 

1. Main Toolbar: This is the toolbar that is displayed when VLC is running in Window mode. 

You can change the position of the player controls to place it above the video by checking the 

appropriate box. There are two lines of controls and line 2 has the most commonly used buttons. 

2. Time Toolbar: This one allows you to customize the time toolbar that shows the position of the 

video or audio that you are currently playing. 

3. Advanced Widget: This is the advanced widget that is displayed when View > Advanced 

Controls is activated. You can place buttons that can record, cut, loop or navigate frame by frame. 

These are the buttons that aren’t frequently used. 

4. Full screen Controller: These are the controls that show up when your video is playing in full-

screen mode. You can have a different set of controls in full screen. 

Not that there is a Select profile option above everything else. This one allows you to save your 

interface configurations as profiles. You can switch between profiles to switch to different 

interfaces easily. 

 

To Edit the Interface 

Use your mouse and simply drag the buttons in the toolbar editor. 
 

Choose the tab for which you want to change the controls. 

To add new buttons drag them from the Toolbar Elements to the main toolbar, full screen 

controller, advanced widget or time toolbar. 

To edit/move the existing buttons click and hold using your mouse, and drag them to where you 

want to. 

To remove buttons just drag them outside the toolbars editor. 

Click Close to save your changes or if you messed up, click Cancel. 

See the Preview area to get an idea of what your player looks like after the changes are saved. 

Make use of the options to display the toolbar under or above the video. We are used to the 

toolbar being placed below the video but you never know whether you’d like it placed above; 

unless you try it. 

 



 
 

Note: 

If you are trying to add new buttons to the main toolbar, you’ll want to add it to line 2 because 

that’s your usual control toolbar. 

 

Make sure to create a new profile or make use of saving and retrieving using the profile feature. 

This prevents you from messing it all up. 

 

 

 

 

 

 

 

VLC Options Related to Displaying in Windows System Tray and Task Bar 

 
 

7. UTILISATION OF TOOLS 

5 Tools for Cleaning Up Audio in Adobe Audition 

Integrate Adobe Audition into your post production workflow Utilize Audition’s powerful tools 

for fixing common audio problems like back-ground noise, hum, clipping, clicks and pops. 

Noise Reduction in Audition 

Adobe Audition has powerful noise reduction tools that be accessed in the Waveform Editor. If 

you are in a Multitrack Session, double click on a track to go into the Waveform Editor. 



 
 

Click and drag to select several seconds of background/ambient only sound. The more time you 

have to sample the better your results will be. Make sure you do not select any audio with 

voices or other noises 

Go to Effects > Noise Reduction (process). Click “Capture Noise Print” and then “Select Entire 

File”. 

Click “Noise Only” to hear what you are removing (deselect it before you click apply). Click 

the green button on & off to toggle the effect as you adjust the “Noise Reduction” & “Reduce 

by” sliders. 

If you prefer shortcuts, use Shift +P to save a noise print and CMD/CNTRL/Shift + P to open 

the “Noise Reduction” Effect. I suggest making shortcuts for effects you commonly use (do this 

by accessing the shortcut editor in the menu bar, Edit >Keyboard Shortcuts). 

 



 
 

Adaptive Noise Reduction 

Adaptive Noise Reduction automatically learns what noise is, as long as you have back-ground 

noise before people start speaking. To take advantage of this tool, it is a good habit to always 

record 4-5 seconds of audio before your talent starts speaking. 

In Adobe Audition, you can also combine Adaptive Noise Reduction with other effects in the 

Effects Rack (which you can’t do with standard Noise Reduction). It is part of several presets like 

“Clean up and Level Voice-Over” that can help you get started if you are new to audio effects.

 



 
 

 

 

Remove Hum in Audition 

 

This Adobe Audition effect comes in handy if you are doing a lot of location filming where you 

can’t control the production environment. 

Use this to remove AC hum (lights, power lines, and electronics). In my example I was picking up 

hum from an Xbox 360 in the room. 

Go to Effects > Noise Reduction/Restoration >Dehummer. Select your preset based on country. 

I’m in the states so I picked 60Hz. 

 

 

 

 

 

 

 

 

 

 

 
 

 

 

 

 

 

 

 

Auto Heal & Spot Healing 

You can use Auto Heal & the Spot Healing Brush to remove clicks, pops, and other short noises 

you want to remove from your audio. 

 

 



 
 

 

Zoom in by pressing the plus key and select the pop. Right click and select “Auto Heal” 

(Comm/Control + U). 

You can also paint a selection with the spot healing brush(B) by dragging over the area to fix in 

the “Spectral Frequency” display. 

 

 

 



 
 

 

Using the Diagnostic Panel 

Access the Diagnostics panel in Audition by choosing Window > Diagnostics from the menu bar. 

The powerful diagnostic panel provides tools to fix clipping, clicks and pops in your audio. 

The Declipper is handy for repairing clipped audio. Select the DeClipper Effect in the Diagnostic 

panel. Click Scan and your clipping areas will be listed. Select a listed problem to move to it in 

the waveform. 

You can fix each one at a time or click Repair All. 

Note: Depending on your audio it may still appear clipped, as Audition works in 32 bit floating 

point. Decrease the amplitude or use Normalize to see that the audio isn’t actually clipped. I have 

had varied results with the DeClipper, so if it dozen’s fix your issues, you the manual method 

mentioned above using Auto Heal & Spot Healing Brush. 

Before: 

 

 

 

 

 

 

 

After: 

 

 

 

 

 

 

 

 



 
 

 

8. EDITING DIFFERENT AUDIO SCENARIOS 

 

 

 

 

 

 

 

 

 

 

 

 

The Trim Tool 

 

 
 

 

 

One of the most common audio editing scenarios is stripping away unwanted sound bite audio 

either side of a good take, or isolating a small vocal fragment (say) in a longer speech sound bite. 

The easiest way to do this is to edge-edit the sound bite, as I described last month, by pointing the 

mouse at the right or left boundary of the sound bite and dragging using the blue edge-edit cursor. 

Sometimes, though, if you're working with very long sound bites or are really zoomed in to the 

Sequence Editor, sound bite edges aren't visible. Edge-editing is then a hassle: you have to scroll 

forward (or zoom out) to locate the sound bite edge, drag the edge-edit, then try to get back to what 

you were doing. Surely there must be an easier way? 

DP 5's extended Tool Palette, with the Scissors tool already selected and the Trim tool about to 

be clicked. 



 
 

DP 5's extended Tool Palette, with the Scissors tool already selected and the Trim tool about to 

be clicked. 

In Digital Performer 5, there is. The Tool Palette, which you can easily open by hitting Shift-O, 

now sports four new tools, one of which is the Trim tool. As with all the other tools, it's miles 

better for workflow to select this with a keyboard shortcut rather than the mouse, and the Trim 

tool's default shortcut is the forward slash (commonly found next to the right-hand shift key). Try 

out the following: 

1. With a sound bite visible in your Sequence Editor and the Tool Palette open, hold down the 

forward-slash key. Your mouse pointer should take on the appearance of a square bracket with 

blue arrows either side — just the same as when you do a normal edge-edit. 

2. Point anywhere in your sound bite and click. The right-hand boundary of the sound bite jumps 

back to that point. You've effectively edge-edited the sound bite, but in a single click, and with no 

need to go near the right-hand sound bite edge. 

3. Hit Apple-Z to Undo your last action and get your full-length sound bite back. 

4. Now hold down the forward-slash key together with the Alt/Option key and again point at your 

sound bite. You'll notice the mouse pointer's square bracket now points in the opposite direction to 

before. 

5. Click somewhere in your sound bite and now the left-hand boundary of the sound bite jumps to 

that point. So Alt/Option-slash is like edge-editing the left-hand side of the sound-bite. 

It's worth noticing that you can actually click and drag with the Trim tool, just as if you were edge-

editing, and DP will 'scrub' the audio as you do so (with, typically, comical results). Also, if you 

have the Edit grid enabled and you hold down the Apple key while trimming, the trim will be 

constrained to that grid, which is handy when you need edits to snap to a strict rhythmical pattern. 

 

 

 

 

 



 
 

The Scissor Tool 

 

 

 

 

 

 

 

 

 

 

DP 's Scissors tool has been around for a while and performs all manner of useful editing tasks, 

chopping up longer sound bites into shorter ones, and isolating beats or phrases ready to be 

duplicated and used elsewhere in your sequence. Let's look at it in context. 

1. Load up or record a sound bite, have it showing in the Sequence Editor, and be prepared to 

hack it to bits For now, make sure the Edit and Beat grids are turned off, by deselecting their 

blue toggle switches at the top right of the editor window. 

2. Regardless of whether the Tool Palette is open or closed, hold down the 'C' key (think 'Cut') to 

engage the Scissors tool. When you point at your sound bite, you'll see an additional cursor 

superimposed on it to confirm exactly where the cut will occur. 

When you're working with beat analysed audio, and with DP's Beat grid enabled -- note the blue 

tick-box towards the upper right of the window & mdash; Scissor tool cuts are con-strained to 

audio beats. Here, a short vocal syllable is being cut on a detected beat, shown by very faint 

vertical lines superimposed on the waveform. 

When you're working with beat analysed audio, and with DP's Beat grid enabled -- note the blue 

tick-box towards the upper right of the window — Scissor tool cuts are constrained to audio beats. 

Here, a short vocal syllable is being cut on a detected beat, shown by very faint vertical lines 

superimposed on the waveform. 



 
 

3. Simply click to cut the sound bite into two. You can then continue to click if necessary to make 

additional cuts in other places. Simple as that. 

The Scissors tool has got some tricks up its sleeve, though. One is the ability to make cuts that are 

automatically aligned with Edit or Beat grid divisions. This makes it really easy to exactly chop out 

a four-beat section (for example) from a longer sound bite. And, assuming your audio has been 

analysed for beats, cutting out a single drum hit or even an entire groove becomes trivially easy, 

even if it doesn't exactly align with DP 's time ruler. 

 

 

 

 
 

 

 

 

 

 

 

 

 

When you're using the Scissors in conjunction with the Edit or Beat grids, there's another technique 

you can try. Zoom in to your sequence sufficiently that you can see all the divisions of your 

currently selected Edit grid (it won't work otherwise). Then click a sound bite to make a cut, but 

keep your mouse key pressed down and drag left or right over the soundbite. As you do this DP 

makes multiple cuts, either on Edit or Beat grid divisions, to leave what looks like a very 

fragmented collection of sound bites. Of course, the audio will still play back without a break, as 

the sound bites perfectly abut one another, but you can now easily move or copy any of them 

elsewhere in your sequence (see screen above). Some people also delete or mute some of the 

resulting sound bites, to achieve 'stutter' or glitch effects. 

 

 



 
 

Sound bite Handling 

Layering 

 

 

 

 

 
 

The Audio menu gives access to DP's sound bite layering commands. With these, you can control 

how overlapping sound bites appear on the screen, and consequently how the resulting edit sounds 

during playback. 

The Audio menu gives access to DP's sound bite layering commands. With these, you can control 

how overlapping sound bites appear on the screen, and consequently how the resulting edit sounds 

during playback. 

When you're working with sound bites, it doesn't take long to realise that they can be over-lapped 

in the same track. On playback, DP plays whatever portion of a sound bite is visible at any one 

time, so the layering of overlapping sound bites becomes important. Just as in a graphics program, 

DP has functions for moving selected sound bites forward or back in the layering. To access these, 

go to Audio menu / Layering and choose one of the four sub-menu items that appears (see screen 

below). Alternatively, use the keyboard shortcuts Shift-Apple-[minus sign] and Shift Apple-

[equals] to push a sound bite back or forward in the track layering, respectively. 

Nudge, Nudge 

 

 

 

 

 

 

 

 

 
 



 
 

The Audio menu gives access to DP's sound bite layering commands. With these, you can control 

how overlapping sound bites appear on the screen, and consequently how the resulting edit sounds 

during playback. 

Nudge is a wonderfully helpful feature that is also easy to use. It simply moves any selected data 

(including sound bites) by a user-specified amount, in response to a press of the left or right arrow 

key on your Mac keyboard. For audio editing, you can set it up to move a sound bite one 

millisecond (or less) at a time, to hugely assist in finding good edit points, for example. Equally, 

the Nudge amount can be much larger, making it easy to move data and audio around your 

sequence regardless of the zoom level. 

To set the current Nudge Amount, hit Alt-Apple-N. Then, in the little window that appears, 

configure your desired time/amount by choosing from the pop-up menu and configuring any 

necessary text boxes. One handy option is 'Use Edit Grid', but all the others are useful too. For 

example, if you needed to move your entire sequence four bars further along, to make room for 

some new material at the start, you'd only need to hit Apple-A (to Select All), Alt-Apple-N (to 

bring up the Nudge Amount window), choose 'Measures' and type in '4', hit Return, then, back in 

the Sequence Editor, press the right arrow key. If you do a lot of Nudging, you can even keep the 

Nudge Amount window open and reconfigure it whenever necessary as you encounter different 

editing tasks.  

 

 

 

 

 

 

 

 
 

 

 

 



 
 

SELF ASSESSMENT QUESTION 

 

Q # 1.  How you can launch the software? 

Q # 2. Name one of the famous audio editing tool and why it is mostly used? 

Q # 3. What is interface in the means of communication? 

Q # 4.  What is sound card and how it works? 

Q # 5. How many types of sound cards are there? 

Q # 6. What is customizing the interface? 

Q # 7.  Brief any scenario? 

Q # 8.  What is the utilisation of tool? 
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INTRODUCTION 

 

Early recordings were all completed live, using a single complete take; due to the techno-logy not 

being advanced enough to patch in mistakes it all had to be done through one take only. Audiences 

of music were more concerned with how it was performed than the perfection of it, so if a wrong 

note was played, that didn’t bother people as much as it would now. Now, with the exception of a 

few ‘live’ albums, most takes are edited to make them as ‘perfect’ as possible. Audio editing can 

involve taking part of a track and replacing it with another section that is the same, or 

adding/removing content from the track. The modern listening audience has become very selective 

regarding mistakes and what doesn’t sound good to the ear. We can edit through our DAW to 

enhance the track using Beat Detective, Flex Time, Time Stretch etc. 

Multi-track mixing essentially the blending of a number of audio files or regions to create an 

overall mix that sounds well balanced. This introductory guide is written for those who wish to 

conduct very basic mixing of small multi-track projects and who have little or no knowledge or 

experience of the subject. 

A mix is the putting together of audio (on separate tracks or channels in your software) to create a 

final mix file. With the creation of a new audio resource, this could be in the form of separate 

audio files of spoken word, adding background music to voice recordings, or blending in special 

effects sound files with other source files. 

It discusses the fundamental aspects of mixing in digital audio software, such as volume, pan and 

automation, and what mixing down to mono, stereo and surround actually means. 

This guide also advises on how to finalise your mix, the starting blocks of the mastering processes. 



 
 

OBJECTIVES 

 

After the reading this unit the student will be able to:  

 

1. Learning after the Editing efficiency and multi track mixing in detail will provide the students a 

practical professional knowledge for their professional carrier.  

1. This course leads the maximum practical skills for those professional students who made their 

future in the field of all type of audio productions. 

2. This is digital era and the audio productions completely deals with the digital technology as the 

audio productions are the computer aided productions.  

4. After the completion of this task the students will be able to handle any type of digital audio 

professional productions for their best performance in the field of audio productions. 

 

 

 

 

 

 

 

 

 

 

 

 

 



 
 

1. MARKERS 

 

Working with markers 

 

Markers (sometimes called cues) are locations that you define in a waveform. Markers make it 

easy to navigate within a waveform to make a selection, perform edits, or play back audio. 

In Adobe Audition, a marker can be either a point or a range. A point refers to a specific time 

position within a waveform (for instance, 1:08.566 from the start of the file). A range has both a 

start time and an end time (for example, all of the waveform from 1:08.566 to 3:07.379). You 

can drag start and end markers for a range to different times. 

In the timeline at the top of the Editor panel, markers have white handles you can select, drag, or 

right click to access additional commands. 

 

 

 

 

 

 

 
 

 

 

 

 

Examples of markers 

A. Marker point B. Marker range  

Note: 

To preserve markers when you save a file, select Include Markers and Other Metadata. 

 



 
 

Add, select, and rename markers 

Though you can add markers directly in the Editor panel, you use the Markers panel (Windows > 

Markers) to define and select markers. 

To hide or show information such as Duration and Type, choose Markers Display from the panel 

menu. 

Add a marker 

Do one of the following: 

 Play audio. 

 Place the current-time indicator where you want a marker point to be. 

 Select the audio data you want to define as a marker range. 

 Either press the M key, or click the Add Marker button in the Markers panel. 

 

To automatically create markers where silence occurs, see Delete Silence and Mark Audio options. 

Select markers 
 

• Click a marker in the Editor or Markers panel. Or double-click to move the current-time 

indicator to that location and select the area for range markers. 

• To select adjacent markers, click the first marker you want to select in the Markers panel, and 

then Shift click the last. 

• To select nonadjacent markers, Ctrl+click (Windows) or Command+click (Mac OS) them in 

the Markers panel. 

• To move the current-time indicator to the nearest marker, choose Edit > Marker > Move 

CTI to Next or Previous. 

Rename a marker 

 

- In the Markers panel, select the marker. 
 

- Click the marker name, and enter a new name.  

Adjust, merge, convert, or delete markers 

After creating markers, you can fine-tune them to best address the needs of an audio project. 

 



 
 

Reposition markers 

- In the Editor panel, drag marker handles to a new location.  

- In the Markers panel, select the marker, and enter new Start values for point markers, or Start, 

End, and Duration values for range markers. 
 
 

Merge individual markers 

• In the Markers panel, select the markers you want to merge, and click the Merge button. 

The new merged marker inherits its name from the first marker. Merged point markers be-come 

range markers. 

 

Convert a point marker to a range marker 

 

• Right‑click the marker handle, and choose Convert to Range. 

The marker handle splits into two handles. 

 
 

Convert a range marker to a point marker 

• Right‑click a marker handle, and choose Convert to Point. 

The two parts of the range marker handle merge into a single handle, with the start time of the 

range becoming the time for the point marker. 

Delete markers 

- Select one or more markers, and click the Delete button in the Markers panel.  

- Right‑click the marker handle in the Editor panel, and choose Delete Marker.  
 

Save audio between markers to new files 

- In the Waveform Editor, choose Window > Markers.  

- Select one or more marker ranges. (See Working with markers .) 
 

- Click the Export Audio button in the Markers panel. 
 

- Set the following options:  
 

 



 
 

Use Marker Names In Filename 

Uses the marker name as the prefix for the filename. 
 

Prefix 

Specifies a filename prefix for the new files. 

 

Postfix Starting # 

 

Specifies the number to begin with when adding numbers to the filename prefix. Adobe 

Audition automatically adds numbers after the prefix (for example, prefix02, prefix03) to 

distinguish saved files. 

 

Location 

Specifies the destination folder for saved files. Click Browse to specify a different folder. 

 

Format 

 

Specifies the file format. The Format Settings area below indicates and data compression and 

storage modes; to adjust these, click Change. (See Audio format settings.) 

 

Sample Type 

Indicates the sample rate and bit depth. To adjust these options, click Change. (See Con-vert the 

sample rate of a file.) 

Include Markers and Other Metadata 

Includes audio markers and information from the Metadata panel in processed files.(See Viewing 

and editing XMP metadata.) 

 

Creating playlists 

A playlist is an arrangement of marker ranges that you can play back in any order and loop a 

specified number of times. A playlist lets you try different versions of an arrangement be-fore you 

commit to edits. You create playlists in the Playlist panel (Window > Playlist). 

Note: 

To store a playlist with a file, you must save in WAV format. (See Save audio files.) 

 



 
 

Create a playlist 

- In the Playlist panel, click the Open Markers Panel button .  

- In the Markers panel, select marker ranges you want to add to the playlist. Then click the 

Insert Selected Range Markers Into Playlist button , or drag the range markers to the 
 

Playlist panel. 

Change the order of items in a playlist 

• Drag the item up or down. 

 

Play items in a playlist 

- To play all or part of the list, select the first item you want to play. Then click the Play but-ton at 

the top of the panel. 
 

- To play a specific item, click the Play button to the left of the item name.  

 

Loop an item in a playlist 

Select an item, and enter a number in the Loops column. Each item can loop a different number 

of times. 

Delete items from a playlist 

- Select the items, and click the Remove button .  

- Delete Silence and Mark Audio options 
 

- Batch process files 

 

  



 
 

2. EFFECT RACK 

Sounds 

Effect Racks 

 

Effect Racks is a collection of over 200 sophisticated audio effects engineered for instant sound 

sculpting. It comes packed with an endless variety of Channel Strips, DJ and Live PA effects, 

Glitch Racks, Amp Racks, Modulators, Filters, Beat Processors and Noise Boxes. 

 

 

 

 

 

 

 

 

 

 

 

 

Effect Racks compiles the vast sound manipulation possibilities of Puremagnetik'sRackPak series 

and includes the complete RackPak 1, 2, 3 and AmpPakcollections. Effects Racks' presets are 

grouped into the following categories: 

Amp Racks 

From overdriven metal to crunchy glitch percussion processors Amp Racks contains a specially 

programmed selection of all things amplified and distorted. Plug in a live guitar feed, process 

audio loops or create lo fi beats with this versatile collection of tools. 

Channel Strips 

Includes custom multiband compressors, voice, guitar and drum channels, tone coloring, imaging 

and mix controls. 

 



 
 

Crush & Destroy 

For annihilating all of your audio quickly and safely. This category includes guitar cabinets, 

distortion menus, overdrives and bit reduction racks. 

 

DJ & Live PA 

Add instant dynamicism to a live set with this collection of beat parsers, DJ channel strips, 

compressors, EQ and filtering effects. 

 

Glitch Racks 

A selection of 11 rhythmic dissection racks, stuttering effects and real-time beat tweaking tools. 

LoFi&NoFi 

8 expertly programmed distortions, bit crunchers and sample massacring racks. Derange and 

overdrive whatever you feed these effects. 

Noise Boxes 

The noise boxes category is unique in that it contains 9 white noise instruments that can easily be 

replaced with your own instruments or soft synths. Use them as is, or as a tem-plate for texture 

generation, feedback processing and more. 

Space Modulators 

Includes 9 advanced audio racks to explore the sonic stereo spectrum, widen your mixes or freak 

out your drums. 

Time Machines 

Throw 4/4 out the window with this collection of 15 slapbacks, meter crunchers and echo filters. 

 

Weird Filters 

Banks of 8 band split filters with independent time based effects and dynamic processing per 

band. 

 

 

 

 
 



 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3. AMPLITUDE STATISTICS 

1. Audition can analyze your file for amplitude, clipping, DC offset, and other characteris-tics 

2. If the entire waveform isn’t already selected, press Ctrl+A (Command+A). 

Click the Amplitude Statistics tab, and then click Scan Selection. 

 

 

 

 

 

 

 

 

 

 

 



 
 

- The Amplitude Statistics panel shows peak levels, whether some samples may be clipped, 

average (RMS) amplitude, DC offset, and other statistics. Here’s one example of how these 

statistics can be useful: Note that there’s some DC offset in the left channel, which reduces the 

available amount of headroom. Choose Favorites > Repair DC Offset, and then click Scan 

Selection again. The left channel no longer has any DC offset. 
 

- Keep this project open for the next lesson.  

NOTE 

Total RMS Amplitude is another useful statistic, because it represents a file’s overall loudness. If 

two files have very different Total RMS Amplitude statistics, one will probably sound much louder 

than the other. 

 

4. SHORTCUT KEYS 

These partial lists include the shortcuts that Adobe Audition experts find most useful. For a 

complete list of shortcuts, choose Edit > Keyboard Shortcuts. 
 

 

Keys for playing and zooming audio 

Result        Windows Shortcut 

            

Toggle between Waveform and Multitrack Editor  8    

            

Start and stop playback     Spacebar    

            

Move current-time indicator to beginning of timeline Home    

            

Move current-time indicator to end of timeline  End     

            

Move current-time indicator to previous marker, clip, or Ctrl+left arrow   



 
 

selection edge           

            

Move current-time indicator to next marker, clip, or  Ctrl+right arrow   

selection edge           

            

Toggle preference for Return CTI To Start Position On Shift+X    

Stop            

            

Zoom in horizontally     =     

            

Zoom in vertically      Alt+=     

               

Zoom out horizontally     -       

               

Results        Windows Shortcut  

               

Zoom out vertically      Alt+minus sign     

               

Add marker       M or * (asterisk)     

               

Move to previous marker     Crtl+Alt+left arrow     

               

Move to next marker     Crtl+Alt+right arrow     

               



 
 

Keys for editing audio files 

 

The following keyboard shortcuts apply only in the Waveform Editor.    

            

Results       Windows Shortcut  

            

Repeat previous command (opening its dialog   Shift+R     

box and clicking OK)           

            

Repeat previous command (opening its dialog   Ctrl+R     

box but not clicking OK)           

            

Open Convert Sample Type dialog box   Shift+T     

            

Capture a noise reduction profile for the Noise  Shift+P     

Reduction effect            

            

Activate left channel of a stereo file for editing  Up arrow     

            

Activate right channel of a stereo file for editing Down arrow  



 
 

Results        Windows Shortcut 

 

 

 

Make spectral display more logarithmic or  

 

linear      

 

 

 
 

 Ctrl+Alt+up or down arrow   

       

Make spectral display fully logarithmic or linear Ctrl+Alt+Page Up or Down  

    

Increase or decrease spectral resolution  Shift+Ctrl+up or down arrow  

    

Keys for mixing multitrack sessions 

 

The following keyboard shortcuts apply only in the Multitrack Editor. 

 

 

Results       Windows Shortcut 

Select the same input or output for all audio tracks Ctrl+Shift-select  

Activate or deactivate Mute, Solo, Arm For Record, or Ctrl+Shift-click   

Adjust knobs in large increments    Shift-drag   

Adjust knobs in small increments  
 

Nudge selected clip to the left  

Nudge selected clip to the right  

 

 

  Ctrl-drag    

  Alt+comma    

  Alt+period    

 

 



 
 

 

Maintain key frame time position or parameter value   Shift-drag    

Reposition envelope segment without creating keyframe Ctrl-drag    

        

 

5. FAVORITES  

Adding a Favorite 

 

1. As you begin to work more with Audition, you may find yourself applying the same effects 

repeatedly. Saving effects as favorites allows you to name and access your effects in a central 

location. You can even assign keyboard shortcuts to access commonly used effects. 

2. In the Edit View, click on the Favorites tab to bring the Favorites panel forward. If the Favorites 

tab is not visible, choose Window > Favorites to make it visible. Click the Edit Favorites button at 

the bottom of the Favorites panel. The Favorites window appears. Audition comes installed with 

certain favorites, such as Fade In and Fade Out. 

Click the New button, and in the Name field, enter Pan Left to Right Smooth. In the Press New 

Shortcut Key field type the letter D. 

3. In the Function tab, click the Audition Effect drop-down menu. A list of the effects available in 

Edit View appears. Choose Amplitude\Stereo Field Rotate (process). 

 

 

 

 

 

 

 

 

 



 
 

4. To ensure that the effect you are saving is the one you want, click the Edit Settings but-ton. The 

Stereo Field Rotate window appears. Click to select the Pan Left to Right Smooth preset that you 

saved in the previous section, and click OK. Click the Save button and the favorite appears at the 

bottom of the Favorites list. 

5. In the Favorites window, click the Up button to move your favorite to the top of the list of 

favorites. Click the Close button. 

6. Click the Files tab to access your list of files. Double-click on the SmackFunkDrm18. Cell file to 

display the waveform. Click to select the waveform, then press the letter D to apply the Stereo Field 

Rotate effect. You may need to wait a few moments as Audition calculates and applies the changes. 

When the waveform changes, the effect has been applied. Press the spacebar to hear the effect. 
 

Note 

You can also click the Favorites tab, then double-click the Pan Left to Right Smooth favorite to 

apply the effect. 

 

7. Choose File > Save As. If necessary, navigate to the AA_03 folder on your hard disk. 

Rename this file SmackFunkDrm_pan.cel and click Save. 

Note 

If an alert message appears confirming that you want to overwrite an existing file, click Yes. 

8. Press F12 to enter Multitrack View. When working in Edit View, the Multitrack View is also 

open and all edits made in Edit View are automatically updated. Press the Home key and then 

press the Play button to hear the session. Pay particular attention to the stereo effect of the first 

drum clip, as well as when the tambourine begins. The stereo field changes you made have been 

incorporated into the main mix. 
 

9. Choose File > Save Session and then choose File > Close All. 

 

 

 

 

 

 

 



 
 

6. MUTITRACK SESSION 

About multitrack sessions 

 

In the Multitrack Editor, you can mix together multiple audio tracks to create layered soundtracks 

and elaborate musical compositions. You can record and mix unlimited tracks, and each track can 

contain as many clips as you need—the only limits are hard disk space and processing power. 

When you’re happy with a mix, you can export a mixdown file for use on CD, the web, and more. 

The Multitrack Editor is an extremely flexible, realtime editing environment, so you can change 

settings during playback and immediately hear the results. While listening to a session, for 

example, you can adjust track volume to properly blend tracks together. Any changes you make are 

impermanent, or non-destructive. If a mix doesn’t sound good next week, or even next year, you 

can simply remix the original source files, freely applying and removing effects to create different 

sonic textures. 

Adobe Audition saves information about source files and mix settings in session (.sesx) files. 

Session files are relatively small because they contain only pathnames to source files and references 

to mix parameters (such as volume, pan, and effect settings). To more easily manage session files, 

save them in a unique folder with the source files they reference. If you later need to move the 

session to another computer, you can simply move the unique session folder. 

Editing multitrack sessions in the Editor panel and Mixer 

In the Multitrack Editor, the Editor panel provides several elements that help you mix and edit 

sessions. In the track controls on the left, you adjust track specific settings, such as volume and 

pan. In the timeline on the right, you edit the clips and automation envelopes in each track



 
 

  Editor panel in Multitrack Editor  
 

A. Track controls B. Zoom navigator C. Vertical scroll bar D. Track  

The Mixer (Window > Mixer) provides an alternative view of a session, revealing many more 

tracks and controls simultaneously, without showing clips. The Mixer is ideal for mixing large 

sessions with many tracks. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Controls in the Mixer: 

A. Inputs B. Effects C. Sends D. Equalization E. Volume F. Outputs 



 
 

 

Select ranges in the Multitrack Editor 

 

 

 

 

 

 
 

 

 

      

     

      

 

In the toolbar, select the Time Selection tool .  

1. In the Editor panel, do one of the following:  
 

•  To select only a range, click an empty area of the track display, and drag left or right.  

• To select a range and clips, click the center of a clip, and drag a marquee. 

 

Start Time 
 

Sets a start-time offset, helping you match audio in Adobe Audition to the time displayed in video 

applications. 

 

Advanced settings 

To customize Time Display settings for the active session, set the Time Format and Cus-tom 

Frame Rate settings. For details, see Change the time display format. 



 
 

Adobe also recommends 

• Comparing the Waveform and Multitrack editors  

• Create a new multitrack session 
 

• Save multitrack sessions 
 

• Add or delete tracks 
 

• Arranging and editing multitrack clips 
 

• Automating mixes with envelopes 

 

 

7. ADDING MULTIPLE TRACK 

 

COMPILE WHOLE TRACKS.  

Track1, track2, track3, track4, track5. 

 

Import track one and two.  

Left click on blank area of left panel of track two to highlight the track.  

Go to Edit and click Cut  

Click on track one at the very end of the track then go to edit again and click Paste.  

Track two will now be added to the end of track one.  

If there's a silent gap between the tracks click on the gap to place the selection marker then zoom 

in, click hold and drag to select the blank section then Edit/Cut.  

Repeat for tracks 3, 4 and 5 then export via the file menu to your chosen format.  

For a smoother transition between tracks you could crossfade them.  

 

As one track is fading out the next is fading in. There is no stop / start as in the above method.  

If a track starts or stops abruptly a fade in or fade out effect can be applied by selecting the 

beginning / end of a track then selecting fade in or fade out from the effect menu.  



 
 

Do this first. 

If you make an error ctrl+z is the quickest way to undo it.  

Import all five tracks.  

Apply fade ins / outs if needed.  

Select the time shift tool. (icon with the left/right arrow <->)  

Click hold and drag on track two to move the whole track to the right until it slightly over-laps 

the end of track one.  

Re-select the selection tool, click on the waveform just before the crossfade point and play the 

track to check it.  

Re-adjust with the time shift tool if needed then do the same for tracks 3 and 4.  

Tip: there's an icon with a blank magnifying glass symbol and inward pointing arrows (>--<) 

which will fit the whole project in the same screen.  

The finished project should look something like this with the overlaps: (ignore the lines)  

Track one  

 

_______Track two  

 

______________Track three  

 

______________________Track four  

 

_____________________________Track five  

 

 

When exported it's automatically mixed into a single track. 

 

 

 



 
 

8. MIXING AND PLACING AUDIO 

 

Audio mixing (recorded music) 

Digital Mixing Console Sony DMX R-100 used in project studios 

In sound recording and reproduction, audio mixing (or mix down) is the process which 

commences after all tracks are recorded (often, tracked) and edited as individual parts. The 

mixing-process can consist of various processes but are not limited to setting levels, setting 

equalization, using stereo panning, and the addition of effects. The way the song is mixed has as 

much impact on the way it sounds as each of the individual parts that have been recorded. 

Dramatic impacts on how the song affects the listeners can be created by minor adjustments in the 

relationship among the various instruments within the song. 

Audio mixing is utilized as part of creating an album or single. Mixing is largely dependent on 

both the arrangement and the recordings. The mixing stage often follows a multitrack recording. 

The process is generally carried out by a mixing engineer, though sometimes it is the musical 

producer, or even the artist, who mixes the recorded material. After mixing, a mastering engineer 

prepares the final product for reproduction on a CD, for radio, or otherwise. 

Prior to the emergence of digital audio workstations (DAWs), the process of mixing used to be 

carried out on a mixing console. Currently, more and more engineers and independent artists are 

using a personal computer for the process. Mixing consoles still play a large part in the recording 

process. They are often used in conjunction with a DAW, although the DAW may only be used as 

a multitrack recorder and for editing or sequencing, with the ac-tual mixing being performed on 

the console. 

 

 

 

 

 

 



 
 

Digital Mixing Console Sony DMX R-100 used in project studios 

 

The role of audio mixing 
 

In its simplest form an audio mixer combines several incoming signals into a single output signal, 

however this is not as simple as connecting the input signals in parallel and sen-ding them to a 

single output signal because they could influence each other. In order to combine different signals, 

they must be mixed first so that each signal has a relationship of hierarchy (each signal's volume 

one step below the next). The role of a music producer is not necessarily a technical one, with the 

physical aspects of recording being assumed by the audio engineer, and so producers often leave 

the similarly technical mixing process to a specialist audio mixer. Even producers with a technical 

background may prefer that a mixer comes in to take care of the final stage of the production 

process. Noted producer and mixer Joe Chiccarelli has said that it is often better for a project that 

an outside person comes in because: 

when you're spending months on a project you get so mired in the detail that you can't bring all the 

enthusiasm to the final [mixing] stage that you'd like. [You] need somebody else to take over those 

responsibilities so that you can sit back and regain your objectivity. 

 

https://en.wikipedia.org/wiki/Audio_mixing_(recorded_music) 

Mixing refers to the process of combining multiple Audacity tracks which play 

simultaneously into a single track. 

Audacity mixes automatically when playing or exporting, but it can also physically mix selected 

multiple tracks together into one within the project. 

The channel of a track being mixed affects whether it will be mixed into the left channel of the 

resulting track(s), the right channel, or both (mono). For example, if you have four tracks: 

 

Track 1: left channel 

Track 2: left channel 

Track 3: right channel 

Track 4: mono channel 

 



 
 

and you select them all and perform a Mix and Render, you will end up with one stereo track: the 

left channel will contain a mix of tracks 1, 2, and 4 and the right channel will contain a mix of 

tracks 3 and 4. 

Mixing can be done for a number of reasons, for example mixing speech with background music 

to make a podcast, or adding different instruments into the same song. Concatena-ting songs (for 

example, playing three songs one after the other) does not necessarily involve mixing, but if you 

wanted the songs to fade into each other it would involve mixing. 

 

Within an Audacity project, you can physically mix selected multiple selected tracks into a single 

mono or stereo track using either of two explicit mix commands: 

Tracks > Mix and Render (which replaces the original track(s) with the mixed track) or 

Tracks > Mix and Render to New Track (which adds the mixed track to the project, preserving the 

original tracks). 

However in Audacity, mixing is automatic. You could just put audio into two different tracks, 

play to listen to the result then export it as an audio file like MP3 or WAV or burn the WAV to 

Audio CD. 

However once audio has been finally mixed (as in an audio file you might import into Audacity) it 

is essentially impossible to separate out all the original parts again; it's like trying to take the 

banana out of a banana milkshake after you've already put it through the blender. There are a few 

occasions when it actually is possible to separate sounds a bit - you can sometimes isolate the 

bass, or remove the lead vocals. But these processes don't always work well and usually cause 

some quality loss. So remember, as long as the multiple tracks are inside an Audacity project, you 

can manipulate them independently, but once you export as a mixed down file you can't expect to 

separate the different parts again. So keep your Audacity project around if you plan to continue 

editing 

 

 

 



 
 

The controls used for mixing are the Mute and Solo buttons and the Gain (-.....+) and Pan (L.....R) 

sliders. 

 

 

 

 

 

 

 

 

 

 

 

 

 

In the above example, mixing the mono (upper) and stereo (lower) track means that the audio of 

the mono track will be heard equally in both left and right channels of the resulting stereo mix. 

Muting and Soloing 

When working with multiple tracks, it's often important to be able to hear just one at a time. Each 

track has a Mute and a Solo button, allowing you to temporarily hear just some of your tracks - see 

the figure above 

 

Mute causes a track to be silenced. More than one track can be muted. 

 

Solo can behave in two different ways depending on the setting made in Tracks Preferences. 

Default behaviour is that Solo silences all of the tracks except the ones being soloed. More than 

one track can be soloed, and soloing overrides muting. 

 

Alternative behaviour is that only one track can be soloed at a time. Soloing still overrides 

muting. 

 



 
 

A third option in Tracks Preferences is to hide the Solo button from tracks, leaving just a Mute 

button which silences whichever tracks it is applied to. 

 

You can press the Mute and Solo buttons while tracks are playing. 

 

If you're using the keyboard, SHIFT+U toggles muting on the currently focused track which has 

the yellow border, and SHIFT + S toggles soloing. The solo shortcut works even if you hide the 

Solo button. 

 

Gain and panning 

 

Above the Mute / Solo buttons, each track has a - / + gain slider which adjusts the track's volume, 

and an L / R pan slider which adjusts the track's stereo position in the overall mix - whether it 

comes from the left speaker, right speaker or in-between. To change the value, just click on the 

slider and drag. For finer control when dragging, hold SHIFT while dragging or double-click on 

the slider or slider scale to enter a precise value as text. 

 

The normal range of gain is from -36 dB to 36 dB. If you need more, choose Effect > Amplify. 

 

If you're using the keyboard, use: 

 

ALT + SHIFT + UP to increase the gain on the focused track or ALT + SHIFT + DOWN to 

reduce it 

 

Use ALT + SHIFT + LEFT to pan left on the focused track or ALT + SHIFT + RIGHT to pan 

right. 

 

Or press SHIFT + G to adjust the gain in a dialog box or SHIFT + P to adjust the pan. 

 

Explicit Mixing and Rendering 

 

While mixing is automatic, there are times when you may want to explicitly tell Audacity to mix 

several tracks. This is useful in several ways: 

 



 
 

You can consolidate tracks which you have finished working on, making it easier to see the other 

tracks without scrolling up and down 

Playback may respond more quickly with fewer tracks 

You can see what the final mix will look like as a waveform so as to check the overall level of the 

final mix before exporting it. 

To mix explicitly, select all the tracks you want to mix together then choose either Tracks > Mix 

and Render or Tracks > Mix and Render to New Track (shortcut CTRL + SHIFT + M). 

Several things happen when you choose either Mix and Render command. 

All selected tracks are mixed down to a single track called Mix. 

If you choose Mix and Render, the resulting Mix track replaces the selected original tracks. 

If you choose Mix and Render to New Track, the original tracks are preserved so that the resulting 

Mix track becomes an additional track in the project. 

The Mix track is always placed underneath any non-selected or remaining tracks. 

The new mixed track will be stereo unless the tracks you mixed were mono tracks panned to 

center. 

If any of the original tracks did not match the sample rate of the project (set at bottom left of the 

project window in Selection Toolbar), they will be re-sampled to match the project rate. 

Any envelope points defining amplitude modifications will be applied and the previous envelope 

points removed. 

 

Gain and panning changes will be applied and the sliders reset to normal in the mixed track. 

Mute and Solo button states will be released. 

 

You can always Edit > Undo if you're not happy with the results of Mix and Render, then make 

changes and try it again. 

 

 

 



 
 

Mixing Levels 

 

The act of mixing multiple tracks adds the waveforms together. In most cases this will cause the 

mixed track to have a higher peak and RMS (average) level than the individual pre-mixed tracks, 

though this is not always true by definition. How much (or whether) the peak level increases and 

how much louder it actually sounds depends on how related the wave-forms of the mixed tracks 

are. 

When peaks or troughs in the waveform coincide, the waveforms will reinforce each other, leading 

to an increased signal level. In fact if you combined two identical tracks, the signal level would 

exactly double, leading to an increase in peak level of 6 dB. But when a peak in one track 

coincides with a trough in another track the waveforms will tend to cancel each other out, leading 

to a lower level in the mix at that point. 

 

Also the more tracks that have audio at the same point on the Timeline, the higher the mix level is 

likely to be. 

 

The overall mix level is indicated on the Playback Meter when the project is playing. You can 

see individual meters for each track (showing the levels as modified by the track's gain/pan 

sliders and mute/solo buttons) if you enable View > Mixer Board. 

 

 

 

 

 

 

 

 

 

 



 
 

SELF ASSESSMENT QUESTIONS 

 

 

 

Q # 1.What are the markers and why markers use during audio recording/editing ?  

 

 

Q # 2.What are the benefits of shortcut keys? 
 

 

Q # 3.What is multi-track session and what are its benefits? 
 

 

Q # 4.How you can add multiple tracks? 
 

 

 

Q # 5.Brief the mixing and placing audio?   
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INTRODUCTION 

Dear Students the fact is that the real world is continuous and the Digital world is not. 

More precisely time, distance, and pressure are all continuous quantities. They can take 

an infinite number of values and are infinitely divisible. 

In this unit we will discuss about the Sampling rate for an audio file. The students will 

learn why it is very important for our audio files, bit depth and bit rate. 

Dear students the sampling rate is only one of several variables in audio files. Others 

include the sample size, the number of channels, encoding algorithm, the type of 

compression used, and possibly commands and/or information useful to the operating 

system for which the file format was developed.  

Dear students many audio file formats allow for a variable number of channels. Thus a 

file could be mono, stereo, or any number of discreet channels. Audio files can be 

encoded in different ways. Dear students we all know and appreciate the convenience of 

digital audio, and most people are comfortable with the most common format of MP3. 

Move beyond this, however, and things can start to get a little confusing. In this unit 

students will learn the basics of file formats, and hopefully, it will help students to 

improve their listening experience in the process. 

Dear students Data formats designed to represent musical scores, recordings, and other 

miscellaneous aspects of musical composition have proliferated over the last several 

decades. While some have been recognized as industry standards, archival records have 

been generated in a bewildering array of formats specific to particular operating systems 

and software, in addition to a variety of file interchange formats. This unit is intended as 

an introduction to the file formats used in audio recordings. The digital representation of 

music can be broken down into three broad categories. The first category includes file 

formats that represent actual sound (digital recordings) while the second includes formats 

that represent musical scores (notation files). A third category includes formats that 

neither represent a score or recording, but serve to control computer operations that could 

then generate a score or recording. 



 
 

The last variables in an audio file are the system-specific commands or information. File 

formats that make use of these variables are only useful on certain computers. To some 

extent, the file format used can help to determine the chronology of files in an archive. 

Some formats have becoming obsolete as technology improved, and some operating 

systems have decreased in popularity. 

Dear students a description of the file formats and their technical specifications is 

explained in this unit which will help students learn about file formats. 

Dear students this unit also covers the different ways of saving an edited audio file. How 

to export your saved work or project in different file formats. In the end of this unit 

students will be able to write your own audio CD.  

 

OBJECTIVES: 

After studying this unit you will be able to: 

 

1. Understand the science of sampling and bit depth in an audio file. 

2. Importance of audio channels in recording. 

3. Knowledge about the difference of stereo and mono audio. 

4. Learn about recording methods and audio quality. 

5. Knowledge about the history of mono and stereo. 

6. Know about different file formats. 

7. Knowledge about compressed, lossless and lossy formats. 

8. Learn how to save the audio file. 

9. Learn to export multitrack audio project. 

10. Able to save an edited audio file and its export to different format and creating audio CD. 

 

 



 
 

1. SAMPLE RATE AND BITRATE 

We use digital audio all the time, but people are unclear about how digital audio works. 

Digital audio has two primary qualities that compose the way the audio is described. Real 

sounds have frequencies and volumes. In order to measure real world sounds and 

represent them digitally, we have created sample rate and bitrate as digital’s audio 

qualities. Sample rate determines how analog frequencies are described digitally whereas 

bitrate determines how analog volume is described digitally. The two qualities need each 

other in order to describe a sound. You can’t have volume without frequency or 

frequency without volume. 

In order to understand about sample rate and bitrate, you need to understand a little bit 

about how all things digital work. Digital works like a ticking second hand. Whereas time 

and the world as we know seem continuous and seamless, digital breaks things like time 

up into little measurements. When we are talking about measurements of time, we are 

talking about ticks just like the ticking of a second hand. If anything is to happen 

digitally, it has to happen on a tick. The rate of these ticks is measured in hertz. A 2Ghz 

computer has 2,000,000,000,000 ticks a second. That’s a lot of ticks. 

 

a. Sample Rate 

Sample rate is a rate, just like the ticks we just talked about. Analog signal is smooth, just 

like the image you see to the right here. Like the real world, it just keeps going. In order 

to get this signal represented in the digital world, we need to measure it into little chunks 

by defining a rate. On the bottom line of the graph to the right you’ll see time is 

represented by t. 

https://d6efvjlgj0t6x.cloudfront.net/wp-content/uploads/2008/01/analog_signal.png


 
 

 

If we start to split up the smooth analog signal into digital chunks, you will start to see 

something like the second image. With each tick of the clock we measure what is 

happening at each tick ‘t’. That measurement is documented, represented by the balls on 

the signal graph. How often we do these measurements is called the sample rate. The 

higher the rate, the closer you’ll get to the smoothness of the first image. Measuring 

things in bits like this is called quantizing and the measurements are called samples 

(hence sample rate). 

The sample rate can be thought of as how often or how much the sound is described. 

CD quality audio has 44,100 of these measurements a second. That’s called 44.1 kilohertz (khz). 

b. Bit Depth 

With what we just learned, consider that in order for the ticks to make any sense at all 

they need to actually be measuring something. We are actually measuring volume. 

Volume is represented by the height of the balls in the image. With each tick a new 

measurement of the volume is made. This is how we describe the volume. It is a range 

from 0 to 100? 0 to 2000?0 to 1? The range of volumes that can be described is the bit 

rate. Now, in each of these examples, 0 means totally silent and 100, 2000, or 1, 

respectively, means as-loud-as-it-can-get. So the only difference between each of these 

ranges is not how loud the sound can be but how many different volumes can be 

described. We only have two choices for ‘0 to 1’, i.e. Is there a sound or not? But from 0 

to 2000 we can have half volume (1000), quarter volume (500), or even somewhere in 

between (829). The higher the bitrate, the more accurately we can communicate exactly 

how loud the volume of the ‘real’ sound we want to describe is. 

The bit rate can be thought of as how well the sound is described. 

https://d6efvjlgj0t6x.cloudfront.net/wp-content/uploads/2008/01/sampled_signal.png


 
 

CD quality audio has 65,536 volumes to choose from for every sample that’s measured. 

That’s called 16-bit audio (because 2 to the 16th power is 65,536). 

c. Putting Them Together 

With each sample rate and bitrate there’s a limit to how accurately the analog sound can 

be described. The Nyquist–Shannon sampling theorem states that a sample rate of twice 

the maximum frequency of the signal being sampled is needed to describe the frequency. 

Most humans can hear from 20Hz to 20Khz, so the sampling rate of 44.1khz was chosen 

to be able to capture frequencies up to 22.05khz. 

d. Speaking in General Terms 

In general, the higher bitrate the ‘smoother’ the sound will be. 8-bit sounds rather grainy 

and harsh whereas 16-bit sound sounds quite a bit better. 24-bit sound is used by most 

audio professionals these days not because it sounds so much better than 16-bit sound but 

because the higher accuracy is useful because so much is done to the audio in the 

recording, mixing, and mastering process. Higher bitrate means that each change that is 

done to the sound produces a more accurate result. Imagine only being able to describe 

the sounds you are recording with two volumes: on or off. It would be impossible to 

produce any music at all with such a low bitrate. 

Higher sample rates are theoretically able to capture higher frequencies that humans may 

or may not be able to perceive. There are many things to consider when making these 

claims, including the quality of the microphones used, the sounds being recorded, the 

delivery medium, and the quality of the speakers to be used to listen to the material. Since 

then, most people have come to the agreement that high resolution samples rates are not 

as important as higher bit rates with respect to pro audio. Again, you cannot replace one 

with the other, so a balance is required, but 44.1khz/24-bit audio is still the standard when 

producing 44.1khz/16-bit audio CD quality audio.  

When digital audio is played back, the audio processor looks at the information and 

recreates the waveform from the sample/bit rates. It’s actually creating, as best it can, real 

continuous sound from the quantized digital data.  



 
 

e. Final Thoughts 

Why carry around a dozen cups from shot glasses to five gallon jugs when one 1.5litre 

travel bottle suits most of your drinking needs throughout the day? It’s the same way with 

sample rates and bitrates. If you don’t need super high-res audio, it may not be 

worthwhile to record it. The higher the bitrate and samplerate, the more data will be 

recorded, the larger your sessions will be, and the harder your DAW will have to work.  

See this table for a few examples. 

Bit 

Depth 

Sample 

Rate 
Bit Rate 

File Size of one 

stereo minute 

File size of a three 

minute song 

16 44,100 1.35 Mbit/sec 10.1 megabytes 30.3 megabytes 

16 48,000 1.46 Mbit/sec 11.0 megabytes 33 megabytes 

24 96,000 4.39 Mbit/sec 33.0 megabytes 99 megabytes 

mp3 file 
128 k/bit 

rate 
0.13 Mbit/Sec 0.94 megabytes 2.82 megabytes 

Hard disk requirements for a multi-track 3 minute song 

Bit 

depth/sample 

rate 

number of 

mono 

tracks 

size per  

mono track 

size per 

song 

songs per 20 

gigabyte hard 

disk 

songs per 200 

gigabyte hard 

disk 

16/44.1 8 15.1 megs 121 megs 164 1640 

16/48 8 16.5megs 132 megs 150 1500 

24/96 8 49.5 megs 396 megs 50 500 

16/44.1 16 15.1 megs 242megs 82 820 



 
 

16/48 16 16.5 megs 264 megs 74 740 

24/96 16 49.5 megs 792 megs 24 240 

 

2. AUDIO CHANNELS 

There are basic two channels in audio file recording: 

1. Stereo 

2. Mono 

Stereo (Stereophonic) is the reproduction of sound using two or more independent 

audio channels in a way that creates the impression of sound heard from various 

directions, as in natural hearing.  

Mono (Monaural or monophonic) has audio in a single channel, often centered in the 

“sound field”.  

Comparison chart 

Stereo sound has almost completely replaced mono because of the improved audio 

quality that stereo provides.  

Mono versus Stereo comparison chart 

 Mono Stereo 

Cost Less expensive for recording 

and reproduction 

More expensive for recording and 

reproduction 

Recording Easy to record, requires only 

basic equipment 

Requires technical knowledge and skill to 

record, apart from equipment. It's important 

to know the relative position of the objects 

and events. 

Key feature Audio signals are routed Audio signals are routed through 2 or more 



 
 

through a single channel channels to simulate depth/direction 

perception, like in the real world. 

Stands for Monaural or monophonic sound Stereophonic sound 

Usage Public address system, radio 

talk shows, hearing aid, 

telephone and mobile 

communication, some AM radio 

stations 

Movies, Television, Music players, FM radio 

stations 

 

a. APPLICATIONS 

Mono sound is preferred in radiotelephone communications, telephone networks, and 

radio stations dedicated to talk shows and conversations, public address system, hearing 

aids. Stereo sound is preferred for listening to music, in theatres, radio stations dedicated 

to music, FM broadcasting and Digital Audio Broadcasting (DAB).  

b. HISTORY 

Until the 1940s mono sound recording was popular and most of the recording was done 

in mono even though the two-channel audio system was demonstrated by Clément Ader 

in as early as 1881. In November 1940 Walt Disney's Fantasia became the first 

commercial motion picture with stereophonic sound. With the advent of magnetic tapes 

the usage of stereo sound became easier. In the 1960s albums were released as both 

monaural LPs and stereo LPs because people still had their old mono players and the 

radio station were mostly AM. Similarly movies were released in both versions because 

some theatres were not equipped with stereo speakers systems. Today no monaural 

standards exist for 8-track tape and compact disc and all films are released in 

stereophonic sound.  

c. RECORDING METHODS AND AUDIO QUALITY 

Mono sound recording is done mostly with one microphone and only one loudspeaker is 

required to listen to the sound. For headphones and multiple loudspeakers the paths are 

mixed into a single signal path and transmitted. The signal contains no level, arrival time 



 
 

or phase information that would replicate or simulate directional cues. Everyone hears the 

very same signal and at the same sound level. The sound played for instance by each 

instrument in a band will not be heard distinctly though it will have full fidelity. Hand 

held recorders record sound in mono. It is cheaper and easier to record in mono sound.  

Stereo recording is done with two or more special microphones. The stereo effect is 

achieved by careful placement of microphone receiving different sound pressure levels 

accordingly even the loudspeakers need to have the capability to produce the stereo and 

they also need to be positioned carefully. These sound systems have two or more 

independent audio signal channels. The signals have a specific level and phase 

relationship to each other so that when played back through a suitable reproduction 

system, there will be an apparent image of the original sound source. It is expensive and 

it requires skill to record stereo sound.  

There are following methods of recording in stereo: 

X-Y technique:(intensity stereophony)- In this technique two directional microphones 

are at the same place, typically pointing at an angle between 90° and 135° to each other.  

A-B technique:(time-of-arrival stereophony) - Here two parallel microphones which are 

not direction specific are kept some distance apart. This results in capturing time-of-

arrival stereo information as well as some level (amplitude) difference information.  

M/S technique:(Mid/Side stereophony) - A bidirectional microphone facing sideways 

and another microphone at an angle of 90°are kept facing the sound source. This method 

is used for films.  

Near-coincident technique:(mixed stereophony) - This technique combines the 

principles of both A-B and X-Y (coincident pair) techniques. The playback is suitable 

over stereo speakers.  



 
 

d. COMPATIBILITY 

Mono is compatible with and usually found on Phonograph cylinders, Disc records, like 

78 rpm and earlier 16⅔, 33⅓, and 45 rpm microgroove, AM radio and some (very few) 

FM radio stations. Mono and stereo are both found in MiniDisc, compact audio cassette, 

most FM radio, VCR formats and TV. Mono is not used in 8-track tape and audio CDs.  

3. AUDIO FILE FORMAT 

An audio file format is for storing digital audio data on a computer system. The bit layout 

of the audio data (excluding metadata) is called the audio coding format and can be 

uncompressed, or compressed to reduce the file size, often using lossy compression. The 

data can be a raw bit stream in an audio coding format, but it is usually embedded in 

a container format or an audio data format with defined storage layer. 

a. FORMAT TYPES 

It is important to distinguish between the audio coding format, the container containing 

the raw audio data, and an audio codec. A codec performs the encoding and decoding of 

the raw audio data while this encoded data is stored in a container file. Although most 

audio file formats support only one type of audio coding data, a multimedia container 

format (as AVI) may support multiple types of audio and video data. 

There are three major groups of audio file formats: 

1. Uncompressed audio formats, such as WAV, AIFF, AU or raw header-less PCM. 

2. Formats with lossless compression, such as FLAC, Monkey's Audio (filename 

extension .ape ), Wav Pack (filename extension .wav ), TTA, ATRAC Advanced 

Lossless, ALAC(filename extension .m4a ), MPEG-4 SLS, MPEG-4 

ALS, MPEG-4 DST, Windows Media Audio Lossless (WMA Lossless), 

and Shorten (SHN). 

3. Formats with lossy compression such as Opus, MP3, Vorbis, Musepack, AAC, 

ATRAC and Windows Media Audio Lossy (WMA lossy)  



 
 

b. UNCOMPRESSED AUDIO FORMAT 

One major uncompressed audio format, LPCM, is the same variety of PCM as used 

in Compact Disc Digital Audio and is the format most commonly accepted by low level 

audioAPIs and D/A converter hardware. Although LPCM can be stored on a computer as 

a raw audio format, it is usually stored in a .wav  file on Windows or in a .aiff  file on Mac 

OS. The AIFF format is based on the Interchange File Format (IFF), and the WAV 

format is based on the similar Resource Interchange File Format (RIFF). WAV and AIFF 

are not inherently lossless. They are designed to store a wide variety of audio formats, 

lossless and lossy. They just add a small, metadata-containing header before the audio 

data to declare the format of the audio data, such as LPCM with a particular sample 

rate, bit depth and number of channels. Since WAV and AIFF are widely supported and 

can store LPCM, they are suitable file formats for storing and archiving an original 

recording. 

BWF (Broadcast Wave Format) is a standard audio format created by the European 

Broadcasting Union as a successor to WAV. Among other enhancements, BWF allows 

more robust metadata to be stored in the file. This is the primary recording format used in 

many professional audio workstations in the television and film industry. BWF files 

include a standardized timestamp reference which allows for easy synchronization with a 

separate picture element. Stand-alone, file based, multi-track recorders from 

AETA, Sound Devices, Zaxcom, HHB Communications Ltd,Fostex, Nagra, 

Aaton, and TASCAM all use BWF as their preferred format. 

 

C. LOSSLESS COMPRESSED AUDIO FORMAT 

A lossless compressed format stores data in less space without losing any information. 

The original, uncompressed data can be recreated from the compressed version. 

Uncompressed audio formats encode both sound and silence with the same number of 

bits per unit of time. Encoding an uncompressed minute of absolute silence produces a 

file of the same size as encoding an uncompressed minute of music. In a lossless 

compressed format, however, the music would occupy a smaller file than an 

uncompressed format and the silence would take up almost no space at all. 



 
 

Lossless compression formats include the common FLAC, WavPack, Monkey's, 

Audio, ALAC (Apple Lossless). They provide a compression ratio of about 2:1 (i.e. their 

files take up half the space of PCM). Development in lossless compression formats aims 

to reduce processing time while maintaining a good compression ratio. 

d. LOSSY COMPRESSED AUDIO FORMAT 

Lossy compression enables even greater reductions in file size by removing some of the 

audio information and simplifying the data. This of course results in a reduction in audio 

quality, but a variety of techniques are used, mainly by exploiting psychoacoustics, to 

remove the parts of the sound that have the least effect on perceived quality, and to 

minimize the amount of audible noise added during the process. The popular MP3 

format is probably the best-known example, but the AAC format found on the iTunes 

Music Store is also common. Most formats offer a range of degrees of compression, 

generally measured in bit rate. The lower the rate, the smaller the file and the more 

significant the quality loss. 

e. LIST OF FORMATS 

File 

Extension 
Description 

.aac 
The Advanced Audio Coding format is based on the MPEG-2 and MPEG-

4 standards. AAC files are usually ADTS or ADIF containers. 

.aax  

Audiobook format, which is a variable-bitrate (allowing high quality) M4B file 

encrypted with DRM. MPB contains AAC  or  ALAC  encoded audio in 

an MPEG-4 container.  

.act  

ACT is a lossy ADPCM 8 kbit/s compressed audio format recorded by most 

Chinese MP3 and MP4 players with a recording function, and voice recorders 

.aiff  

Standard audio file format used by Apple. It could be considered the Apple 

equivalent of wav. 

https://en.wikipedia.org/wiki/MPEG-2
https://en.wikipedia.org/wiki/MPEG-4
https://en.wikipedia.org/wiki/MPEG-4
https://en.wikipedia.org/wiki/Audible.com#Quality
https://en.wikipedia.org/wiki/Audiobook
https://en.wikipedia.org/wiki/MPEG-4_Part_14#Filename_extensions
https://en.wikipedia.org/wiki/Digital_rights_management
https://en.wikipedia.org/wiki/Advanced_Audio_Coding
https://en.wikipedia.org/wiki/Apple_Lossless_Audio_Codec
https://en.wikipedia.org/wiki/MPEG-4
https://en.wikipedia.org/wiki/ACT_(audio_format)
https://en.wikipedia.org/wiki/AIFF
https://en.wikipedia.org/wiki/Wav


 
 

File 

Extension 
Description 

.amr AMR-NB audio, used primarily for speech. 

.ape  Monkey's Audio lossless audio compression format. 

.au 

The standard audio file format used by Sun, Unix and Java. The audio in au files 

can be PCM or compressed. 

.dss 

DSS files are an Olympus proprietary format. It is a fairly old and poor codec. 

GSM or MP3 are generally preferred where the recorder allows. It allows 

additional data to be held in the file header. 

.flac  File format for the Free Lossless Audio Codec, a lossless compression codec. 

.gsm  

Designed for telephony use in Europe, gsm is a very practical format for 

telephone quality voice. It makes a good compromise between file size and 

quality. Note that wav files can also be encoded with the gsm codec. 

.m4a 

An audio-only MPEG-4 file, used by Apple for unprotected music downloaded 

from their iTunes Music Store. Audio within the m4a file is typically encoded 

with AAC, although lossless ALAC may also be used. 

.m4b 

Audiobook / podcast extension with AAC or ALAC encoded audio in an MPEG-

4 container. Both M4A and M4B formats can contain metadata including chapter 

markers, images, and hyperlinks, but M4B allows "bookmarks" (remembering 

the last listening spot), whereas M4A does not. 

.m4p 

A version of AAC with proprietary Digital Rights Management developed by 

Apple for use in music downloaded from their iTunes Music Store. 

.mp3 

 

MPEG Layer III Audio is the most common sound file format used today. 

https://en.wikipedia.org/wiki/Adaptive_Multi-Rate
https://en.wikipedia.org/wiki/Monkey%27s_Audio
https://en.wikipedia.org/wiki/Au_file_format
https://en.wikipedia.org/wiki/Sun_Microsystems
https://en.wikipedia.org/wiki/Unix
https://en.wikipedia.org/wiki/Java_(Sun)
https://en.wikipedia.org/wiki/Pulse-code_modulation
https://en.wikipedia.org/wiki/Digital_Speech_Standard
https://en.wikipedia.org/wiki/Olympus_Corporation
https://en.wikipedia.org/wiki/FLAC
https://en.wikipedia.org/wiki/GSM-FR
https://en.wikipedia.org/wiki/M4a
https://en.wikipedia.org/wiki/ITunes
https://en.wikipedia.org/wiki/MPEG-4_Part_14#Filename_extensions
https://en.wikipedia.org/wiki/Audiobook
https://en.wikipedia.org/wiki/Podcast
https://en.wikipedia.org/wiki/Advanced_Audio_Coding
https://en.wikipedia.org/wiki/Apple_Lossless_Audio_Codec
https://en.wikipedia.org/wiki/MPEG-4
https://en.wikipedia.org/wiki/MPEG-4
https://en.wikipedia.org/wiki/Mp4
https://en.wikipedia.org/wiki/Digital_Rights_Management
https://en.wikipedia.org/wiki/ITunes
https://en.wikipedia.org/wiki/MP3


 
 

File 

Extension 
Description 

 

.mpc 

Musepack or MPC (formerly known as MPEGplus, MPEG+ or MP+) is an open 

source lossy audio codec, specifically optimized for transparent compression of 

stereo audio at bitrates of 160–180 kbit/s. 

.ogg, .oga  

A free, open source container format supporting a variety of formats, the most 

popular of which is the audio format Vorbis. Vorbis offers compression similar to 

MP3 but is less popular. 

.opus 

A lossy audio compression format developed by the Internet Engineering Task 

Force (IETF) and made especially suitable for interactive real-time applications 

over the Internet. As an open format standardised through RFC 6716, a reference 

implementation is provided under the 3-clause BSD license. 

.ra, .rm  

A RealAudio format designed for streaming audio over the Internet. 

The .ra format allows files to be stored in a self-contained fashion on a computer, 

with all of the audio data contained inside the file itself. 

.raw  

A raw file can contain audio in any format but is usually used with PCM audio 

data. It is rarely used except for technical tests. 

.wav  

Standard audio file container format used mainly in Windows PCs. Commonly 

used for storing uncompressed (PCM), CD-quality sound files, which means that 

they can be large in size—around 10 MB per minute. Wave files can also contain 

data encoded with a variety of (lossy) codecs to reduce the file size (for example 

the GSM or MP3 formats).  

.wma 

Windows Media Audio format, created by Microsoft. Designed with Digital 

Rights Management (DRM) abilities for copy protection. 

.webm Royalty-free format created for HTML5 video. 

 

https://en.wikipedia.org/wiki/Musepack
https://en.wikipedia.org/wiki/Transparency_(data_compression)
https://en.wikipedia.org/wiki/Ogg
https://en.wikipedia.org/wiki/Opus_(audio_format)
https://tools.ietf.org/html/rfc6716
https://en.wikipedia.org/wiki/RealAudio
https://en.wikipedia.org/wiki/RealAudio
https://en.wikipedia.org/wiki/Raw_audio_format
https://en.wikipedia.org/wiki/Wav
https://en.wikipedia.org/wiki/Microsoft_Windows
https://en.wikipedia.org/wiki/Pulse-code_modulation
https://en.wikipedia.org/wiki/Windows_Media_Audio
https://en.wikipedia.org/wiki/Digital_Rights_Management
https://en.wikipedia.org/wiki/Digital_Rights_Management
https://en.wikipedia.org/wiki/WebM
https://en.wikipedia.org/wiki/Royalty-free
https://en.wikipedia.org/wiki/HTML5_video


 
 

4. SAVING EDITED AUDIO TRACK 

There are several different formats for saving a file or group of files are available in edit 

view of Adobe Audition. We discuss all the options one by one. Choosing a format 

depends upon your plan to use the file in future. Keep in mind that each format stores 

unique information that might be discarded if you save a file in a different format. 

We will discuss the options available in saving a file after defining all the save 

commands. 

a. DIFFERENT WAYS OF SAVING A FILE 

1. To save changes in a current file select File > Save. 

 

 

2. To save changes under another file name select File > Save as option from the menu. 



 
 

 

 

 

3. To save a copy of the current file while leaving the original version open and 

active, choose File > Save Copy As. 

 

4. To save a selected portion of the edited as a new file choose File > Save Selection. 

 



 
 

 

 

When you choose any one option from the above it will open a dialgue box having 

different options. 

 

 



 
 

Here you select the folder and its location where you want to put in your saved file. After 

then input a file name which is understandable to you in future. Select the file type. There 

are  

many file types available according to your requirement. You are very well aware about 

the file types. 

Below file type select Save Extra Non-Audio Information to preserve markers and file 

information, such as loop and Broadcast Wave metadata. Deselect this option only, when 

you plan to burn your CD from another program. 

Depending on the format you choose, additional options might be available. To view 

format-specific options, click Options. 



 
 

 

Here you can select extra options for your file if you want to. After selecting all the 

options click save. It will save your file at a location specified by you. 

5. To save all open files in their current format select File > Save All options from 

the menu. 

 

 

 

 

 

 

 

 



 
 

In either Edit View or Multitrack View, you can save a group of all open audio files to 

one format of your choice with File > Save All Audio As option. This option 

automatically choose filenames from file information such as Artist, Album and song if 

the files extracted from a CD. 

 

Set the following options. 

Destination folder: Select the destination folder where do you want to put your files.. 

Filename Template: You can input your information if files are not extraxted from a CD.  

You can add another file name template by pressing  sign and delete current filename 

template by pressing  sign. 

Output Format: Select the output format for your files. 

Audio Files: Audio files with specific names are shown here.  

Show Folder: Displays the complete path for each file in the Audio Files list.  

 



 
 

b. SAVING MULTITRACK SESSION 

A multitrack session file is a small, non-audio file. It stores information about locations 

of related audio files on your hard drive, the duration of each audio file within the 

session, the envelopes and effects applied to various tracks, and so forth. You can reopen 

a saved session file later to make further changes to the mix. 

 If you create multitrack compositions only for Adobe Audition, save session files in the 

native SES format and if you have planned to share multitrack compositions with other 

applications, save sessions in XML format.  

 

It will open a dialogue box having different options. Give the filename, file type and other 

options mostly disscussed in save options of single track. In option you can change the sample 

rate of the files. Choose any sample rate available in the drop down menu and then save the file. 

 

 



 
 

c. EXPORT A MUITRACK SESSION TO AN AUDIO FILE 

To export a multitrack session choose File > Export > Audio Mix Down. 

Ctrl+Shift+Alt+M 

1. If you want to export part of a session, use the Time Selection tool to select the 

desired range. 

2. In the Export Audio Mix Down dialog box, specify a location, name, and format 

for the saved file.If the file format you select can be customized, the Options 

button is available, click it to review or change settings, and then click OK. 

3. In the Mix Down Options section, set Source, Bit Depth, and Metadata options. 

4. Click Save. 

 



 
 

 

d. CLOSE FILES 

Do any of the following: 

 To close the current audio file in Edit View, choose File > Close. 

 To close the current session file in Multitrack View but leave related media files 

open, choose File > Close Session. 

 To close a CD list in CD View, choose File > Close CD List. 

 To close all audio and video files not in use, choose File > Close Unused Media. 

 To close all open audio, video, session, and CD list files, choose File > Close All. 

 

 

 

 



 
 

e. BURNING AN AUDIO CD 

To open CD view click View > CD View or press 0. 

 

 

Below is the CD View. 

 

 

 

 

You can insert files in Main list or drag the files into Main Pan or press Alt + Insert. 

 

 

 



 
 

Or click the icon present on up side of the files list. 

 

After inserting the files into CD list. You can select different options and save the .cdl 

file for future use. 

 

 

 

 

 

 

You can select track properties by clicking track properties on the right side of the pan. 

It will open a dialogue box. Select the source, selection and track title. Click ok. 

Reassign, re-arrange or remove one or all track in your CD view.  

 



 
 

 

 

 

 

 

 

 

 

 

 

Click Write CD to set the write cd options. Set CD Device Properties. 

Enter Text Options. Write CD-Text. Title and Artist. Insert a blank CD into CD drive 

and click Write CD. It will start the CD writing and shows the status. After burning disk 

will automatically eject.  

 

 

 

 

 

 

 

That’s it your burned CD is ready. Enjoy your first Audio CD. 



 
 

SELF ASSESSMENT QUESTIONS  

1. Explain in detail Sample rate and bit depth. 

2. Define basic audio channels and types. 

3. What is audio file format? Just name the file formats. 

4. Explain lossy compressed audio format with two examples. 

5. Give the name of five audio file formats and give description of any two. 

6. How many ways we can save an edited audio file? Explain any one. 

7. Define the export of your saved project. 

8. How can we burn an audio CD? 
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INTRODUCTION  

 

This program is open to all nationalities and all ages over 18. Suitable for gap years or those 

taking a year out, grown-up gapers, career breakers, anyone interested in gaining overseas 

qualification experience or an internship for university credit or requirement. Also suitable for 

anyone just wanting to study and learn about audio and audio Production practice. 

 

1. Internship 

Internships are work-related learning experiences that provide students with the chance to gain 

important knowledge and skills in a career related that may or may not be directly related to their 

academic study. Therefore internships guide should be with very clearly defined learning 

objectives related to the professional goals of the learners. This internship will provide an 

exposure to the career fields of interest without making a permanent commitment. 

Dear student the internships are unpaid positions providing you with practical experience. The 

Institute of Educational Technology, Allama Iqbal Open University will offer the internship to all 

of you after being enrolled and completion of course for academic credit. You can earn work 

experience by participating in an internship. 

The interning in a field of choice will stand out on your resume and help them with their job 

search after the completion of course. Every one of you meets during the course of their 

internship will be a contact. The internship supervisor or guider will help or guide you in career 

path as you make their way into the business world. They know other people in the industry as 

well and will provide introductions. Your fellow interns also will become great contacts in the 

future. 

All students should explore the possibility of earning academic credit through their place of 

internship/university. 

 

 

 

 



 
 

1.1 Internship Criteria  

Following is the criteria to meet for unpaid internships. According to certain standards listed 

below: 

 Interns are not guaranteed a job at the end of the internship 

 Interns must receive training from the company. 

 Interns must get hands-on experience with equipment and processes used in the industry. 

 Interns' training must primarily benefit them, not the company. 

 

1.2 Why Provide Internships? 

Following are the few reasons for providing internship 

 Internships allow students the opportunity to apply their knowledge and skills in a 

 Professional setting while still doing course. 

 Internships offer carefully planned and monitored work experience with the goal being to 

 gain additional knowledge from on the job exposure. 

 Internships may also be part of an educational program in which students can earn 

 academic credits from their college. Internships may be arranged independently from 

 the curriculum in which students would gain work experience only. 

 

1.3 Benefits to Department 

• Immediate assistance to support projects 

• Students will provide new ideas and viewpoints 

• Salary Savings = No cost to department 

• Effective public relations ambassadors for department; Recruitment and 

Workforce Planning 

• Department/University ties are strengthened and communication is improved 

• Permanent State employees can be relieved from performing minor or routine 

 tasks allowing them to perform higher priority work 

• Students energize a workplace with their enthusiasm and desire to learn. 

 

 

 



 
 

1.4 Benefits to Students 

• Career related experience 

• Gains practical knowledge 

• Opportunity to explore career avenues 

• Valuable work experience for their resumes 

• Potential to earn academic credit 

• Increased self-confidence 

• Enhances conventional classroom learning methods 

• Letter of recommendation from departments supervisor 

• Obtain references from co-workers 

 

2. Internship Coordinator 

The Internship coordinator will: 

• Conduct on-campus recruiting to ensure students are aware that the departmentis offering 

internship opportunities 

• Advertise the department’s recruitment opportunities 

• Coordinate the recruiting and screening of intern applicants 

• Assist in the selection of interns 

• Promote internship opportunities within the department 

• Serve as the contact regarding the department’s internships 

• Review and revise the department’s internship procedures as needed 

• Serve as a liaison between intern supervisors and university. 

 

3. Interns 

• Internships allow students the opportunity to apply their knowledge and skills in  a 

professional setting while still completing course. 

• Internships offer carefully planned and monitored work experience with the goal being to 

gain additional knowledge from on the job exposure. 

• Internships may also be part of an educational program in which students can earn 

academic credits from their college. Internships may be arranged independently from the 

curriculum in which students would gain work experience only. 

 



 
 

3.1 How to Begin 

Interns should: 

• Analyze their skills, values and interests to determine the location and working 

environment desired. 

• Prepare a resume and cover letter and have them critiqued at their career center. 

• Network with alumni, college professors, friends, and family. 

 

3.2 How to Apply 

Internships are defined at the end of the course through departments, at Student Internship 

Positions. Please follow the directions on each individual internship flyer. 

3.3 Responsibilities 

Interns should: 

• Adhere to agency policies, procedures, and rules governing professional behavior. 

• Be punctual, and work the required number of hours at times agreed to by the intern and 

their supervisor. 

• Notify their supervisor if they are unable to attend as planned. 

• Behave and dress appropriately to the particular workplace. 

• Respect the confidentiality of the workplace, its clients and its employees. 

• If things are slow, take the initiative and volunteer for different tasks or other work. 

• Discuss any problems with their supervisor and, if necessary, with the Internship 

coordinator at the department. 

3.4 Intern Rights 

Unpaid interns have the same legal rights as employees in regards to protection against 

discrimination and harassment. However, interns do not have the same rights as employees in the 

realms of unemployment compensation or termination procedures. 

4. Internship Completion 

At the end of the internship: 

• The intern supervisor will provide the student with a letter of recommendation. 



 
 

• The student Intern will evaluate the overall internship experience. The evaluation form 

must be returned to the internship coordinator. 

 

5. Supervising an Intern 

An intern will have a designated site supervisor who is responsible for providing orientation and 

supervision. This will be someone, available to the student on a regular basis, and possesses 

expertise in the area in which the intern will work. Even if the intern will rotate through various 

departments in order to gain broad-based experience, there still will be a single overall supervisor 

who over sees the internship as a whole. Dear student on choosing a supervisor, it is important to 

choose someone who is interested in working with university students; has the time to invest in 

the internship, especially during the first few weeks; and possesses qualities such as leadership, 

strong communication skills, and patience. 

Because an internship is defined as a learning experience, proper supervision of the intern is 

essential. The supervisor is very important element in internship and he/she will be serving as a 

teacher, mentor, critic, and boss. Ongoing supervision of the student intern is the key to the 

success of the internship. This is especially true for students who do not have extensive work 

experience. 

Acknowledging and identifying the different expectations between the workplace and school will 

help interns make a successful transition to the world of work. 

An effective method of intern supervision is to have a set time (bi-weekly is recommended) to 

meet with the intern to review progress on projects, touch base, and provide feedback. Some 

supervisors do this over lunch; others choose a more formal setting. 

The supervisor will oversee and assign the student intern’s work. Supervisors will need to monitor 

the intern’s time and submit an intern evaluation form provided by the intern’s college for those 

receiving academic credit. The intern supervisor will also provide the student with a letter of 

recommendation. 

6. Training 

Training is as important as supervision. Establishing a training program will give the interns a 

clear understanding of what is expected, and information about the duties that will be supervised 

and evaluated.  



 
 

The Institute of Educational technology, AIOU, Islamabad will designate a supervisor to oversee 

and assign the student intern’s work. 

Discuss the following with interns: 

• What will the specific duties/responsibilities of the intern be? 

• How will you provide the intern with regular feedback, guidance, and support? 

• What training will the intern receive (if applicable)? 

• What will the intern need to do if they will be absent from work? 

7. Orientation 

Establish goals and objectives, and clarify these goals and objectives before the intern begins 

working. Some interns need more guidance than others, and many factors must be taken into 

consideration. Consider the intern’s cultural background, disabilities, learning style and 

experience. Evaluate his or her level of maturity and confidence. Is the intern a critical thinker or 

a creative problem-solver? 

 

Plan to include the following in your orientation: 

• Information about the organization. Office interns will review documents that are 

important for them to understand the big picture. If available, include an organizational 

chart that explains various roles and responsibilities of employees. 

• Structure. Interns might not be familiar with formal workplace procedures (e.g., 

attendance policies, break times, days off). Make sure to clarify relevant policies and 

procedures to interns on their first day. 

• Introductions. Take time in the beginning of the internship to introduce the intern to the 

people in your program. Allow more time for conversation with those employees who are 

likely to interact with the intern on a regular basis. Some interns, based on personality or 

culture, may be reluctant to seek out co-worker son their own. By making a special effort 

to encourage those contacts early on, interns will feel more comfortable asking for advice 

or support later. 

 



 
 

8. Ongoing Training 

Interns, as students, appreciate any opportunity to learn new skills or increase their knowledge. 

Developing a plan for training throughout the internship will keep students interested in the 

position and ready to tackle new challenges. Ongoing training may include the following: 

• Skill development. There may be a need for training in specific skills such as computer 

programs, office equipment, or other tasks directly related to the job. 

Even bright students with great potential will struggle if they are not instructed in the 

specifics related to successful completion of duties. 

• Shadowing. Allow interns to participate in activities and meetings. Interns may have 

leadership potential but not understand the culture of your organization. 

They will rely on their supervisor to educate them. 

• Questions. Interns might not know when to speak or how or what to ask. Assist them in 

actively learning by explaining and clarifying everything. Suggest and encourage 

questions at appropriate times. 

• Professional conferences or association meetings. If possible, offer interns the 

opportunity to attend training or networking events. It helps interns to get a feel for the 

overall mission of your organization, and at the same time make them feel that they are 

valued. 

 

9. Evaluations 

Evaluation is important to an intern's development and is an opportunity to identify strengths and 

weaknesses. It is helpful if supervisors evaluate throughout the entire internship, not just at the 

end. The evaluation should be planned as a learning experience and an opportunity for two-sided 

feedback. 

Regularly scheduled evaluations help avoid common problems with internships, including 

miscommunication, misunderstanding of job roles, and lack of specific goals and objectives. You 

may find it helpful to schedule a preliminary evaluation early in the internship (in the second or 

third week). This will help you understand whether the intern’s orientation and training was 

sufficient or if there are specific areas in which the intern has questions or needs further training. 

Criteria to consider when evaluating an intern: 



 
 

• Progress towards or accomplishment of learning objectives as stated in the learning 

agreement. 

• Skill development or job knowledge gained over the course of the internship. 

• Overall contribution to the mission of the organization. 

• Dependability, punctuality, attendance. 

• Relations with others, overall attitude. 

• Potential in the field. 

The student will also evaluate the internship experience, which is important in determining the 

value of the work experience for future interns. Categories might include: 

• Was there educational value or merit in the assignment? 

• Did the position live up to its initial description? 

• Was the supervisor receptive to your ideas? 

• Does the experience relate to your major or career goals? 

• Did you receive a proper job orientation? 

• Was the supervisor willing and/or capable of answering questions? 

• Did you develop good work habits? 

10. Internship Completion 

An internship should have a clearly stated end date that is identified before the internship begins. 

Completing a formal evaluation process such as the one described above can help both the site 

supervisor and the intern bring closure to the experience. A letter of recommendation from the 

Intern supervisor shall be given to the intern on the last day of work. 

You also may want to have some form of acknowledgment such as a lunch with coworkers in the 

final week of the internship. Because co-workers often have extensive contact with interns, this 

type of event can be a positive way to recognize the contribution of other employees as well as 

the intern. 

At the end of the internship, the intern supervisor will: 

• Provide the student with a letter of recommendation. 



 
 

• Complete college/university evaluation to assess the intern's progress and skill 

development (if applicable). 

• Evaluate the overall internship experience. This feedback is not only essential for making 

necessary program improvements, but also for recognizing those departments that provide 

outstanding learning opportunities. The evaluation form must be returned to the internship 

coordinator. 

11. Frequently Asked Questions 

Why should I look at an internship? 

Internships allow students the opportunity to apply their knowledge and skills in a professional 

setting. Students will gain valuable work experience and the opportunity to explore career 

avenues. 

How do I find an internship? 

The department advertises their intern positions at local radio stations and production houses. 

Is my internship paid? 

There are no paid positions available. The department will provide internships to students as 

volunteers or for academic credit. 

What happens at the end of my internship? 

You will receive a letter of recommendation from your internship supervisor. You will also have 

an opportunity to evaluate the department’s internship program. 

 

 

 

 

 

 



 
 

Institute of Educational Technology 

Student Intern Performa 

Print all information clearly! 

Intern's Name ____________________________________________________________ 

Semester of Internship:  □ Spring  □ Autumn 

Year: ______________ 

Intern’s supervisor:________________________________________________________ 

What resources did you use to find your internship? (Check all that apply) 

□ Career Services Office/Internship Coordinator □ Faculty □ Internet Site 

□ Family Friend □ Other: _______________________________________________ 

Internship field: __________________________________________ 

Project Title: ____________________________________________ 

______________________________________________________ 

____________________________________________________________ 

Details of the final project: _______________________________ 

______________________________________________________ 

_____________________________________________________________________________ 

_______________________________________________________________________________ 

Department ____________________________    Date ________________________ 

 



 
 

This evaluation is completed by the student. 

Please rate the following aspects of your Internship placement on the basis of this scale: 

Excellent (Consistently exceeds expectations)Good (Sometimes exceeds expectations) 

Average (Meets expectation)Poor (Rarely meets expectations) 

N/A Not Applicable (Not applicable to this internship experience) 

Select one evaluation level for each area by marking an “X” under the level that represents the 

internship. 

 

Comments if any 



 
 

______________________________________________________________________________

______________________________________________________________________________

______________________________________________________________________________

______________________________________________________________________________ 

Would you work for this supervisor again?  

Yes      No     Uncertain 

Would you work for this agency where doing internship again? 

Yes      No     Uncertain 

Would you recommend this agency where doing internship to other students? 

Yes      No     Uncertain 

Why or why not?: _____________________________________________________ 

____________________________________________________________________ 

____________________________________________________________________ 

____________________________________________________________________ 

 

Intern’s Signature: _________________Date: ______ 

 

Thank you very much for completing this evaluation of your internship. We take your 

comments very seriously. Please return this evaluation to the university. 

 

 

 

 

 



 
 

Supervisor Evaluation of Student Internship 

Print all information clearly! 

Intern's Name: ___________________________________________ 

Intern's Supervisor: _______________________________________ 

This internship started on (date) _________________________and 

will be as completed on (date)________________________________ 

Do you permit the student to receive a copy of this evaluation? Yes ___ No ___ 

Please rate the following aspects of your Internship placement on the basis of this scale: 

Excellent (Always demonstrates this ability/consistently exceeds expectations) 

Good (Usually demonstrates this ability/sometimes exceeds expectations) 

Average (Sometimes demonstrates this ability/meets expectation) 

Poor (Seldom demonstrates this ability/rarely meets expectations) 

N/A Not Applicable (Not applicable to this internship experience) 

 

Evaluation of personal qualities of the intern observed during the internship. Select one evaluation 

level for each area by marking an “X” under the level that represents the intern’s performance. 



 
 

 

Comments about the project 



 
 

______________________________________________________________________________

______________________________________________________________________________

______________________________________________________________________________

______________________________________________________________________________ 

 

Would you supervise this intern again? 

Yes      No     Uncertain 

Would your agency host this intern again? 

Yes      No     Uncertain 

Would you recommend this student to other organizations?  

Yes      No     Uncertain 

Why or why not? ___________________________________________________ 

__________________________________________________________________ 

__________________________________________________________________ 

__________________________________________________________________ 

Evaluator’s Signature: ___________________Date: ______________________ 

Title/Position: _____________________Telephone: ________________________ 

 

Thank you very much for completing this evaluation of your intern. We take your comments very 

seriously. Please return this evaluation to the FAX number or address listed above. 
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